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1.0 Introduction 
 

 
 
The Electronic Shipping Tools User Guide – Desktop Version manual for preparing an electronic 
Statement of Mailing is written and organized to meet the needs of first-time and casual users of the 
desktop version of the application.  This manual is designed to help you learn the basic functions of 
Electronic Shipping Tools in order to prepare your Communications mailings. 
 
This guide: 

• Provides an overview of the application and describes the steps in creating your electronic 
Statement of Mailing; 

• Is available in French via the website; 
• Is in Portable Document Format (PDF) with links from the Table of Contents.  You can use the 

links to quickly navigate to the section that interests you, and; 
• Can be printed. 

 
It will take you step-by-step through the process of completing your electronic Statement of Mailing from 
the entry of data into the application, along with the validations that take place, and the functionality of the 
command buttons and templates to transmitting and printing your SOM. 

 
 

1.1 New Connection on Start-up 
 
The Desktop version of Electronic Shipping Tools (EST) is based on highly synchronized data related to your contract with Canada 
Post.  In order to ensure your mailings and your invoices agree, it’s important that you keep your Desktop application up to date. 
 
To help ensure you receive all the updates you need to keep your Desktop version current, the Communication Status Notification 
page requires that you establish a daily connection with the EST server before creating statements of mailing (SOMs) or manifests. 
 
You will be connected to the EST server the first time you launch the application each day; the server will then automatically check 
for and apply any updates.  If, for any reason, a connection cannot be established with the EST server, you will see an error 
message indicating your connection failed.  When you click on the OK button, start up will continue. 
 
All other aspects of connecting to the EST server remain unchanged.  When you check for updates during the day under Check for 
Application, Data and Barcode Update, the Desktop will continue as before, checking for application and data updates during the 
Transmit process.  Note that if the connection at start-up was successful, there should not be any additional updates available. 
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2.0  Electronic Shipping Tools Desktop Version – 
Communications Services 
 

 2.1 Application Desktop Window 
 
The application Desktop window for the electronic Statement of Mailing acts as the control centre for all your processing of Order 
transactions.  From this window, you can manage and navigate through the application structure, select Orders to transmit to CPC, 
print/reprint Order documents, delete Orders and initiate the data capture of new Orders or complete data capture for partially 
entered Orders. 
 
The desktop also provides a visual representation of how the Orders, Order templates and the Transmit Session Logs are 
organized.  The window is of a multiple windowpane design.  The window takes advantage of command buttons, main menu 
navigation and popup menu navigation and actions. 
 
 

 
 
 
The purpose of each window component is as follows: 

Title Pane: Displays the current folder name selected by the user. 
Folder Pane: Provides a tree structure to allow you to navigate to the different folders used by the application.  
List Pane: Lists the contents of the selected folder.  You can sort the contents displayed in this pane by selecting the 

desired column heading. 
Details Pane: If a SOM entry is selected, lists the detailed contents of the selected item in the List Pane.  You can sort the 

contents displayed in this pane by selecting the desired column heading.  If a Transmit Session Log is 
selected, the Transmit Session Log text is displayed. 

Command 
Buttons: 

Command buttons available on the application desktop for a particular window. 

 Details Pane

List Pane

 Folder Pane 

 Command Buttons 
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 2.2 Navigating Around the Application 
 
To select from the Main Menu or to activate a command button: 

• Use the mouse to point and click on the desired option. 
• Use hot keys as defined by an underlined letter.  Hold down the <ALT> key and press the letter. 
• When applicable, use the right mouse button to activate a popup menu. 

 
To move from field to field: 

• Use <TAB> or your mouse to move from one field to the next or point and click with the mouse. 
• Use the left and right arrow keys to move between choices for a single field (e.g. radio buttons).  Click on your 

choice to select it. 
• Click on the down arrow to display a selection/drop-down list. 

 
All drop-down lists have the same functionality, that is, if the user types in a character then the drop-down list automatically scrolls to 
the first item in the drop-down list that begins with this character. However, if the user types a second character, then the list 
automatically scrolls down to the first item in the drop-down list that begins with the second character entered. 
 
 

 2.3 The Order Lifecycle 
 
The principles of an Order lifecycle were used in the design of the base tree structure of the Folder Pane.  At each point in the 
Order lifecycle, the state of the Order can be managed by the location the Order is in the application tree structure.  The following 
lists the possible states of an Order. 
 

• Opened Order 
• Finalized Order 
• Transmitted Order 
• Deleted Order 

 
 

 2.4 The Application Folder Structure 
 
The following table describes the tree structure for electronic Statement of Mailing users, keeping the Order lifecycle in mind.  You 
can create subfolders off of this base structure, but the core structure itself cannot be changed. 
 

Desktop Tree Structure 

FOLDER NAME DESCRIPTION OF FOLDER CONTENTS 

SOMs All SOM’s, SOM Templates and SOM Transmit Session Log records created by the application will 
reside in subfolders of this folder. 

Templates This subfolder contains the SOM template records created by the user. 
Opened SOMs This subfolder contains the Opened SOM records created by the user.  An Opened SOM is a SOM 

still in the process of being entered. 
Finalized SOMs This subfolder contains the Finalized SOM records.  A finalized SOM is a SOM that is ready to be 

transmitted to CPC and printed. 
Transmitted SOMs This subfolder contains the SOM records that have been transmitted to CPC and printed. 
Transmit Session Logs This subfolder contains the SOM Transmit Session Log records created by the Transmit/Print 

function. 
Deleted SOMS This subfolder contains SOM’s and SOM templates that have been deleted. 
Deleted Logs This subfolder contains Transmit Session Log records that have been deleted. 
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 2.5  Main Menu, Command Buttons and Popup Menus 
 

 

 
Note:  The List Pane will be populated with column headings, data and scroll bars once an Electronic Shipping Tools folder has 

been selected.  The Details Pane will be populated with column headings, data and scroll bars once a SOM or Manifest has 
been selected. 

 
 
The Main Menu is displayed at the top of the window.  Command buttons are located at the bottom of the Desktop window (hot key 
definitions are identified by an underlined letter).  Popup menus appear within the applicable windowpane when you press the right 
mouse button when an item(s) is selected in the Folder or List Pane. 
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 2.5.1 Main Menu Functionality 
 
The following table describes the Main Menu functionality and displays the hot key definitions (by underlining the letter in question).  
The Main Menu is displayed at the top of the Desktop window. 
 

MENU ITEM RESULT OF INVOCATION 

File • Shows submenu consisting of the following: 
¾ New Shipment… 
¾ New Manifest… 
¾ New SOM… 
¾ Open… 
¾ Move… 
¾ Delete… 
¾ Exit 

Customer 
(i.e. Mailed on Behalf of 
Customer) 

• Shows submenu consisting of all Mailed on Behalf of Customers defined for the Mailed By 
Customer (displays Number and Name of each). 

• When application is initiated, the Mailed on Behalf of Customer is defaulted to the Mailed on 
Behalf of Customer used in the last session. 

Security  • Security Enabled checkbox on the Options tab of Site Information window must have been 
selected. 

• Shows submenu consisting of the following single option: 
¾ User Profile… 

Data Maintenance • Shows submenu consisting of the following: 
¾ Order Items   > 
¾ Cost Centres 
¾ Address Book… 
¾ Distribution List of Clients… 
¾ Distribution List of Imported Orders… 
¾ Containers… 
¾ Pre-defined Goods… 
¾ Contract Number Alias… 
¾ Salutations… 
¾ Site Information… 
¾ Customer… 
¾ Client… 

Reports • Shows submenu consisting of the following: 
¾ Reports… 
¾ Delivery Confirmation… 

Tools • Shows submenu consisting of the following: 
¾ Search/Manage Orders… 
¾ Scale Configuration… 
¾ Eltron/Zebra Configuration… 
¾ Printer Configuration… 
¾ Output Configuration… 
¾ Proxy Server Configuration 
¾ Purging… 
¾ Order History Export… 
¾ Barcode Ranges… 
¾ Check for Application, Data and Barcode Update 
¾ Sign In Electronic Shipping Tools 
¾ Sign Out Electronic Shipping Tools 

Window • Shows submenu consisting of the following: 
¾ A list of the currently opened data entry windows 

Help • Shows submenu consisting of the following: 
¾ EST News 
¾ Release Notes 
¾ Electronic Shipping Tools 
¾ Help 
¾ HouseHolder Counts and Maps 
¾ Track Package 
¾ Product and Services 
¾ Help Desk Ticket 
¾ SOM Deletion Request 
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MENU ITEM RESULT OF INVOCATION 

¾ About 
Submenus of File 
New Shipment • For Distribution Services only. 

• Opens the Shipping window. 
New Manifest • For Distribution Services only. 

• Opens the Manifest window. 
New SOM • For Communications Business Services only. 

• Shows submenu consisting of the following: 
¾ Lettermail SOM 
¾ Addressed Admail SOM 
¾ Publications  SOM  
¾ Unaddressed Admail -  SOM only 
¾ Unaddressed Admail – fully featured 
¾ Catalog Mail SOM 
¾ Int’l Incentive Letter-post 
 

Open • Same as the Open command button. 
Move • Same as the Move command button. 
Delete • Same as the Delete command button. 
Exit • Same as the Exit command button. 
Submenu of Security 
User Profile • Opens the User Profile window. 
Submenus of Data Maintenance 
Order Items > • For Distribution Services only. 

• Shows submenu consisting of the following: 
¾ Import… 
¾ Maintain… 

 •  
 •  
Cost Centres • Opens the Cost Centres window. 
Address Book  • For Distribution Services only. 

• Opens the Address Book window. 
Group Shipping of Clients • For Distribution Services only. 

• Opens the  Group Shipping List –  Clients window. 
Group Shipping of Imported 
Orders 

• For Distribution Services only. 
• Opens the  Group Shipping List – Imported Order Items window. 

Containers • For Distribution Services only. 
• Opens the Containers window. 

Pre-defined Goods • For Distribution Services only. 
• Opens the Pre-defined Goods window. 

Contract Number Alias • For Distribution Services only. 
• Opens the Contract Number Alias window. 

Salutations • For Distribution Services only. 
• Opens the Salutations window. 

Site Information • Opens the Site Information window. 
Customer • Opens the Customer window. 
Client • For Distribution Services only. 

• Opens the Client window. 
Import Presort Software 
Mailing Plan 

• Opens the Open File – Open Import Presort Software Mailing Plan Window     
The Data Maintenance Menu on the Mailing page now offers the new “Import Presort Software 
Mailing Plan” option for SERP* mailing plans. This option contains two new sub-menus: Import the 
Presort Software Mailing Plan and View the Presort Software Mailing Plan. This menu is available if 
you have selected Addressed Admail LCP Communications Services during the installation process 
or later, at the Site Information page using the Options tab. 

¾ •Import Mailing Plan 
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MENU ITEM RESULT OF INVOCATION 

 When you select the Import option, a pop-up window will allow you to: 
-select the desired folder from your file system 
-specify the SOM Id related to the SERP* Mailing Plan file 
-view files in the folder you have selected 
-ensure the correct file is being imported 
 You will only be able to view the data on this window;  
 any changes must be made in the SERP* Presortation Software, creating 
 a new mailing plan to be imported into the Desktop. At this point you   
 may proceed with the import or cancel the order. 
  
 The SERP* Mailing Plan import format is a flat-comma delimited,  
 ASCII file. There is a separate file for each structure  
 (e.g. Header, Deposit Location,Burst Location,Groupings, Containers) 
 
Please consult the following for the list of Recognized Presortation Software: 
http://www.canadapost.ca/business/offerings/address_management/can/presort_list-e.asp 

¾ •View Mailing Plan 
 The View Mailing Plan feature is enabled only after  
 the mailing plan has been imported successfully. 
 From the View Mailing Plan window,  
 you can select a Mailing Plan and begin   
 the order creation process by clicking on the ‘OK’ button. 

Import Template • Opens the Open File – Import Template Window 
Submenus of Reports 
Reports • Opens the Reports window. 
Delivery Confirmation • For Distribution Services only. 

• Opens the Delivery Confirmation window. 
Submenus of Tools 
Search/Manage Orders • Opens the Search/Manage Orders window. 
Scale Configuration • Opens the Scale Configuration window. 
Eltron/Zebra Configuration • For Distribution Services only. 

• Opens the Eltron/Zebra Configuration window. 
Printer Configuration • Opens the Printer Configuration window. 
Output Configuration • Opens the Output Configuration window. 
Proxy Server Configuration • Opens the Proxy Server Configuration window. 
Purging • Opens the Purging window. 
Order History Export • Opens the Order History Export window. 
Barcode Ranges • For Distribution Services only. 

• Opens the Barcode Range Maintenance window. 
Reserve SOM Ids for 
Presort Software 

• For Communication Services only 
• Opens the Reserve SOM Ids for Presort Software Window 

Check for Application, Data 
and Barcode Update 

• Checks for updates to the application.  Displays warning message if there are software 
updates. 

Sign In Electronic Shipping 
Tools 

• Opens the Sign In Electronic Shipping Tools window. 

Sign Out Electronic Shipping 
Tools 

• Opens the Sign Out Electronic Shipping Tools window. 

Submenus of Help 
EST News • Stay in-touch with the latest news about EST including planned outages and upcoming 

changes 
Release Notes • Review release documentation for current and previous versions of EST 
Electronic Shipping Tools • EST guides and reference material 
Help • Help/Support using EST 
Householder Counts and 
Maps 

• Unaddressed Admail House Holder Counts and Delivery Maps 

Track a Package • Jump to our website and Track a Package 
Products and Services • Learn more about Canada Post Products and Services 
Help Desk Tickets • Submit EST Diagnostic Files to technical support.  You must obtain a ticket number from             
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MENU ITEM RESULT OF INVOCATION 

Technical Support before using this feature 
SOM Deletion Requests • Submit a request to void a transmitted Statement of Mailing 
Submenus of Submenu New SOM 
Lettermail SOM • Opens the Lettermail data entry window. 
Addressed Admail SOM • Opens the Addressed Admail data entry window. 
Publications Mail SOM • Opens the Publications Mail data entry window. 
Unaddressed Admail – SOM 
only 

• Opens the Unaddressed Admail data entry window. 

Unaddressed Admail – Fully 
featured 

• Opens the Unaddressed Admail data entry window. 

Int’l Incentive Letter-post • Opens the International Incentive Letter-post data entry window. 
Catalog Mail SOM • Opens the Catalogue Mail data entry window. 
 
  2.5.2 Command Button Functionality 
 
 The following table describes the Command Button definitions and displays the hot key definitions (by underlining the letter in 
question).  All the command buttons you need to do a mailing are in one place, grouped in five different categories on the Desktop 
page.  Some commands, designated here with a * are duplicates, available both as buttons or from the toolbar. 
 
 
 
 
 

COMMAND BUTTON RESULT OF INVOCATION 

 
Shipping: 
 
Ship a Package (Distribution Services)  This button allows you to prepare and ship a package 
Track a Package (Distribution Services)  This button allows you to track a package  
Void an Item Performs the same function as the Void button on Search/Manage page 
 
Mailing: 
 
Create a SOM (Communications Services)  Opens a pop-up window from which you can select a type of SOM 
Print a Report  This button allows you to generate reports* that will help you reconcile your shipping business. 
 
Documents: 
 
Transmit/Print • Enabled for Finalized SOM’s only. 

• One or more entries have been selected in the List Pane from the Finalized SOM’s folder. 
• Initiates the Transmit/Print Order function: 

• Initiates Connection with Server; 
• Initiates Reference Data, Barcode and Software Update check; 
• Initiates CPC validations and rating and; 
• Creates Transmit Session Log. 

 
• If the Transmit/Print function is successful: 

• The Order record is saved with a status of Transmitted and automatically moved to the Transmitted 
SOM’s folder; 

• For Unaddressed Admail, the ADS Sequential Number is generated for each Delivery Installation 
Detail record, starting at one for each SOM.  The 4-digit number is sequentially generated at the 
SOM level, by the sort criteria selected on the Unaddressed Admail data entry window. 
• If the ADS Reference sort criterion is selected, the sequential number is generated by ADS 

reference and then by Delivery Installation Postal Code. 
• If the Title of Mail Piece sort criterion is selected, the sequential number is generated by Title of 

Mail Piece and then by Delivery Installation Postal Code. 
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• The Printing Process is initiated. 
• If the Transmit/Print function fails, an appropriate error message is displayed. 
Note:  Warning messages may be triggered during the Transmit/Print process (e.g. order “blocked” due to 

credit issues); however, the order is still considered successfully transmitted. 
• If the warning message triggered indicates that the order has been “blocked”, then this information must 

be stored in order to have this data printed on the SOM. 
• A message is displayed if the wrong page orientation is selected. 

 •  
Finalize/On-Hold • Enabled for Opened SOM’s only. 

• A single entry has been selected in the List Pane from the Opened SOM’s folder. 
• Initiates pricing of services selected. 
• If pricing is successful then 

• The Order is saved with a status of Finalized and; 
• The Order record is automatically moved to the Finalized SOM’s folder. 

• If pricing fails, an error message is displayed indicating the pricing process error(s). 
• For a Publications Mail SOM with a PAP Subsidy, a message is displayed indicating eligibility of the 

subsidy. 
 •  
Reprint • Enabled for Transmitted SOM’s only. 

• A Transmitted SOM has been selected:  Generates the SOM Reprint report and displays it in the Report 
Preview window. 

• For Unaddressed Admail SOM’s: 
• Displays a message to ask if the Admail Delivery Slips should also be printed.  If you select OK, 

then generates and prints the Admail Delivery Slips. 
• Displays another message to ask if the Labels should also be printed.  If you select OK, then 

generates and prints the Unaddressed Admail Labels. 
• The Unaddressed Admail Distribution Plan is printed automatically 

• SOM’s and Distribution Plans generated through the Reprint functionality contain a Reprint watermark on 
each page of the report.  

• For Unaddressed Admail, the SOM and Admail Delivery Slips generated through the Reprint functionality 
contain a Reprint watermark. 

Move • One or more entries in the List Pane have been selected (use the <SHIFT> key to select a block of 
entries and <CTRL> key to select non-adjacent entries). 

• Displays the Move Item(s) window to allow you to select the destination folder to which the selected 
items are to be moved. 

Delete Document • One or more entries in the List Pane have been selected (use the <SHIFT> key to select a block of 
entries and <CTRL> key to select non-adjacent entries). 

• Deletes the selected entries.  When the current folder is any folder other than the Deleted SOM’s or 
Deleted Logs folder, this action moves the selected items to the Deleted SOM’s/Logs folder.  No 
confirmation is requested. 

• If the current folder is the Deleted SOM’s or Deleted Logs folder, this action physically deletes the 
selected item(s) from the application database.  You are requested to provide confirmation. 

 •  
Open • Enabled for Templates, Opened/Finalized/Transmitted SOM’s, Finalized SOM’s, Transmitted SOM’s and 

Transmit Session Logs. 
• An Order or Template has been selected:  Opens the data entry window for the selected Order or 

Template and populates the window with data located in the selected Order or Template record. 
• Transmit Session Log record has been selected:  Displays the Transmit Session Log record in the Report 

Preview window. 
 
Tables: 
 
Address Book (Distribution Services)  This button allows you to create an address book, add/delete recipients to and from 

the address book, and edit address book entries 
Import Order File (Distribution Services)  This button allows you to import order entry information produced outside the 

Electronic Shipping Tools into the application database 
Export History This button allows you to export order history 
 
System: 



 

©

 
Help Opens a pop-up window containing the tools you need to complete an order 
Check for Updates This button allows you to query if any updates are available 
Exit Clicking this button closes all application windows and exits the desktop application.  If you were creating or 

editing a manifest in the Manifest window, a message appears asking if you want to save your changes.  
However, if certain windows are open, such as the Client window, this functionality does not work and the 
application emits a beep to inform you to close these windows first. 
 
You can also exit the application by selecting Exit from the File menu 

 
 
    2.5.2.1 Command Buttons 
 
ATTENTION!  These command buttons apply ONLY on the manifest line items, NOT on the individual transaction line items of each 

manifest.  For example, you CANNOT move a transaction line item from one manifest to another or delete a transaction from a 
manifest. 

 
All the command buttons you need to do a mailing are in one place, grouped in five different categories on this Desktop page.  
Some commands, designated here with a * can also be found from the toolbar.  
 

 

 

Shipping: 
 
 
 
 
(
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T
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T
 
 
 

 
Ship a Package
S

Distribution Services)  This button allows you to prepare and ship a package* 

Distribution Services)  This button allows you to track a package*   

h

C
yp

h

Track a Package 

 
Void an Item
is button allows you to void an item (shipment) 

Mailing: 

 
Create a SOM
ommunication Services)  This button opens a pop-up menu, which will determine the type of SOM you will create based on the 
e of service you select. 

 
Print a Report
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is button allows you to generate reports* that will help you reconcile your shipping business. 
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Documents: 
 
 
 
 
 
To transmit either an Open or Finalized manifest, click on its line item to select it and click this button.  A connection to the CPC 
server is initiated and validations are performed.  If an error occurs, a session log documenting the error is created either in the 
Finalize Session Logs folder or Transmit Session Logs folder.  If there are no errors, the manifest information is sent.  The 
application also prints the manifest. 
 
You must supply a printed Manifest to the Canada Post agent with your shipment.  Otherwise, your shipments run the risk to be 
refused. 
 

e:  If the transmission fails, the application prints a manifest with a “Non-Transmitted” watermark on each page.  Attach this 
ted copy to your shipment and retransmit the manifest later. 
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prin
Transmit/Print
TION!  Regarding manifests that failed on Transmit, Canada Post currently allows a grace period of 12 days during which 
ey can remain un-transmitted.  This grace period is under the control of Canada Post.  Once this grace period is over, you 

re locked out of the application and thus forced to connect to the CPC server to transmit these manifests.  This happens after 
ou click on the Desktop icon.  The Communication Status Notification window appears, on which you need to click 
onnect. 
Finalize/OnHold
lize an Open manifest, click on its line item to select it and click this button.  The application automatically moves the line item 
e Opened Manifests folder to the Finalized Manifests folder.  Some validations are performed, such as the validation of 

card information.  If an error occurs, a session log documenting the error is created in the Finalize Session Logs folder. 

t 
Reprin
e

n only reprint Transmitted manifests.  To do so, click on its line item to select it and click this button.  The printed copy has a 
nt” watermark on each page. 
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 change the status of a manifest by moving it to a different folder.  However, from a particular folder, the application dictates 
 other folders a manifest can be moved.  You can also move a Finalize or Transmit session log between its folder and the 
 Logs folder. 

e a line item, click on it to select it and click this button.  The Move Items pop-up window appears.  The permissible 
tion folders, along with the source folder, are displayed.  Click on the desired folder (it becomes bolded) and click OK.  To 
 action, click Cancel. 

 also perform the Move functionality by clicking on a line item to highlight it and selecting Move from the File menu. 

 the following table for permissible destination folders. 

FROM FOLDER TO FOLDER 
Opened Manifests Deleted Manifests 
Finalized Manifests Deleted Manifests, Opened Manifests 
Transmitted Manifests Deleted Manifests 
Finalize Session Logs Deleted Logs 
Transmit Session Logs Deleted Logs 
Deleted Manifests Opened Manifests (previously Open AND Finalized manifests), Transmitted Manifests 



 

©

(previously Transmitted manifests) 
7. Deleted Logs Finalize Session Logs (previously Finalize logs), Transmit Session Logs (previously 

Transmit logs) 
 
 
 
 
To delete a manifest or a log, click on its line item to select it and click this button.  If you do this in any folder except for the Deleted 
Manifests and Deleted Logs folders, NO confirmation message appears.  The application automatically moves the line item from 
the folder to the appropriate Deleted folder.  If you do this in the two aforementioned folders, a confirmation message appears.  Click 
OK to permanently delete the line item from the application.  Click on Cancel to keep the line item in the Deleted folder. 
 
You can also “delete” a line item via the Move button to move it to the appropriate Deleted folder or by selecting Delete from the File 
menu. 
 
 
 
 
To open a manifest of any status or a log of any type to see and print its information, click on its line item to select it and click this 
button.  For a manifest, the Manifest window appears with the Local ID indicated in the top bar.  For a log, the Reports window 
appears. 
 
You can also open a manifest or log by double-clicking on its line item or clicking on it to highlight it and selecting Open from the 
File menu. 
 
 
Tables: 
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Delete Document 

 
Address Book
istribution Services)  This button allows you to create an address book, add/delete recipients to and from the address book, and 
it address book entries * 

istribution Services)  This button allows you to import order entry information produced outside the Electronic Shipping Tools into 
e application database * 

Import Order File 

 
Export History
Septem

is button allows you to export order history * NEEDS FURTHER EXPLANATION WHEN MORE INFO BECOMES AVAILABLE 

ystem: 

is but

is but

 
Help
ton opens a pop-up window containing the tools you need to complete an order.  See section 10 for more details 
Check for Updates 
ton allows you to query if any updates are available*  

 
Exit
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Clicking this button closes all application windows and exits the desktop application.  If you were creating or editing a manifest in the 
Manifest window, a message appears asking if you want to save your changes.  However, if certain windows are open, such as the 
Client window, this functionality does not work and the application emits a beep to inform you to close these windows first. 
 
You can also exit the application by selecting Exit from the File menu * 
 
ATTENTION!  If you have entered data for a transaction on the Shipping window, clicking Exit will NOT prompt you to save your 
data or automatically save it for when the application is next launched 
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  2.5.3  Additional functionality 
 
Popup menus appear within the applicable windowpane when you hit the right mouse button for items located in the Folder and List 
Panes. 
 

POPUP MENU ITEM RESULT OF INVOCATION 

Folder Pane Popup Menu 
Create Folder • A folder has been selected from the Folder Pane. 

• Opens the Create Folder dialogue window. 
Rename • A user-created folder has been selected from the Folder Pane. 

• Highlights the name of the selected folder, and allows you to change its name. 
Expand • Expands the folder structure. 
Collapse • Collapses the folder structure. 
List Pane Popup Menu 
Open • If an Order or Template has been selected:  Opens the data entry window for the selected Order or 

Template and populates the window with data located in the selected Order or Template record. 
• For a SOM with a status of Transmitted, the following information is not retrieved from the saved SOM 

record. 
• Issue Date (Publications Mail only) 
• Mailing Date 

• If a Transmit Session Log record has been selected:  Displays the Transmit Session Log record in the 
Report Preview window. 

Delete • Deletes the selected entries.  When the current folder is any folder other than the Deleted SOM’s or 
Deleted Logs folder, this action moves the selected items to the Deleted SOM’s/Logs folder.  No 
confirmation is requested. 

• If the current folder is the Deleted SOM’s or Deleted Logs folder, this action physically deletes the 
selected item(s) from the application database.  You are requested to provide confirmation. 

Move • Displays the Move Item(s) window to allow you to select the destination folder to which the selected 
items are to be moved. 

 
      2.5.3.1 Move Item(s) Window 
 
This user interface component enables you to select the destination folder to which the selected items are to be moved.  Selecting 
the Move command button on the Desktop window or Move menu option from the File menu triggers it.  You will be able to traverse 
the application tree structure to select the destination folder to which the selected items are to be moved. 
 
Use the <SHIFT> key to select a block of items and the <CTRL> key to select non-adjacent items. 
 

 
 



 

©September 2004 Canada Post Corporation  15 

Move Item Destination Rules 

CURRENT FOLDER VALID DESTINATION FOLDERS 
Templates (including subfolders) • Templates subfolder(s) 

• Deleted SOMs subfolder(s) 
Opened SOMs (including subfolders) • Open SOMs subfolder(s) 

• Deleted SOMs subfolder(s) 
Finalized SOMs (including subfolders) • Finalized SOMs subfolder(s) 

• Opened SOMs subfolder(s) 
• Deleted SOMs subfolder(s) 

Transmitted SOMs (including subfolders) • Transmitted SOMs subfolder(s) 
• Deleted SOMs subfolder(s) 

Transmit Session Logs (including subfolders) • Transmit Session Log subfolder(s) 
• Deleted Logs subfolder(s) 

Deleted SOMs (including subfolders) • Deleted SOMs subfolders 
• Templates folder and subfolder(s) if selected deleted items are 

actually Templates 
• Opened SOMs folder and subfolder(s) if selected deleted items are 

previously Opened or Finalized SOMs 
• Transmitted SOMs folder and subfolder(s) if selected deleted items 

are previously Transmitted SOMs 
Deleted Logs (including subfolders) • Deleted Logs subfolder(s) 

• Transmit Session Logs subfolder(s) 
 
Note:  You cannot move Finalized SOMs from the Deleted SOMs folder directly back to the Finalized SOMs folder. 
 
 

3.0 Communications Services 
 

 3.1 Service Offerings 
 
The following Communications Services mailings can be made using Electronic Shipping Tools: 
 

• Lettermail TM  
• Addressed Admail TM  
• Publications Mail 
• Unaddressed Admail TM  
• International Incentive Letter-post TM  
• Catalogue Mail 

 
A brief description of each of the Service Offerings follows.  For detailed information about a specific Service Offering, just click on it in the list 
above if you are reading this guide online.  If not, please visit the Canada Post website (www.canadapost.ca) > Business Needs > Products and 
Services > Market with Direct Mail > I know what services I need, or contact your Canada Post Representative. 
 
  3.1.1 Lettermail  
  
Lettermail is a convenient, cost-effective, secure and high-impact way to send personal messages, business correspondence, 
invoices, billing statements and much more.  Lettermail is predictable in service, easy on the budget and easy to use. 
 
  3.1.2 Addressed Admail  
 
Addressed Admail consists of mailable items, bearing a uniform message, that: 
 

• Promote the sale or use of products or services; 
• Report on financial performance, primarily for promotional purposes or; 
• Solicit donations or contributions. 
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  3.1.3 Publications Mail 
 
Publications Mail includes newspapers, magazines and newsletters, which are: 
 

• Mailed in Canada and addressed to a subscriber, non-subscriber or news dealer anywhere in Canada and; 
• Produced for the purpose of disseminating news and information to the public. 

 
  3.1.4 Unaddressed Admail  
 
Unaddressed Admail consists of printed matter and product samples that are not addressed to specific delivery addresses in 
Canada.  Unaddressed Admail can be used to deliver advertising messages to some 13 million homes and businesses served by 
Canada Post.  Advertisers can direct their messages to an area as large as the entire country or as small as a single letter carrier 
walk. 
 
  3.1.5 International Incentive Letter-post  
 
International Incentive Letter-post offers qualifying Canadian-based, large-volume commercial mailers an incentive-based service 
for mail destined to all areas in the USA and internationally. 
 
  3.1.6 Catalogue Mail 
 
Catalogue Mail is printed matter of bound or sewn pages, which are specifically designed to sell and/or promote products or 
services, and includes, but is not limited to, a telephone directory, a university calendar and a list of products. 
 
 

4.0 Using the Electronic Shipping Tools Application 
 

 4.1 Creating an Electronic Statement of Mailing (SOM) 
 
Creating an electronic Statement of Mailing is simple – there are seven steps involved in creating a Statement of Mailing.  This 
application guides you in capturing customer information and your mail deposit, calculates your postage and prints your Statement 
of Mailing (SOM), reducing complexity and saving you valuable time. 
 

SOM TASK TASK COMPONENTS & CHARACTERISTICS 

1. Create a new SOM from the Main Menu Select File, New SOM from the Main Menu or click on command button Create a 
SOM.  Select from the submenu the applicable Service Offering – Lettermail, 
Addressed Admail, Publications Mail, Unaddressed Admail, Unaddressed Admail 
– AdCard, International Incentive Letter-post or Catalogue Mail.  This action will 
open the appropriate data entry window.  From here, you can begin to capture the 
information required for the mailing you want to do.  For details on the Service 
Offerings available, see Section 4.1 Service Offerings. 

2. Enter your Mailing information (Header 
Level) 

At the Header Level, enter customer information that is required to ensure 
accurate pricing and billing (where applicable) of the transaction. 

3. Enter information regarding the Items to 
be mailed (Grid Level) 

At the Grid Level, enter the details of your mailing as it pertains to the service 
description(s) selected here.  You will be required to enter information concerning 
the number of pieces, weight and other specific information as it pertains to your 
service description(s). 

4. Calculate, Preview or Finalize your SOM 
(optional but highly recommended) 

Click the Calculate command button to calculate and display the price on the form 
for your SOM. 

OR 
Click the Preview command button to calculate and display the price on the form 
for your SOM, save your SOM and display your Preview in the Report Preview 
window. 

OR 
Click the Finalize command button to calculate the price of your SOM.  If the 
rating is successful, the Order is saved with a status of Finalized and the order 
record is automatically moved to the Finalized SOMs folder.  The data entry 
window is closed and the Desktop window is displayed. 

5. Save your SOM as a Template 
(optional) 

Templates allow you the ability to save data entered for reuse when creating 
another SOM.  Select File, Save As Template from the Main Menu.  Enter a 
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SOM TASK TASK COMPONENTS & CHARACTERISTICS 

filename in the field and click the Save button. 
6. Transmit your SOM to Canada Post 

Corporation 
Click the Transmit/Print command button to initiate connection with the CPC 
server.  This function also performs a software update check, validates 
information and creates a Transmit Session Log.  If the Transmit/Print function is 
successful, the Order record is saved with a status of Transmitted and 
automatically moved to the Transmitted SOMs folder.  For Unaddressed Admail, 
the ADS Sequential Number is generated for each Delivery Installation Detail 
record. 

7. Print your documents Upon successful transmission of your Order, print copies (3) of your SOM by 
selecting the Printer icon on the tool bar. 
 
If you selected Unaddressed Admail, a SOM and Distribution Plan will be printed 
followed by your ADS and labels. 

 
 4.2 SOM Data Entry  
 
Upon selecting File, New SOM, Lettermail from the Main Menu or by selecting a Lettermail SOM from the Templates or Opened 
SOMs folder, the VCD data entry window for Lettermail is presented.  The data entry windows for the other Service Offerings are 
similar to this one.  However, there are a few differences with respect to the information you are required to enter. 
 
Sample of Lettermail Data Entry page 
 

 
 

 
 
Sample of Unaddressed Admail Data Entry page 
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This window has several modes of operation.  It can be used to create a new SOM or SOM Template, update an existing SOM or 
SOM Template, or enter a partial SOM and save it to be completed at a later time. 
 
When this window is opened, it will be blank or populated with data from a current SOM or SOM Template.  You can then enter or 
update existing data to complete the SOM.  This window provides limited field validation to provide you with the maximum flexibility 
when entering mailing information. 
 
The following describes the basic functionality of this window: 

1. The local identifier is displayed on the title bar adjacent to the window name as follows: 
• When a new SOM or SOM Template is created, the local identifier is blank. 
• When a previously saved SOM is displayed, the local identifier is equal to the Order ID generated locally. 
• When a previously saved SOM Template is displayed, the local identifier is equal to the Template Name. 
• When a transmitted SOM is displayed, the local identifier is equal to the SAP Order ID. 

2. The service descriptions displayed depend on the Contract and Service Offering selected. 

 
Note:  Although only contracted services available in the selected contract are displayed, all non-contracted service 

descriptions for the given Service Offering are also displayed.  If a Contract Number has not been supplied, then only 
the non-contracted services will be displayed.  If the Contract Number is modified, the Service Descriptions column 
will be reset. 

 
3. If a SOM Template has not been selected, then the Mailed on Behalf of Customer Number is defaulted to the Mailed By 

Customer Number. 
4. If a SOM Template has not been selected, the Contract Number is defaulted to the one associated to the Mailed on Behalf 

of Customer.  However, you can instead select the one associated to the Mailed By Customer.  If the Mailed on Behalf of 
Customer selection is modified, then the Contract Number will be defaulted to the one associated with the new Mailed on 
Behalf of Customer. 

5. When the Mailed On Behalf Of drop-down list is expanded, the Customer Names and the associated Customer Numbers 
are displayed.  When a value is selected and thus the drop-down list is collapsed, the field displays the Customer Number 
only. 

6. The Paid By Customer drop-down list is populated with the Mailed on Behalf of and Mailed By Customer partners of type 
Payer.  When the drop-down list is expanded, it displays the Customer Names and the associated Customer Numbers.  
When a value is selected and thus the drop-down list is collapsed, the field displays the Customer Number only. 

7. The values for the Method of Payment are:  Account, Credit Card and Metered. 
8. If a SOM Template has not been selected, the Method of Payment field is defaulted with the Preferred Method of Payment 

associated with the Paid By Customer. 
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9. The Method of Payment drop-down list is filtered to exclude Metered as a Method of Payment for the following Service 
Offerings:  Publications Mail, Unaddressed Mail, International Incentive Letter-post and Catalogue Mail. 

10. For Publications Mail: 
• The Contract Number filters the Publication Title and PAP Registration Number fields.  When the Contract Number is 

modified, then the Publication Title and PAP Registration Number fields are reset. 
• The Publication Title filters the PAP Registration Number drop-down list.  When the Publication Title is modified, then 

the PAP Registration Number field is reset. 
 

(Points #11 to #14 pertain to applicable Service Offerings other than Unaddressed Admail) 
11. Downstream Entry is applicable to Addressed Admail, Publications Mail and Catalogue Mail Service Offerings to allow the 

customer to specify the Date of Mailing and Outlet at the line item level.  When the Downstream Entry checkbox is 
selected, the following changes are applied to the applicable SOM data entry window: 
• The Outlet, Date of Mailing and Shipment No. columns are displayed in the data grid.  The fields are defaulted to the 

values entered on the header, if available, for: 
• All line items containing data in the data grid or; 
• The first line item, once the service description is selected, if no data has been entered in the data grid; 

• Outlet is defaulted only if the value entered on the header is a Revenue Verification Unit (RVU) type; 
• Shipment No. is defaulted to “1”. 
• The Outlet drop-down list in the data grid is populated with RVU type outlets. 
• The Outlet field label is changed to Payment Outlet on the header. 
• The Date of Mailing is cleared and disabled on the header. 
• The Container fields (i.e. Monos, Skids, Small Bags, Large Bags, Hard Sided) are cleared and disabled. 
• You can enter a maximum of 13 line items on the data entry window (note that they can all have the same Outlet 

(RVU), Date of Mailing and Shipment No. combination). 
• When a new line item is entered (i.e. a Service Description is selected on a new line), the Outlet, Date of Mailing and 

Shipment No. fields are defaulted to the values entered on the previous line. 
12. When Downstream Entry is selected, the Outlet entered at the line item level is used in rating the SOM. 
13. Mailing Type of Partial is applicable to Addressed Admail, Publications Mail and Catalogue Mail Service Offerings to allow 

the customer to specify the Date of Mailing at the line item level.  When the Partial radio button is selected, the changes 
made to the SOM data entry window for Downstream Entry are applied with the exception of the Outlet change. 

14. The Outlet, Date of Mailing and Shipment No. fields in the data grid are hidden when Downstream Entry and/or Mailing 
Type of Partial are not selected. 

 
(Points #15 to 22 apply to Unaddressed Admail) 

15. The following is an important observation to keep in mind.  On the Delivery Installation Details page, when you set the 
Deposit Location field EQUAL to the Delivery Installation field, this means that you will directly drop off your mail at that 
specified Delivery Installation.  To the application, this situation does not have an actual Deposit Location (and thus 
Transportation Required cannot be selected).  To the application, an actual Deposit Location is created only when that 
field is DIFFERENT from the Delivery Installation field. 

16. If there are different Deposit Dates on the Delivery Installation Details pages AND at least one of the Details pages has 
the Deposit Location field DIFFERENT from the Delivery Installation field (this means that Transportation Required needs 
to be selected, because the mail is being brought from the Deposit Location to the Delivery Installation), the Mailing Type 
is automatically set to Partial by the application.  This field is display-only.  In this case: 
• The Deposit Date column is displayed in the data grid, populated and display-only.  The Shipment Number column is 

also displayed and defaulted to “1”. 
17. If there is more than one Deposit Location selected (i.e. that field is different from the Delivery Installation field) on the 

Delivery Installation Details pages - this includes the scenario of one or more Deposit Locations coupled with one or more 
direct drop-offs to the Delivery Installations (i.e. the Deposit Location is the same as the Delivery Installation), the Order is 
classified as Downstream Entry by the application.  In this case: 
• The Deposit Date and Deposit Location columns are displayed in the data grid, populated and display-only.  The 

Shipment Number field is also displayed and defaulted to “1”. 
 
Note:  On the data entry window, there is no indication that the Order has been considered Downstream Entry by the 

application (such as a display-only selected checkbox).  To find this out, look at the line item in question in the List 
Pane.  There is a Downstream column.  If it is set to true, then the Order is Downstream Entry. 

 
18. Following the logic of the previous two points, if an Order has the Mailing Type set to Full and is NOT Downstream Entry, 

then the Deposit Location, Deposit Date and Shipment Number fields do not appear in the data grid of the data entry 
window. 
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19. If you created one line item and enter data on the Delivery Installation Details pages that includes multiple Deposit 
Locations, multiple Deposit Dates and/or direct drop-offs to Delivery Installations, the application automatically groups the 
Delivery Installations according to the following rules: 
• A separate SOM line item is generated for each unique Deposit Location and Deposit Date combination, and the 

related Delivery Installation data is automatically associated to the appropriate SOM line item. 
• All direct drop-offs to Delivery Installations (i.e. the Deposit Location is set equal to the Delivery Installation) are 

grouped into one line item, even if they have different Deposit Dates.  This SOM line item has the Deposit Date and 
Deposit Location fields left blank.  You should set the Deposit Date equal to the EARLIEST Deposit Date of the 
direct drop-offs involved, and leave the Deposit Location blank. 

20. If you do not complete ADS data for ALL of the Delivery Installations that you have chosen for one Mailing Plan Summary, 
then a separate line item is created on the Unaddressed Admail data entry window to account for the Incomplete Delivery 
Installations. 

21.  ‘Mail Pieces Over 14” X 6” (35.56 x 25.4 cm)’. When this selection box is chosen a validation will occur to ensure that 
all Delivery Installations related to the Statement of Mailing (SOM) have only the “Business” target area selected if there 
are any Letter Carrier Delivery Modes selected for this Delivery Installation. 

 
For more information , please consult the Canada Postal Guide  

 http://www.canadapost.ca/business/tools/pg/manual/c12-e.asp 
 

ATTENTION:  The first time that you click the DI Details button for this line item, you are brought to the Mailing Plan 
Summary window with the Incomplete Delivery Installations listed.  At this point, you can still access these Delivery 
Installations to enter ADS data for them (highlight one and click Go to DI).  However, if you click Close without doing 
anything, these Delivery Installations will no longer be listed the next time you click the DI Details button (i.e. you 
must add them to your Mailing Plan again). 

22. The Cost Centre field is filtered by the Mailed on Behalf Of Customer Number.  The drop-down list is sorted alphabetically 
and contains the value selection of None, which is displayed at the bottom of the list.  When the Mailed on Behalf of 
Customer Number is modified, then the Cost Centre field is reset. 

23. After selecting a mail Service Description, the unit field on the same grid row is automatically populated with the unit of 
measurement associated with the selected mail service. 

24. The Average Weight command button located on the Lettermail, Addressed Admail, Publications Mail and Catalogue 
Mail data entry windows is enabled only when the cursor is located on one of the Weight fields in the grid.  Activation of 
this command button will also be achievable via the hot key ‘g’. 

25. When you click the Average Weight command button, the Weighted Average Weight Calculator window is displayed.  
If you click the Apply command button on this window, the No. of Pieces and Weight fields on the current grid row are 
populated with the values calculated on the Weighted Average Weight Calculator window.  The No. of Pieces is set to 
the Total (No. of Pieces) and the Weight is set to Weighted Average Weight per Piece. 

26. The Options grid column contains a navigation button to the Select Options window.  This feature is available only for a 
given Lettermail or Unaddressed Admail – AdCard Service Description.  If the Service Description selection is modified, 
the Options data related to that particular line item is cleared. 

27. When you modify the Service Description entered by selecting the blank line in the Service Description drop-down list, all 
data for that line item is cleared.  For Unaddressed Admail, when the user selects the blank line in the Service Description 
drop-down list, a warning message will appear to indicate that this action will delete all the related ADS data. 

28. For Unaddressed Admail: 
• The No. of Pieces fields are display-only.  The No. of Pieces field will be populated by the system and derived by 

summing the Total Pieces Shipped for Delivery fields (from the Delivery Installation Details pages) associated to the 
given SOM line item. 

• The DI Details Entered? checkbox will be display-only.  The system will populate the checkbox based on whether or 
not ADS data exists for the SOM line item in question. 

• The Sort ADS Form for Printing radio button should be defaulted to the Delivery Installation Postal Code selection. 
29. For Lettermail, the following grid columns should not be displayed unless they contain a non-zero value:  Registered. 

Additional Coverage and Advice of Receipt. 
30. The following table defines the number of lines available for data entry on the SOM Data Entry windows when 

Downstream Entry checkbox and/or Mailing Type of Partial radio button is not selected. 

SERVICE OFFERING NUMBER OF LINES IN THE GRID 

Lettermail 13 
Addressed Admail 13 
Publications Mail 13 
Unaddressed Admail 13 
Unaddressed Admail – AdCard 13 
International Incentive Letter-post 13 
Catalogue Mail 13 
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  4.2.1 Command Buttons 
 
The following table describes the fields and Command Button 
 

COMMAND BUTTON RESULT OF INVOCATION 

Average Weight • Opens the Weighted Average Weight Calculator window. 
Select  • Not present on the SOM data entry window for Unaddressed Admail. 

• Enabled when entering or modifying a SOM or Template. 
• Opens the Select Outlet/Induction Point window. 

New • Enabled when entering or modifying a SOM or Template. 
• Opens the Cost Centres window. 
• Upon return to the data entry window, the newly created Cost Centre is displayed in the drop-down list 

if it is associated to the Mailed on Behalf of Customer Number selected. 
DI Details • Appears in the DI Details column for a particular line item once a Service Description is selected. 

• Validates that a Mailing Date has been entered.  Note that for SOM’s where Partial Mailing has been 
selected, it is the Mailing Date associated to the given line item that is mandatory.  If the validation 
fails, an error message is displayed. 

• Validates that the Mailing Date is less than or equal to the Householder Data Expiry Date.  Note that 
for SOM’s where Partial Mailing has been selected, the relevant Mailing Date is the one associated to 
the given line item.  If the validation fails, an error message is displayed. 

• If validations are successful and ADS data exists, then displays the Mailing Plan Summary window. 
• If validations are successful and no ADS data exists, then displays the Select Delivery Installation(s) 

for Mailing Plan window. 
Calculate • Enabled when entering or modifying a SOM; at least one line item is required. 

• Initiates validations and generates price. 
• If pricing fails, an error message is displayed indicating the process error. 

Preview • Enabled when entering or modifying a SOM. 
• Initiates validations and generates price. 
• If pricing is successful then 

• The SOM transaction is rated; 
• The totals are displayed on the form; 
• The SOM is saved and; 
• The SOM Preview is created and displayed in the Report Preview window. 

• If pricing fails, an error message is displayed indicating the process error. 
Finalize/On Hold • Enabled when entering or modifying a SOM. 

• Performs the same process as the Finalize button on the Desktop window. 
• If the pricing process completes successfully, the data entry window is closed and the Desktop window 

is displayed; otherwise the data entry window remains open. 
Transmit/Print • Enabled when entering or modifying a SOM. 

• Performs the same process as the Transmit/Print button on the Desktop window. 
• If the Transmit/Print process completes successfully, the data entry window is closed and the Desktop 

window is displayed; otherwise the data entry window remains open. 
Save • If you are editing an existing SOM or Template, the SOM or Template is saved to its current location. 

• If you have created a new SOM, the SOM is saved in the Opened SOMs folder. 
• The SOM is saved with a status of Opened. 
 
Note:  If you have created a new SOM Template, you must save it by choosing File, Save as Template from 

the Main Menu. 
Clear • Confirmation is required before all modifiable fields are cleared on the data entry window. 
Close • The data entry window is closed and the Desktop window is displayed. 

• If you have not yet saved your newly entered data or changes, asks if you want to save your changes 
or not. 

• If you have created a new SOM, a line item for it is created in the Opened SOMs folder. 
 
  4.2.2 Menu Functionality for SOM Data Entry Window 
 
MENU ITEM RESULT OF INVOCATION 

File • Shows submenu consisting of the following: 
¾ Load Template 
¾ Save 
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MENU ITEM RESULT OF INVOCATION 

¾ Save As Template 
¾ Finalize 
¾ Close 

Data Maintenance • Shows submenu consisting of the following: 
¾ Customer… 
¾ Cost Centres 

Tools • Shows submenu consisting of the following: 
¾ Calculate 
¾ Preview 

Window • Shows submenu consisting of the following: 
¾ Return to Electronic Shipping Tools Desktop 

Help • Shows submenu consisting of the following: 
¾ Help 

Submenus of File 
Load Template • The Open window is displayed.  The current folder on the window is set to the Templates folder from 

which you can navigate to select a template to load. 
• Once you have selected a template to load, the data on the form is overwritten with the data saved in the 

template if it is the same Service Offering; otherwise displays the appropriate data entry window. 
Save • Same as the Save command button. 
Save As Template • The Save as Template window is displayed.  You can then enter the name of the Template being saved. 
Finalize • Same as the Finalize command button 
Close  • Same as the Close command button. 
Submenus of Data Maintenance 
Customer  • Opens the Customer window.  See Data Maintenance section. 
Cost Centres • Opens the Cost Centres window.  See Data Maintenance section. 
Submenus of Tools 
Calculate • Same as the Calculate command button. 
Preview • Same as the Preview command button. 
 •  
 
 
  4.2.3 Weighted Average Weight Calculator Window 
 
This user interface component enables you to calculate the Weighted Average Weight.  It is triggered when you click the Average 
Weight command button on the Addressed Admail, Lettermail, Publications Mail, and Catalogue Mail SOM data entry windows. 
 
There are three fields displaying information on this window, of which two require data entry: 

• Service Description - The mail service for which the Weighted Average Weight is being calculated.  This field is 
display-only. 

• No. of Pieces - Enter the number of pieces that the weight is applicable to in the grid column. 
• Weight/Piece - Enter the weight of a single piece in the grid column. 

 
The following fields are calculated on this window. 

• Sub-Total - The total weight of each line (i.e. Weight/Piece * No. of Pieces). 
• Total (No. of Pieces) - The sum of the No. of Pieces column. 
• Total (Sub-Total) - The sum of the Sub-Total column.  This is the total weight of all pieces entered. 
• Weighted Average Weight per Piece - This is the average weight of a single piece.  It is calculated as Total (Sub-

Total) / Total (No. of Pieces) 
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Command Buttons 
 
The following table describes the fields and Command Button 
 

COMMAND BUTTON RESULT OF INVOCATION 

Calculate • Performs the calculation for the fields that are calculated.  If you have not completed the entry of a 
grid line, an error message will be displayed. 

Apply • Performs the calculation for the fields that are calculated. If you have not completed the entry of a 
grid line, an error message will be displayed. 

• The values in the Total (No. of Pieces) and the Weighted Average Weight per Piece fields are 
returned to the calling data entry window.  These values are used to populate the No. of Pieces and 
the Weight per Piece columns on the current line in the data entry window. 

Print • The Weighted Average Weight Calculation report is created and displayed in the Report Preview 
window. 

• The Weighted Average Weight Calculation report should be attached to the printed copy of the 
SOM.  This report is then used by CPC to verify that mailing items below the base weight have not 
been combined with items above the base weight in the weighted average weight calculation. 

Clear • All fields on the window are cleared.  No confirmation is requested. 
Cancel • Closes the window.  No confirmation is requested. 
 
 
Below is a sample of the Weighted Average Weight Calculation report. 
 

Service Description: No. of Pieces Weight/Piece Sub-total 

Some Mail Service Description nnnnnnnn nnnn.nnn nnnnnn.nnn 

 nnnnnnnn nnnn.nnn nnnnnn.nnn 

 nnnnnnnn nnnn.nnn nnnnnn.nnn 

 nnnnnnnn nnnn.nnn nnnnnn.nnn 

 nnnnnnnn nnnn.nnn nnnnnn.nnn 

 nnnnnnnn nnnn.nnn nnnnnn.nnn 

    

Total: nnnnnnnnn  nnnnnnn.nnn 

  

Weighted Average Weight per Piece: nnnn.nnn 
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  4.2.4 Select Options Window 
 
This user interface component enables you to select options for a given Lettermail or Unaddressed Admail – AdCard Service 
Description.  Clicking the Options button in the Options grid column on the Lettermail or Unaddressed Admail data entry window 
opens this window. 
 

1. The list of options currently available for Communications Services – Lettermail are Registered, (Additional) Coverage, 
and Advice of Receipt. 

2. Some options, such as (Additional) Coverage, require an entry of an associated dollar amount in the Value field. 
3. The list of options currently available for Communications Services – Unaddressed Admail – AdCard are Perforation, 

Scratch & Win, Fifth (5th) Colour, Die Cutting, 8 Point Coated Two Sides Stock, and 10 Point Coated One Side Stock. 
 

 
 
 
Service Description – This display-only field identifies the Service Description in question.  It is retrieved from the current line item on 
the calling data entry window. 
 
Number of Pieces – This display-only field identifies the Number of Pieces associated with the Service Description in question.  It is 
retrieved from the current line item on the calling data entry window. 
 
Option Indicator (no label) – This checkbox column identifies whether or not the option in question has been selected. 
 
Description (no label) – This display-only field identifies the Name of the option in question. 
 
Value (no label) – This numeric field with two decimal places is mandatory if enabled and identifies the value associated to the 
option in question. 
 
Command Buttons 
The following table describes the Command Button definitions and displays the hot key definitions (by underlining the letter in 
question). 
 
COMMAND BUTTON RESULT OF INVOCATION 

Save • Performs validations. 
• If validations are successful, saves the Option data. 
• If validations are not successful, displays appropriate error message. 

Close • Initiates cross-field validations. 
• If validations are successful, saves the Option data and closes the window. 
• If validations are not successful, displays appropriate error message. 
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  4.2.5 Select Outlet/Induction Point Window 
 
The Select Outlet/Induction Point window is invoked on the data entry window by clicking the Select command button. 
 

• Select from either the “Major postal facilities only” or “All postal facilities” list by choosing the appropriate radio button. 
• Search for an Outlet by Province AND City or Outlet Number.  The Outlet is where the mail will be brought for induction 

into CPC’s mail stream.  The Search function does not work if only a city or province is selected. 
• Highlight an Outlet and click Apply to automatically populate the Outlet field on the calling data entry window. 

 

 
 

 
 
Command and Navigation Control Definitions 
 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR FIELD RESULT OF INVOCATION 

Search Outlet/ 
Induction Point 

• Select  “Major postal facilities only” or “All postal facilities” to search for the Outlet/Induction 
Point where your mailing will be deposited. 

Province 
(Drop-Down List) 

• Allow you to perform a search by province. 

City 
(Drop-Down List) 

• When you select or change a province, the city list is filtered based on the chosen province. 

Outlet Number • Allow you to perform a search by Outlet Number (has precedence over other search criteria). 
Search 
 

• Extracts all Outlets that match the Outlet Number (if entered), or the province and city (if both 
entered). 

• Populates the Outlet list with matching records. 
Outlet List • Displays the records matching the search criteria.  Allow you to select an Outlet from the list 

and see the details about that Outlet. 
Apply • Returns the selected Outlet Number and Name to the data entry window. 
Cancel • Closes the window and returns you to the calling data entry window. 
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4.3 Creating Admail Delivery Slips for Unaddressed Admail 
 
The Admail Delivery Slip (ADS) functionality for Unaddressed Admail is a new feature of Electronic Shipping Tools.  It allows the 
user the ability to capture the ADS information required to produce the ADS, the Distribution Plan and Labels. The steps involved in 
entering ADS data for the first time are as follows: 

1. Select Unaddressed Admail from File, New SOM or click on the Create a SOM button, then select Unaddressed Admail.   
You may select to create an Unaddressed Admail SOM without Delivery Installation Details – SOM Only or to continue to 
create an Unaddressed Admail SOM with Delivery Installation Details – Fully Featured 
 
Two options are available for Unaddressed Admail: Unaddressed Admail SOM without Delivery Installation Details 
(SOM Only) and SOM with Delivery Installation Details (Fully Featured). There will be an incentive starting January 
2005 for customers who use the Fully Featured option. Messaging will be provided on the invoice effective January 2005 
indicating the Fully Featured service had been used. 
 
a. SOM only option: You will be provided a SOM only without associated forms / labels / reports (the print preview 

other similar functions, e.g. reports, are not included in this). DI Details buttons & fields, NPS Consolidation fields, E-
mail Notification fields, Sort ADS Forms, Collate ADS forms, Mail Piece over 14” X 6” field and Print Container Label 
button will be disabled with this option. EST will include the appropriate contract price in the price calculation when 
you select this option 

b. Fully Featured EST with incentive: You will be provided a SOM with all associated forms / labels / reports. As of 
January 2005, you will receive a 2% discount for Unaddressed Admail orders when you complete all mailing plan 
details as required for the Fully Featured option. EST will include the “fully featured” incentive in the price 
calculations for contract and non-contract customers. When you select Fully Featured, all mailing plan data and 
barcoded documents must accompany the mailing, including: 

i.  Statement of Mailing (SOM) 
ii.  Distribution Plan 
iii.  Packing Slips 
iv.  Unaddressed Admail Delivery Slips 
v.  Container Labels 

Enter your SOM data. (Steps 1 to 3 as described in creating an Electronic Statement of Mailing). 

2. Click the DI Details command button for the requested Service Description.  If the DI Details Entered  Checkbox is 
checked, this indicates that ADS data already exists for the given Service Description.  Both the command button and 
checkbox appear after you select a Service Description. 

3. Select the Delivery Installation(s) for your Mailing Plan. 

4. Enter Delivery Installation Detail information. 

5. Get Householder Count data online. 

6. Delete or clear ADS data. 

7. View Mailing Plan Summary. 

8. Preview Unaddressed Admail SOM and Distribution Plan.  If you have chosen the NPS Consolidation option, you can 
preview the NPS Consolidation report. 

9. Verify SOM and Distribution Plan. 

10. Transmit information to Canada Post. 

11. Print SOM and Distribution Plan, ADS and Labels (see Section 5.5.1 Print SOM and Section 5.5.4 Other Unaddressed 
Admail Reports).  If you have chosen the NPS Consolidation option, print NPS Consolidation report and Mono Label(s).  If 
the Order is for multiple Deposit Locations, print Summary of Mailing and Packing Slip(s). 

 
Admail Delivery Slips (ADS), SOMs and Distribution Plans can be printed on regular 8 ½ x 11-inch sheets of regular bond paper.  To 
obtain the adhesive labels to print tie-on-tags and labels, please contact your Canada Post Representative, Commercial outlet or by 
calling our Business Hotline at 1-800-260–7678. 
 
Assuming that your SOM data has already been entered, click the DI Details command button to create your Mailing Plan (Step 3). 
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  4.3.1 Selecting the Delivery Installation for Your Mailing Plan 
 

 
 
 
 
ADS data is entered for an associated line item on the SOM you have entered.  To initiate ADS data entry, click the DI Details 
button next to the SOM line item in question from the Unaddressed Admail data entry window.  This initiates the display of the 
Select Delivery Installation(s) for Mailing Plan window above if no ADS data exists. 
 
The Select Delivery Installation(s) for Mailing Plan window allows you to search for delivery installation names based on the 
following search criteria:  Province, Delivery Area and/or FSA/Postal Code.  These fields are located at the top of the window.  To 
initiate the search, click the Search command button. 
 
Once the search results are returned, make your selection of the Delivery Installation(s) that will be added to the Mailing Plan.  
Multiple searches can also be performed in order to create your list of Delivery Installations. 
 

1. Upon display of the Select Delivery Installation(s) for Mailing Plan window, an informational message is displayed (if 
the DI Details button was used to navigate to this window).  This message window contains a “Don’t show me again” 
checkbox, and OK button and the following message text: 

 
“You must first select the Delivery Installations.  Once this step is completed, you can enter the detailed delivery 
instructions for each Delivery Installation selected.  Consult Help for further information and printer requirements.” 

 
If the user checks the “Don’t show me again” checkbox, then this message will not be displayed again. 

 
2. You can search for Delivery Installation names as follows.  First select a Province from the drop-down list.  You can filter 

the search even more by entering a Delivery Area and/or FSA/Postal Code.  Partial searches on Delivery Area name and 
FSA/Postal Code are also supported.  For example, entering “C” only for Delivery Area would result in all Delivery 
Installations that service Delivery Areas that begin with the letter “C” for the Province in question.  Entering just “K” for 
FSA/PC would result in all FSA/PC’s beginning with the letter “K” for the Province in question.  At a minimum, one search 
criterion must be specified.  However, more than one search criterion can be entered. 

 
Note:  You can do a search with only the Province.  However, your list of results may be too long.  You can also do a 

search with just entering either the Delivery Area name or FSA/PC. 
 

Search criterion is not case-sensitive, as data entered is converted to uppercase.  For the FSA/PC, even if you type lower-
case letters, they immediately appear as upper-case letters. 

 
3. Delivery Installation Name(s) that match the search criteria are listed alphabetically in the Search Results list. 
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4. You can highlight one or more Delivery Installation Name(s) in the Search Results list and click the Add > button in order 

to add the selected Delivery Installation(s) to the Mailing Plan.  The Add All >> button is enabled when the Search 
Results list is populated.  The Add > button is enabled when you make one or more selections. 

 
Note:  You can use the <SHIFT> key to select a block of records in the Search Results list.  You can use the <CTRL> key 

to select non-adjacent records. 
 

5. To remove one or more Delivery Installation Name(s) in the Delivery Installation(s) Added to Mailing Plan list, highlight 
one or more Delivery Installation Name(s) and click the < Remove button.  The << Remove All button is enabled when 
the Delivery Installation(s) Added to Mailing Plan list is populated.  The < Remove button is enabled when you make one 
or more selections. 
 
Note:  If you attempt to remove a Delivery Installation that was previously selected and has user-entered data associated 

to it, then an error message will be displayed to inform you that all associated Delivery information will be deleted. 
 

6. The Delivery Installation Name(s) in the Delivery Installation(s) Added to Mailing Plan list is sorted in the order that the 
Delivery Installations are selected. 

 
7. From this window, you can also import Delivery Installations data by clicking the Import button.  For complete details, see 

Section 5.3.5 Import Delivery Installations Data. 
 
 

• The Import button displays the Open File – Import Delivery Installations Data window.  This file location window 
allows you to select a CSV file to import the ADS data that should be associated to the given SOM line item. 

• If the Delivery Installations data was imported, then the Delivery Installation(s) Added to Mailing Plan list should be 
pre-populated with the Delivery Installation Names from the import file. 

 
Notes:  The import file does not contain the actual Delivery Installation Name, but contains the Delivery Installation Postal 

Code that can then be uniquely mapped to the corresponding Delivery Installation Name. 
 
You can add a Delivery Installation to the same Mailing Plan more than once.  One situation that requires this is 
when you want your mail to be transported from the same Deposit Location but on different Deposit Dates.  Hence 
you need a Delivery Installation Details page, with the same Delivery Installation, for each Deposit Date.  In such a 
case, the application does give you a warning message. 
 
If you remove imported Delivery Installation Names from the Delivery Installation(s) Added to Mailing Plan list, these 
do NOT appear in the Search Results list. 

 
 
Command and Navigation Control Definitions 
 
The following table describes the fields and Command Button 
 

COMMAND BUTTON RESULT OF INVOCATION 

Search • Enabled when data has been entered in at least one search criteria field. 
• Generates and initiates a query based on the search criteria entered. 
• If no Delivery Installations are found that match the search criteria, then a message is displayed. 
• If one or more Delivery Installations are found, then list them in the Search Results list. 

Add > • Enabled when one or more Delivery Installation Name(s) are highlighted. 
• Adds the selected Delivery Installation Name(s) to the Delivery Installation(s) Added to Mailing 

Plan list. 
< Remove • Enabled when one or more Delivery Installation Name(s) are highlighted. 

• Removes the selected Delivery Installation Name(s) from the Delivery Installation(s) Added to 
Mailing Plan list. 

Add All >> • Enabled when the Search Results list is populated. 
• Adds all the Delivery Installation Names from the Search Results list to the Delivery Installation(s) 

Added to Mailing Plan list. 
<< Remove All • Enabled when the Delivery Installation(s) Added to Mailing Plan list is populated. 

• Removes all the Delivery Installation Name(s) from the Delivery Installation(s) Added to Mailing 
Plan list back to the Search Results list (except if they are imported Delivery Installation Names). 

Split Walk Report • Opens a preview window that gives the complete Target Area of the delivery mode; identifies 
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COMMAND BUTTON RESULT OF INVOCATION 

prior to the mailing, which route should be selected to have a complete walk; Shows that the 
Delivery Installation Details have been completed correctly. 

Import • Opens the Open File- Import Delivery Installation Data window.  See Section 5.3.5 Import 
Delivery Installations Data. 

DI Defaults • Makes it easier to complete the information for Unaddressed Admail mailings and the associated 
Delivery Installations targeted 

• Enabled when the delivery installations added to the Mailing Plan list contains at least one 
delivery installation (DI) name 

• Allows definition of the DI Defaults that will apply to the entire mailing plan and eliminates the 
need to navigate through each of the delivery installations pages for a new mailing plan 

Apply • Applies the selected Delivery Installation Name(s) to the Delivery Installation Details page(s).  
Each Delivery Installation Name is associated to one page. 

• Closes the Select Delivery Installation(s) for Mailing Plan window and displays the first Delivery 
Installation Details page. 

 �  

Cancel • Closes the window.  No confirmation is requested. 
 
    4.3.2 Delivery Installation Defaults 
 
Clicking on the DI Defaults button on the Select Delivery Installation(s) for Mailing Plan screen displays the new Delivery Installation 
Defaults page.   
 
This page allows completion of the information that will apply to all of the Delivery Installation (DI) Details pages defined in the 
mailing plan.  
 
As this will apply to all of the delivery installations, the Delivery Installations  field on this screen is disabled.  All other fields are 
accessible to edit.  The functions are identical to those on the Delivery Installation Details page. 
 
By clicking on Apply, the information provided on this page will be applied to all Delivery Installations (DI) associated with the 
Statement of Mailing (SOM) line item selected. 
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  4.3.3 Delivery Installations Details – Split Walks 
 
A letter carrier route may consist of more than one FSA. This is referred as a “split walk”. You can select the FSA within the split 
walk route you wish to have covered. Once you have select either the ‘Get Counts’ button or the ‘Get Count for all Delivery 
Installations’ button on the Delivery Installation Detail page and  if you have selected any Delivery Modes and Delivery Mode IDs 
that contain a “split walk”, a Notice page will pop-up on the screen. The Notice page gives you the opportunity to select the certain 
FSA’s or all FSA’s you wish to add to your mailing. 
 

 
 
 
 
 
COMMAND BUTTON RESULT OF INVOCATION 

Select All • Select all of the FSA that are showing in the table. 
Apply • The FSA that were chosen will be added to the delivery route of the letter carrier. 
Cancel • Closes the window. Process the “Delivery Installation Details” page. 
Don’t…again • The ‘Don’t….again’ checkbox is available should you not want this message to 

appear on each subsequent Delivery Installation Detail Page. This checkbox is only 
enabled when you select ‘ Select All’ and it is disabled if you only select certain 
FSA’s 

 
 
 
 
  
  4.3.4 Enter Delivery Installation Details 
 
The Delivery Installation Details page captures the detailed data by Delivery Installation required for the Unaddressed Admail 
Delivery Slips.  As well, this page performs online queries against the Householder Count data. 
 
This window can be divided into eight sections: 

• SOM Information 
• Delivery Information 
• Delivery Timing 
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• Target Area 
• Select Delivery Modes (DM) 
• Get Counts (Householder) 

Command Buttons at the bottom of the page which allow you to View Mailing Plan / Delete / Finish / Clear or move 
backward or forward to other pages 

 

 
 
 
 
 
SOM Information - The SOM Information section contains display-only information (Service Description and Weight) as captured 
from the SOM line item in question. 
 
 
Delivery Information - This section requires you to provide details on your mailing.  An asterisk indicates that the field is 
mandatory. 
 

Delivery Installation – pre-populated from the Select Delivery Installation(s) for Mailing Plan function.  This field is display-only 
and identifies the Delivery Installation Name of the Delivery Installation in question. 
 
Deposit Location * - if you are not directly dropping off your mail at the Delivery Installation in question, select from the drop-
down list the outlet where you are leaving your mail.  Another outlet may be more convenient (e.g. in your vicinity) at which to 
leave your mail.  CPC then needs to transport your mail from the Deposit Location to the Delivery Installation.  If you set the 
Deposit Location different from the Delivery Installation, then you must select the Transportation Required option. 
 
This field defaults to the Payment Outlet selected on the Unaddressed Admail data entry window (since the Transportation 
Required option initially defaults to being selected).  The drop-down list is populated with all the outlets that were selected on 
the Select Outlets/Deposit Locations window (Data Maintenance > Site Information > Outlets/Deposit Locations tab > Add), 
along with the Delivery Installation in question. 
 
The Deposit Location selected (if different from the Delivery Installation) factors into CPC’s decision of whether it can meet the 
Delivery Timing specified by you. 
 
ATTENTION:  If you set the Deposit Location equal to the Delivery Installation, the Transportation Required checkbox does 

NOT automatically become deselected. 
 
Transportation Required – this checkbox is defaulted as selected.  select this option if you set the Deposit Location different 
from the Delivery Installation.  This means that you are dropping you mail off at an outlet different from the Delivery Installation 
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in question, and thus CPC needs to transport your mail from this outlet to the Delivery Installation.  If you select the 
Transportation Required option, then you must set the Deposit Location different from the Delivery Installation. 
 
ATTENTION:  If you deselect the Transportation Required option, then the Deposit Location automatically changes to be the 

same as the Delivery Installation. 
 
Consumers' Choice - this box is defaulted as selected when the Delivery Installation Detail page is first displayed for a 
particular Delivery Installation.  It is used to identify your target area with respect to those customers who do not wish to receive 
Unaddressed material (i.e. Consumers’ Choice or Total Points of Call). 
 
Version Specific - click this box to identify that the mailing has several versions (e.g. different store addresses appear on mail 
pieces that are otherwise the same). The ‘Title of the Mail Piece’ remains a mandatory field. When ‘Version Specific’ is 
selected, the ‘Version Specific’ and ‘Title of the Mail Piece’ fields are disabled on the subsequent  
Delivery Installation Details pages. Each different version must be entered on separate lines at the Statement of Mailing (SOM) 
Data Entry page. 
 
Title of Mail Piece * - enter a descriptive name or title of the mail pieces for easy identification. 
 
ADS Reference – this is a user-defined field whereby you can enter your won reference number, such as an internal tracking 
number (maximum of 20 characters). 
 
Container Type * - select from the following drop-down list choices:  Bag, Box, Flats Tub and Lettertainer. 
 
Pieces per Bundle * – enter the number of pieces in a non-standard bundle size.  The value must be less than or equal to 
200.  Otherwise you get an error message when you try to leave the page. 
 
Bundles per Container * – enter the number of bundles per container/bag being shipped to the Delivery Installation.  If you wish 
to use two or more different types of containers, you will be required to manually modify/edit the Bundles per Container 
information on the Delivery Installation page(s) concerned or create a separate line item on the SOM for the different container. 
 
No. of Containers – this is a calculated field.  It cannot be altered by the user.  No. of Containers/Bags being shipped to the 
Delivery Installation = No. of Complete Bundles / Bundles per Container (rounded to the next full value, if not fully divisible). 
 
No. of Complete Bundles – this is a calculated field.  It cannot be altered by the user.  No. of Complete Bundles = Total Counts 
for all DM’s selected / Pieces per Bundle (rounded to the next full value). 
 
Pieces in Residue Bundle – this is a calculated field.  It cannot be altered by the user.  Pieces in Residue Bundle = value left 
over from No. of Complete Bundles calculation if Total Counts is not fully divisible by Pieces per Bundle. 

 
 
Delivery Timing * – Automatic calculation of the Delivery Timing will help the user to adjust his mailing plan to ensure that his 
desired initial Start Date can be respected. 
 

Upon Receipt – click this radio button to identify that the delivery can start upon receipt of mailing.  You must enter the 
Deposit Date (i.e. when you will leave your mail either directly at the Delivery Installation in question or at the Deposit Location 
chosen). 
 
Deposit Date – enter the date (YYYYMMDD) when you will leave your mail either directly at the Delivery Installation in 
question or at the Deposit Location chosen.  This field is mandatory if you select the Upon Receipt option. 
 
Latest Start Date- if the Upon Receipt option is chosen, this field is calculated by the application based on the Deposit Date 
entered and Canada Post’s service standards. 
 
Specific Start Date – click this radio button if you want the delivery to start on a specific date.  You must enter this desired 
Start Date. 
 
Start Date – enter the specific date (YYYYMMDD) on which you want delivery of your mail to start.  This field is mandatory if 
you select the Specific Start Date option. 
 
Required Start Date – if the Specific Start Date option is chosen, this field is calculated by the application based on the Start 
Date entered and Canada Post’s service standards. 
 
Notes:  If you select either Upon Receipt and enter a Deposit Date or Specific Start Date and enter a Start Date, but then 

change your mind and select the other radio button, you must manually clear the Date field associated with the first radio 
button chosen. 
 
If Canada Post cannot respect the Start Date specified by you, you will get the following message to inform you that you 
need to adjust your mailing plan: 
”It is not possible to accommodate the specified Start Date according to CPC’s Service Standards.  Please enter a Start 
Date that is at least <calculated number> business days from today’s date.” 
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You can either change your Start Date or your Deposit Location or a combination of both for Canada Post to meet your 
requirements. 

 
 

Target Area- This section allows you to select the type of Target Area for your mailing.  At least one Target Area selection 
must be checked. 

 
Houses - select if delivery is required to houses.  A house is a building with one or two dwelling units.  If a business is 
operated in a house that is also used as a dwelling, it is classified as a house. 
 
Apartments - select if delivery is required to apartments.  An apartment is a self-contained dwelling unit within a multiple unit 
residential building of three or more such dwelling units in which:  all the units share a common main entrance and civic 
address but have individual suite numbers.  For the purpose of this definition, common entrance means entrance to the 
building or to the complex (e.g. private lane or road).  For urban areas, each unit has a separate mail receptacle, which 
normally forms part of a centralized mail receiving facility.  If a business is operated in an apartment that is also used as a 
dwelling, it is classified as an apartment. 
 
Farms - select if delivery is required to farms.  A farm is a dwelling or a point of call associated with a tract of land used to 
raise crops, animals or fish as a source of income or revenue. 
 
Businesses - select if delivery is required to businesses.  A business is defined as a point of call where the primary activity is 
commercial or industrial.  If a business is operated from a house or an apartment, which is also used as a dwelling, it is 
classified as a house or an apartment. 

 
For more information, please consult the Canada Post Guide. 
http://www,canadapost.ca/business/tools/pg/manual/c12-e.asp 

 
 
 
Select Delivery Modes (DM) - This section allows you to select the Delivery Mode(s) you wish to target.  The Select Delivery 
Modes (DM) grid on this page contains only 20 line items for data entry since the ADS report can accommodate only 20 route 
ranges. 
 

FSA/PC - select from the drop-down list the Forward Sortation Area (FSA) or Postal Code (PC) for the delivery mode 
selected.  The FSA is the first three characters (alpha-numeric-alpha) of the postal code, which represent a geographic area. 
 
For urban Delivery Installations, the FSA/PC drop-down list for Delivery Installation contains only the FSA’s available for the 
Delivery Installation selected.  The ‘ALL’ value at the top of the list allows you to select all FSA’s available within the Delivery 
Installation. 
 
For rural Delivery Installations, the FSA/PC drop-down list for Delivery Installation contains the list of Postal Codes for that 
installation as recorded in the Householder data, as well as an ‘ALL’ value at the top of the list. 
 
DM Type - select from the drop-down list the DM Type.  The DM Type drop-down list contains the list of all DM Types (e.g. 
Letter Carrier (LC), Rural Route (RR)) available for the Delivery Installation selected.  The ‘ALL’ value at the top of the list 
allows you to select all DM types available within the Delivery Installation. 
 
Should the FSA/PC field be blank, the DM Type drop-down list will also be blank.  Should the FSA/PC field be modified, the 
value in the DM Type field will automatically be reset to reflect the new FSA/PC selected. 
 
DM ID From / DM ID To – select from the drop-down lists the DM ID.  If you wish to enter a range, then select your starting 
point “DM ID From” and your end point “DM ID To”.  For example, you may enter a range of LC 0001 – 0009.  If you are 
selecting only one DM ID, you need to select this value in both the DM ID From and DM ID To fields. 
 
The DM ID From and DM ID To drop-down lists contain only the ID’s available for the Delivery Installation selected.  The ‘ALL’ 
value at the top of the list allows you to select all the DM ID’s available within the Delivery Installation you have selected. 
 
Should the DM Type field be blank, then the DM ID drop-down lists will also be blank.  Should the FSA/PC or DM Type fields 
be modified, the value in the DM ID fields will automatically be reset to reflect the new FSA/PC and/or DM Type selected. 
 
Note:  Ranges maximize available space on the Unaddressed Admail Delivery Slip. 
 
Delivery Installation Name – select from the drop-down list the abbreviated name of the postal facility that will provide the 
delivery services for the selected delivery mode.  The Delivery Installation Name drop-down list contains the list of Secondary 
Delivery Installation Names for the Delivery Installation selected, and has an ‘ALL’ value at the bottom of the list.  The Delivery 
Installation Name drop-down list is filtered by the selected FSA/PC, DM Type and DM ID’s.  If a “DM ID From” and “DM ID To” 
have not been selected, then this drop-down list is blank.  Should the FSA/PC, DM Type or DM ID fields be modified, then the 
Delivery Installation Name field will automatically be reset to reflect the new FSA/PC, DM Type or DM ID’s selected.  All 
information is as recorded in the Householder data. 
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If ‘ALL’ is selected for both the DM Type and DM ID From fields, the system will automatically populate the DM ID To and 
Delivery Installation Name fields with ‘ALL’ (this will be the only value available in the drop-down list). 
 
If the Delivery Installation Name list contains only one value (i.e. one value other than ‘ALL’), then the system will 
automatically populate the Delivery Installation Name field with this Delivery Installation Name.  If the Delivery Installation 
drop-down list contains two or more values, then you must select the appropriate Delivery Installation Name.  Where a range 
of DM ID’s is entered for which more than one Delivery Installation Name can apply, then the Delivery Installation Name drop-
down list will only contain the DI’s that are common to all DM’s selected. 

 
  4.3.5 Get Householder Counts 
 
Online queries against the Householder Count data can be performed by capturing the target area data, selecting the required 
route data (i.e. FSA/PC, DM Type, DM ID and Delivery Installation Name) and clicking the Get Counts button.  The Get Counts 
button invokes a query on the Householder data and retrieves the counts for the specified target area, route selection and count 
type (e.g. Consumers’ Choice vs. Total Points of Call).  Note that if a range of routes was entered (e.g. A9A LC 0001-0009), the 
Householder data will be summed over that range. 
 
Total Counts These fields represent the total amount Delivery Mode (DM) at the line level. You have the choice to modify the “Total 
Counts” data at the Delivery Mode (DM) line level If you select to change the “Total Counts”, a pop-up message will warn you that 
the value differs from the Householder count. The system displays the modified value in a different font color and disables the 
“Total Pieces Shipped for Delivery field”.  
Total Pieces Shipped for Delivery The Total Pieces Shipped for Delivery field represents the sum of the Total Counts for all DM’s 
selected. It identifies the total number of items being shipped for delivery to the Delivery Installation and is a mandatory field You 
have the choice to modify the Total Pieces Shipped for Delivery. The system displays the modified value in a different font color 
and disables the “Total Counts”. If you select to change the “Total Pieces Shipped for Delivery”, a pop-up message will warn you 
that the value differs from the Householder count. 
 
(Page) X of Y (bottom-right corner) – identifies which Delivery Installation Details page you are currently working on and the total 
number of Delivery Installation Details pages. 
 

Command Buttons 
 
The following table describes the Command Button definitions and displays the hot key definitions where applicable (by underlining 
the letter in question). 
 

COMMAND BUTTON RESULT OF INVOCATION 

Get Counts • Enabled when there is one complete line item in the Select Delivery Modes (DM) grid. 
• Invokes validations. 
• Used primarily to derive the counts for the current Delivery Installation. 
• If count data does not exist for the given mailing date and complete route range entered for a 

Delivery Mode line item, then an error message is displayed. 
• If validations are successful, the page is refreshed and count data is displayed.  Note that if the 

DM From Id equals 'All', the system populates the DM From Id with the smallest DM Id number 
and the DM To Id with the largest DM Id number for the given FSA and DM Type combination. 

Get Counts for all Delivery 
Installations 

• Invokes validations. 
• Used primarily after a successful import of an ADS file followed by the manual addition of more 

Delivery Installations. 
• If count data does not exist for the given mailing date and complete route range entered for a 

Delivery Mode line item, then an error message is displayed. 
• If validations are successful, the page is refreshed and count data is displayed.  Note that if the 

DM From Id equals 'All', the system populates the DM From Id with the smallest DM Id number 
and the DM To Id with the largest DM Id number for the given FSA and DM Type combination. 

View Mailing Plan • Get Counts functionality must have already been invoked. 
• Invokes validations. 
• If a route contains a Split Delivery Mode indicator, then displays an error message.  Note the 

'other FSA' (i.e. other half of the route) can be found by searching for another record in the 
Householder data for that Delivery Installation which has the same DM Type, DM Id and Delivery 
Installation (abbreviated) Name. 

• If a route contains a Split FSA indicator, then displays a warning message. 
• If validations are successful, the Mailing Plan Summary window is displayed and calling Delivery 

Installation Details page is closed. 
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COMMAND BUTTON RESULT OF INVOCATION 

• When you click Close on the Mailing Plan Summary window, you are returned to the Delivery 
Installation Details page. 

Delete • Displays warning message to confirm deletion. 
• If warning message is confirmed, deletes the Delivery Installation (DI) Details data and displays 

the next DI Details window. 
Finish • Gets Counts functionality must have already been invoked. 

• Invokes validations. 
• If a route contains a Split Delivery Mode indicator, then displays an error message.  Note that 

complete coverage of a Delivery Mode is required. 
• If a route contains a Split FSA indicator, then displays a warning message. 
• If Delivery Installation Details pages exist with no user-entered data, then displays a warning 

message.  If the user presses Cancel on the warning message window, then the Finish process 
continues with the exception that instead of displaying the SOM data entry window, the Mailing 
Plan Summary window is displayed. 

• If validations are successful, saves data, closes the Delivery Installation Details page and 
displays the SOM data entry window. 

• If you click on the Finish button and there are Delivery Installation Details pages for which the 
user has not entered any data, a warning message will be displayed indicating that the 
associated Delivery Installations will be deleted from the mailing plan. 

• The close page function, that is the ‘X’ icon at the top of the page, has the same functionality has 
the Finish button. 

Clear • Asked to confirm whether you wish to clear the page. 
• If you click OK, the page is refreshed, all fields on the data entry page are cleared and the cursor 

is positioned on the first field. 
• If you click Cancel, then no changes are made to the data entry page. 

Links to other Delivery 
Installation Details pages: 
• |< (Go to the first 

page) 
• < (Go to the previous 

page) 
• > (Go to the next 

page) 
• >| (Go to the last 

page) 

• Get Counts functionality must have already been invoked. 
• Invokes validations. 
• If validations are successful, displays selected Delivery Installation (DI) Details page.  Note that 

the system also defaults the following fields (i.e.  applies data from previous window) if they do 
not already contain data:  selection of Transportation Required option, Delivery Timing selection 
along with associated Deposit/Start Date, Version Specific, Title of Mail Piece, ADS Reference, 
Container Type, Pieces per Bundle, Bundles per Container, Coverage and Piece Description.  If 
Transportation Required is not selected, the Deposit Location defaults to the Delivery Installation 
in question.  If Transportation Required is selected, the Deposit Location defaults to the Payment 
Outlet selected on the Unaddressed Admail data entry window. 

  
   4.3.6 View Mailing Plan Summary 
 

 
 



 

©September 2004 Canada Post Corporation  36 

The Mailing Plan Summary window allows the user to view a list of the Delivery Installations in the Mailing Plan, access the Select 
Delivery Installation(s) for Mailing Plan window, navigate to a particular Delivery Installation and delete multiple ones (use the 
<CTRL> and/or <SHIFT> keys to select multiple records).  It can now be easily sorted in ascending or descending order by clicking 
on the header of any column.  Click once for ascending, and twice for descending sort order.  The Mailing Plan Summary window 
is displayed in a pop-up window.  Upon closing the Mailing Plan Summary window, you will be returned either to the Unaddressed 
Admail data entry window or a Delivery Installation Details page (depends from where the Mailing Plan Summary window  was 
invoked).  You are now ready to preview your SOM. 
 
All of the fields on this window are display-only.  To change a field for a given Delivery Installation, highlight the line item and click 
the Go to DI button. 
 
Complete – this checkbox indicates whether mandatory ADS data already exists for the Delivery Installation in question. 
 
Delivery Installation Name – this field identifies the Delivery Installation Name in question.  It corresponds to the Delivery Installation 
Area Name, Delivery Installation Type description and Delivery Installation Qualifier Name. 
 
Transport Required – this checkbox indicates whether transportation is needed for the mailing.  This means that you are not 
dropping off your mail directly at the Delivery Installation in question, but at another Outlet (i.e.  Deposit Location).  Thus CPC will 
charge you for transporting the mail from the Deposit Location to the Delivery Installation. 
 
Deposit Location – this field identifies the Outlet where you will drop off your mail for the Delivery Installation in question.  If it is 
equal to the Delivery Installation in question, then it is a direct drop-off (and the application does not consider the Delivery 
Installation as having a Deposit Location).  If it is different from the Delivery Installation, then CPC needs to transport the mail from 
the Deposit Location to the Delivery Installation. 
 
Deposit Date – this field identifies the date when you will drop off your mail for the Delivery Installation in question (either at the 
Delivery Installation itself or at another Deposit Location).  This date is either manually entered by the user (because the mailing is 
to start upon receipt) or calculated by the application based on CPC’s standards (because the user wants the mailing to start on a 
specific date). 
 
Delivery Start Date – this field identifies the date when CPC will start to distribute the mailing for the Delivery Installation in question.  
This date is either calculated by the application (because the user had manually entered a Deposit Date) or manually entered by the 
user because he wants the mailing to start on a specific date. 
 
Total Pieces Shipped for Delivery – this field identifies the total number of pieces being shipped for delivery to the Delivery 
Installation in question. 
 
Title of Mail Piece – this field identifies a descriptive name or title of the mail piece for easy identification. 
 
Command Buttons 
 
The following table describes the fields and Command Button 
 
COMMAND BUTTON RESULT OF INVOCATION 

Add to Mailing Plan • Displays the Select Delivery Installation(s) for Mailing Plan window and closes the Mailing Plan 
Summary window to allow for additional Delivery Installations to be included in the Mailing 
Plan. 

DI Changes • Enabled when the list contains one or more Delivery Installations 
• Basic information such as the Title of the Mail Piece, Target Area, and Container Type, on the 

Delivery Installation Mailing Plan Changes page can now be easily changed and applied to all 
Delivery Installations. 

Go TO DI • Enabled when one or more Delivery Installations are selected from the list. 
• Displays the Delivery Installation Details page for the selected Delivery Installation and closes 

the Mailing Plan Summary window. 
Delete Selected DI’s • Enabled when one or more Delivery Installations are selected from the list. 

• Display warning message to confirm deletion of data. 
• If warning message is confirmed, deletes the Delivery Installation Details data and refreshes 

the window. 
Close • Closes the window.  Returns you to either the Unaddressed Admail data entry window or a 

Delivery Installation Details page (depending from where the Mailing Plan Summary window 
was invoked). 
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 4.3.7 Delivery Installation Global Changes 
 
A new DI Changes button is available and enabled on the Mailing Plan Summary page when the list contains at least one Delivery 
Installation.   
 
This means the basic information on the new Delivery Installation Mailing Plan Changes page can now be easily changed and 
applied to all Delivery Installations.  This includes information such as : 
 
Title of the Mail Piece 
Target Area 
Container Type 
 
Clicking on the DI Changes button displays the new Delivery Installation Global Changes  page . 
 

 
 
This page allows global changes to be made to already defined mailing plans that are then applied to each Delivery Installation. 
 
Changes made to the following fields will be applied to all Delivery Installations included in the mailing plan: 
 
Deposit Date 
Start Date 
Title of mail Piece 
ADS Reference 
Container Type 
Pieces per Bundle 
Bundles per Container 
Target Area (Houses, Apartments, Farms, Businesses) 
 
NOTE:  This functionality is not available when the DI Details have been imported for one or more Delivery Installation in the mailing 
plan. 
 

   4.3.8 Import Delivery Installation Data 
 
The Import Delivery Installation Data unit task allows you to:  

• Select a comma delimited (.csv) file containing a list of Delivery Installation Delivery Mode selections; 
• Import this Delivery Installation Data file in the opened SOM against the selected SOM line item and; 
• Save the records with errors in an Error file, with error messages in English and French. 

Note:  Only delimited ASCII files can be imported.  The default delimiter is a comma.  Users can specify their own delimiter from the 
Open File – Import Delivery Installation Data window.  Other valid delimiters are semi-colon (;), single quote (‘), pipe (|), percent (%), 
colon (:), tilde (~), caret (^), and underscore (_). 
 
The Import Delivery Installation (i.e. ADS) Data functionality is accessed through the Import button on the Select Delivery 
Installation(s) for Mailing Plan window. Clicking the Import button results in the Open File – Import Delivery Installation Data 
window being displayed.  
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From the Open File – Import Delivery Installation Data window, select the file to be imported. If the file has been successfully 
imported, a message with an OK button will be displayed indicating that the process has been completed. Once you click OK, the 
Select Delivery Installation(s) for Mailing Plan window will be refreshed with the Delivery Installation(s) Added to Mailing Plan list 
populated with the Delivery Installation Names corresponding to the imported data (and in the same order as they each appear in 
the import file).  If you click on the Apply button, the Delivery Installation Detail page is displayed and populated with the Delivery 
Mode data imported for the first Delivery Installation. 

 

 
 
During the import process, if one of the field validations fails, then an error file is created. At the end of this import process, a 
message is displayed to inform you that there were records rejected at time of validation. Click the OK button on the message 
dialogue box, then the Save As –Delivery Installation Data Import Error window is opened in order to save the error file. If you click 
the Cancel button on the message dialogue window, a message is displayed to inform you that the process of saving rejected 
Delivery Installation Delivery Mode records has been cancelled.  
 
Next the Select Delivery Installations for Mailing Plan window will be displayed with the Delivery Installation(s) Added to Mailing 
Plan list view populated with the Delivery Installation Names corresponding to the imported data (and in the same order as they 
each first appear in the import file). 
 
If the imported data is being applied to a SOM line item, which already has Delivery Installation Detail data created; the import will 
create distinct Delivery Installation Detail records. That is, if delivery mode (route) data is being imported for a Delivery Installation 
that already has delivery mode information recorded against it, the import will not append this data to it; instead it will record this 
data on a separate Delivery Installation Detail page. 
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Open File – Import Delivery Installations Data Window 
This window has the same layout and functionality as the standard Windows Open File window.  The default file type is Text (*.txt) 
but you can select any file (*.*).  The Open command button triggers the Import Delivery Installations Data process.  If the file is not 
found, a message will be displayed, requesting to open another file.  You can specify the type of file delimiter used in the import file.  
Valid delimiters are:  semicolon (;), single quote ('), comma (,), pipe (|), percent (%), colon (:), tilde (~), caret (^), and underscore (_).  
 
Save As –Delivery Installation Data Import Error File Window 
This window has a similar layout and the same functionality as the standard Windows Save As window.  
 
File Layout 
 
Delivery Installations Data Import File Layout 
The import file must be a comma separated ASCII flat file where character and non-integer numeric fields are enclosed in double 
quotes (“). Where no information is available the system expects a blank entry (i.e. “”). Each record is separated by a carriage 
return. Records starting with a number sign (#) are considered comment lines and are skipped. 
 
You can select from one of two file formats to import Delivery Installation Data. 
 
The purpose of each table is to outline the information the application is expecting during the Delivery Installations Data import 
process. 
 
Format # 1 
Field Type Length Mandatory / 

Opt. 
Validation 

FSADMDMID* 
(Where FSA is the Forward 
Sortation Area;  
DM is the Delivery Mode 
Type; and  
DMID is the Delivery Mode 
ID) 

String 9 M  Validate for format (ANAAANNNN).  
Validate that a Delivery Installation 
exists in the Householder data for the 
FSADMDMID provided. 

Secondary Delivery 
Installation (Abbreviated) 
Name 

String  15 O Validate that it exists in the 
Householder data for the Delivery 
Installation retrieved based on 
FSADMDMID provided. 

 
* The FSA within the FSADMDMID data field for the above file format maps uniquely to a primary Delivery Installation Name and is 
used to populate the Delivery Installation Name field on both the Select Delivery Installation(s) for Mailing Plan window and the 
Delivery Installation Detail window. 
 
 
Format # 2 
Field Type Length Mandatory / 

Opt. 
Validation 

FSA/PC* String 3, 6 or 7 M Validate for format (ANA or ANANAN 
OR ANA NAN). 
 
Validate that a Delivery Installation 
exists in the Householder data for the 
FSA provided. 

“From” DMDMID  
(Where DM is the Delivery 
Mode Type; and DMID is 
the Delivery Mode ID) 

String 6 M Validate format for (AANNNN).  
 
Validate that it exists in Householder 
data for the Delivery Installation 
retrieved based on the FSA/PC 
provided. 

“To” DMDMID  
(Where DM is the Delivery 
Mode Type; and DMID is 
the Delivery Mode ID) 

String 6 O Validate format for (AANNNN). 
 
Validate that it is greater than or equal 
to the “from DMDMID”. 
 
Validate that it exists in the 
Householder data for the Delivery 
Installation retrieved based on the 
FSA/PC provided.  

Secondary Delivery 
Installation (Abbreviated) 
Name 

String  15 O Validate that it exists in the 
Householder data for the Delivery 
Installation retrieved based on the 
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FSA/PC, DM Type and DM ID range 
provided. 

 
* The FSA within the FSA/PC data field for the above file format maps uniquely to a primary Delivery Installation Name and is used 
to populate the Delivery Installation Name field on both the Select Delivery Installation(s) for Mailing Plan window and the Delivery 
Installation Detail window. 
 
The Delivery Mode data (i.e. FSA, DM type, DM Id, DI Name) will be grouped by Delivery Installation Postal Code. That is, all the 
data associated to the same Delivery Installation Postal Code will be saved onto a Delivery Installation Detail page. A maximum of 
20 Delivery Mode selections (routes) can be associated to a Delivery Installation Postal Code. If more than 20 routes for a given 
Delivery Installation Postal Code exists, then each record after the 20th one, will be rejected and have an error message associated 
to it in the error file. 
 
 
Delivery Installation Data Import Error File Layout 
 
The Imported Delivery Installation Data Error File layout will have exactly the same layout as the Delivery Installation Data Import 
File, with the records containing errors being copied, as is, from the import file to the error file. One or more comment lines [i.e. 
starting with a number sign (#)] will be inserted after each error record to describe the error(s), in English and French. 
 
The Imported Delivery Installation Data Error File can be used as an import file after having been edited with any text-processing 
tool, such as Notepad. 
 

 4.4 Previewing your SOM 
 
The Preview function allows you to preview your SOM information with the price rating of your order so that you can visually 
validate the results prior to finalizing and transmitting your completed SOM to Canada Post.  For Unaddressed Admail, the 
Distribution Plan is displayed after the SOM Preview.  Also, if you have selected the NPS Consolidation option on the Unaddressed 
Admail data entry window, then the NPS Consolidation report is the final one to be previewed. 
 
You simply click the Preview command button on the data entry window or select Preview from the Tools menu when all required 
information has been properly entered on the window.  If an error is found, a message dialog box is displayed with details on the 
error. 
 
If changes are required to your SOM: 

• Return to the data entry field(s) that need to be corrected. 
• Make your changes or corrections. 
• Then preview your SOM again. 

 
If no errors are found (i.e. price rating is successful):  

• Your SOM is displayed in a Report Preview window. 
• Your SOM can be saved from the data entry window by clicking the Save button.  If you saved your SOM prior to 

previewing it, then the SOM ID appears on the Preview; otherwise there is no SOM ID on the Preview. 
• You can click the Finalize command button, as your SOM is now ready to be transmitted to the CPC server and 

printed. 
• You can skip clicking the Finalize button and immediately click the Transmit/Print button.  Only when you click this 

button will your SOM (and other documents) be printed. 
 
When Downstream Entry is selected, your SOM Preview will group the line items and repeat them for each instance of the same 
Deposit Location, Deposit Date and Shipment No.  When only Mailing Type of Partial is selected, the line items are grouped and 
repeated for each instance of the same Deposit Date and Shipment No. in your SOM Preview. 
 
Note:  For Unaddressed Admail, ALL Delivery Installations that do not have the Transportation Required option selected (i.e. the 

Deposit Location is set equal to the Delivery Installation in question and thus it is a direct drop-off of mail and there is no 
actual Deposit Location) are grouped as one line item on the SOM Preview, separate from Delivery Installations with actual 
Deposit Locations (i.e. Transportation Required selected). 

 
 

 4.5 Transmitting/Printing your SOM 
 
The SOM data entry window also contains a Transmit/Print button, which electronically sends the SOM transaction to Canada 
Post when clicked.   After verifying that the information in the Preview is correct, click the Transmit/Print button located at the 
bottom of your SOM data entry window. 
 
By clicking this command button, the application will: 

• Initiate a connection with the CPC Server - you will be required to logon to the CPC server; 
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• Perform an application data and software update validation if required and; 
• Create a Transmit Session log. 

 
If the Transmit/Print function is successful, the Order record is saved with a status of Transmitted and automatically moved to the 
Transmitted SOMs folder. 
 
As part of the transmission process, the following information is generated for Unaddressed Admail: 

• An ADS Sequential Number is generated for each Delivery Installation Details record, starting at one for each SOM.  
The four-digit number is sequentially generated at the SOM level by the sort criterion selected on the Unaddressed 
Admail data entry window. 

• If the ADS Reference sort criterion is selected, the sequential number is generated by ADS Reference and then by 
Delivery Installation Postal Code. 

• If the Title of Mail Piece sort criterion is selected, the sequential number is generated by Title of Mail Piece and then 
by Delivery Installation Postal Code. 

 
Note:  Warning messages may be triggered during the Transmit/Print process (e.g.  "blocked" due to credit issues).  However, the 

order is still considered to be successfully transmitted. 
 
The Transmit/Print process creates a Transmit Session Log record.  When the user selects the Transmit Session Log record from 
the List Pane on the Electronic Shipping Tools Desktop window and invokes the Open action, the information related to the record 
selected is displayed in the Report Preview window.  The Report Preview window is used to preview and print the selected 
Transmit Session Log record. 
 
ATTENTION:  If the transmission fails, the Order is automatically moved from the Opened SOMs folder to the Finalized SOMs 

folder.  The line item will be in red.  You can open it in view mode only. 
 
The Transmit Session log will be useful in determining the cause of any problems encountered.  This will also assist the Help 
Desk in expediting error resolution. 

 
   4.5.1 Print SOM 
 
To print your SOM, you must have correctly filled out the data entry window of a SOM and successfully transmitted the SOM.  If the 
transmission process fails, the SOM, as well as all the other documents, are still printed with a “Untransmitted” watermark on each 
page.  
Note: After the SOM is printed (For Fully Featured option only) you may click to continue printing the Distribution Plan, the ADS 
Forms and the Container Labels as well as the Packing Slips and the Summary of Mailing if they apply.   
 
The SOM for the desktop version of the application has the following characteristics: 

• The VCD local identifier is printed on the SOM report (this field is printed on the right-hand side below the Customer 
Signature field). 

• Reprinting a SOM or an Unaddressed Admail Distribution Plan is possible (through the Reprint command button on 
the Desktop and Search/Manage Orders windows).  In this case, a “Reprint” watermark is printed on each page of 
the SOM. 

• The Multi-shipment SOM format is printed if the SOM has one or both of the following characteristics: 
• Downstream Entry is selected or; 
• Mailing Type of Partial is selected. 

 
Note:  A Multi-shipment report is produced when there is more than one line item.  This could be because there are multiple 

Deposit Locations (i.e. Transportation Required selected), one Deposit Location with multiple Deposit Dates OR one or more 
Deposit Locations combined with Delivery Installations with Transportation Required not selected (grouped into one line item). 

 
Special Case:  If you manually create multiple line items but they are ALL for Delivery Installations but they are ALL for Delivery 

Installations with Transportation Required not selected, a Multi-shipment SOM report is not created. 
 
The Multi-shipment SOM report provides shipment details displayed on the Packing Slip, including pricing information.  The Multi-
shipment SOM report is generated to group and display the line items for each Outlet Name, Date of Mailing (this is the Deposit 
Date, not the Delivery Start Date as displayed on the Distribution Plan) and Shipment No. combination.  One SOM is produced for 
each line item. 
 
ATTENTION:  For Unaddressed Admail, since ALL Delivery Installations with Transportation Required selected are grouped into 

one line item, they are thus accounted for on one SOM of the Multi-Shipment SOM report.  In this case, the Outlet Name is 
the Outlet of Payment (selected on the Unaddressed Admail data entry window) and the Date of Mailing is the earliest Deposit 
Date of all the Delivery Installations. 

 
Two copies of the Multi-shipment SOM report are generated - the Customer retains one copy and another copy is submitted to the 
RVU (or Retail Site) at time of payment.  For a Single-shipment SOM report, three copies are generated; the additional one is for 
data entry. 
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A barcode is printed on a Single-shipment SOM report.  For a Multi-shipment SOM report, the barcode does not appear on the 
SOM but is printed on the Packing Slips. 
 
The Multi-shipment SOMs printed are sorted by Outlet Name, Date of Mailing and Shipment Number (X).  All pages of copy 1 are 
printed first, and then all pages of copy 2 are printed. 
 
The shipment number (X) and the total number of shipments (Y) are derived based on the information entered on the SOM data 
entry window.  “X” identifies a sequential number for the current SOM printed for line items that have the same Outlet Name, Date 
of Mailing and Shipment No.  “Y” identifies the total number of instances grouped by Shipment No. that have the same Outlet 
Name and Date of Mailing (i.e.  number of Packing Slips produced for the Order). 
 
An indicator is displayed on the SOM to identify that the Downstream Entry checkbox is selected on the SOM data entry window. 
 
 
 

  
   4.5.2 Produce Packing Slip for Multi-Shipments 
 
A Packing Slip is generated only for Multi-shipments.  The purpose of the Packing Slip is to provide a separate induction document 
for each induction site with the same Date of Mailing and Shipment No.  This document reports on volume and excludes pricing 
information.  The Packing Slip accompanies the individual mail shipments being inducted, enabling receiving offices to access the 
Order on the CPC server, verify the mailing and, subsequently, enter changes from the verification process (if necessary). 
 
The Packing Slip is generated when the Order is successfully transmitted to CPC and has one or both of the following 
characteristics: 

• Downstream Entry is selected or; 
• Mailing Type of Partial is selected. 
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One copy of the Packing Slip is generated to display the line items on a given SOM for each Outlet Name, Date of Mailing and 
Shipment No. combination.  The Packing Slip is printed with a barcode. 
 
ATTENTION:  For Unaddressed Admail, in the event that ALL Deposit Locations are the same as the associated Delivery 

Installations (i.e. Transportation Required not selected), NO Packing Slip is generated. 
 
The shipment number (X) and the total number of shipments (Y) are derived based on the information entered on the SOM data 
entry window.  “X” identifies a sequential number for the current Packing Slip printed for line items that have the same Outlet 
Name, Date of Mailing and Shipment No.  “Y” identifies the total number of instances grouped by Shipment No. that has the same 
Outlet Name and Date of Mailing. 
 
The Packing Slips printed are sorted by Outlet Name, Date of Mailing and Shipment Number (X). 
 
The Packing Slip report supports printing a maximum of thirteen line items per page. 
 
An indicator is displayed on the Packing Slip to identify that the Downstream Entry checkbox is selected on the SOM data entry 
window. 
 
 

 
 
 
  4.5.3 Produce Summary of Mailing Report for Multi-Shipments 
 
The Summary of Mailing report is generated only for Multi-shipments.  It is designed to assist you in your mail preparation process.  
It identifies all Outlet Names, Dates of Mailing and volumes for each Packing Slip produced.  This document must be presented to 
the office where payment is made, and is used as a control document and for quick reference. 
 
The Summary of Mailing report is generated when the Order is successfully transmitted to CPC and has one or both of the following 
characteristics: 

• Downstream Entry is selected or; 
• Mailing Type of Partial is selected. 

 
Each Packing Slip produced is summarized on the Summary of Mailing report to display the Total Volume by Outlet Name, Date of 
Mailing and Shipment No. 
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Two copies of the Summary of Mailing report are generated – the Customer retains one copy and another copy is submitted to the 
RVU (or Retail Site) at time of payment. 
 
ATTENTION:  For Unaddressed Admail, in the event that ALL Deposit Locations are the same as the associated Delivery 

Installations (i.e. Transportation Required not selected), NO Summary of Mailing is generated. 
 
The report is sorted by Outlet Name, Date of Mailing and Shipment No. 
 
An indicator is displayed on the Summary of Mailing report to identify that the Downstream Entry checkbox is selected on the SOM 
data entry window.  This report may span more than one page. 
 
 

 
 
 
 
 
   4.5.4 Other Unaddressed Admail Reports 
 
Print Unaddressed Admail Distribution Plan 
 
Following the successful printing of your SOM, your Unaddressed Admail Distribution Plan is generated.   
 
The distribution plan is now generated and printed during the transmission process only when ‘Transportation required’ has 
been selected for some delivery installations and not for other delivery installations in the same mailing plan. Only when you  
have selected this combination are you required to provide a copy of the distribution plan with your mailing. 
 
A distribution plan will not be automatically printed if all delivery installations in the mailing plan require transportation, or  
none require transportation. 
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You will still have the ability to print the distribution plan using the Reprint functionality. 
 
Note that the Preview button on the SOM data entry window triggers the Distribution Plan Preview report generation.  Clicking the 
Reprint button on the Desktop or Search/Manage Orders window reprints the Distribution Plan report. 
 
 

 
 
 
Generate Unaddressed Admail Delivery Slips 
 
Unaddressed Admail Delivery Slips (ADS) need to be printed on laser printers using 8 ½ x 11-inch paper stock that is perforated 
horizontally in the middle in portrait layout.  The slips are printed after the successful transmission of the SOM(s). After the 
Distribution Plan has been printed, you will be asked to confirm that you wish to print the ADS. Ensure that you have the correct 
paper stock in your printer. 
 
Clicking the Reprint button on the Desktop or Search/Manage Orders window reprints the ADS.  In this case, each ADS has a 
“Reprint” watermark on it. 
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When less than full coverage is identified on the Delivery Installation Details page at the Delivery Mode (DM) level, each 
Unaddressed Admail Delivery Slip is printed with “Less than full coverage” watermark and the quantities for the Delivery Modes are 
printed between brackets. 
 
When less than full coverage is identified on the Delivery Installation Details page at the Delivery Installation level, the last  
Unaddressed Admail Delivery Slip based on the sequence you provided is printed with “Less than full coverage” watermark. 
 
 
 
 
 
 
 
 
 
 
 
Generate Unaddressed Admail Container Labels 
 
Container labels for your Unaddressed Admail mailing can be printed on either a laser printer or thermal printer.  For laser printers, 
you need to print the labels on 8 ½ x 11-inch custom pre-printed paper stock that contains six peel-off labels.  Canada Post will 
provide these custom labels to customers (Form #33-086-612).  For thermal printers, the complete label is printed on 2 ¼ x 4-inch 
white thermal label stock. 
 
For laser printers, six labels are printed on one 8 ½ x 11 inch pre-printed paper stock in landscape layout.  The labels are 2 ¾ x 4 
inches in size.  The static data on the label (i.e. field labels and border lines) is printed on all six labels regardless of whether there is 
data to be printed.  For thermal labels, the labels are 2 ¼ x 4 inches.  Note that the space available for printing the text should be 
reduced 1/8 inch on each side (however this does not apply to the lines). 
 
The purpose of the labels is to capture the Delivery Installation Details and Statement of Mailing data entered in the application. 
 
Labels are affixed to all mail containers to identify the sender, Delivery Installation name and address and number of containers 
going to a Delivery Installation.  The number of labels printed per Delivery Installation Details record is dependent on the value 
calculated in the Number of Containers field. 
 
You can select not to print Unaddressed Admail labels by deselecting this option on the Site Information window under the 
Options tab. 
 
Addresses displayed should adhere to the Canadian Addressing Guide.  However, if the complete address line cannot fit in the 
space allocated to it on the label, it will be truncated.  Note that the key piece of information that must be displayed prominently as 
shown on the report layout is the Delivery Installation Postal Code. 
 
Note that the Transmit/Print process triggers the label generation.  The labels are the last documents to be printed after the 
successful transmission of the SOM(s).  Clicking the Reprint button on the Desktop or Search/Manage Orders window reprints the 
labels. 
 
To obtain the adhesive labels to print tie-on tags and labels, please contact your Canada Post Representative, Commercial outlet or 
call our Business Hotline at 1-800-260-7678. 
 
Note:  A keeper label is also required when using bags.  The keeper label is inserted into the metal tag holder attached to the bag 

and contains information on the destination office.  Customers are responsible to create and supply keeper labels. 
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Print NPS Consolidation Documents 
 
If the user selects the NPS Consolidation option on the Unaddressed Admail data entry window, then the application automatically 
prints the following two documents after the SOM(s) have been successfully transmitted to CPC:  NPS Consolidation Report and 
Monotainer/Skid labels.  The report is designed to assist in facilitating the physical mail preparation process.  The labels print with a 
barcode.  They can be sorted by NPS Sequence (the user must select this radio button on the Unaddressed Admail data entry 
window).  The label must be clearly visible on each Monotainer or Skid. 
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   4.5.5 Requirements for Acceptance/Processing of Mailing 
 
The user must submit the following to the Payment Outlet location before the mailing can be accepted at Canada Post: 

1. The Statement of Mailing (SOM). 
2. A copy of the Distribution Plan when more than ten Delivery Installations are selected.  When less than ten Delivery 

Installations are selected, the user must include either a copy of the Distribution Plan OR provide copies of the 
Unaddressed Admail Delivery Slips (ADS). 

3. The payment for the mailing. 
 
The user must complete the following requirements to ensure proper processing of the mailing: 

1. Place a copy of the ADS in the residue bundle in the last container for each Delivery Installation. 
2. Put a Container label on each container. 
3. For a Multi-shipment Order, provide a Packing Slip for each Deposit Location.  For those Delivery Installations that are 

direct drop-offs of mail (i.e. Transportation Required is not selected), provide the Packing Slip to the Payment Outlet 
location. 

4. For a Multi-shipment Order, submit the Summary of Mailing to the Payment Outlet location. 
5. If NPS Consolidation is chosen, ensure that the Monotainer/Skid label is clearly visible on each Monotainer or Skid. 

Note:  A copy of the NPS Consolidation report does NOT need to be remitted to Canada Post. 
 

 4.6 How to Use Templates 
 
Templates allow you to maximize the functionality of the VCD application by giving you the ability to save data entered for reuse 
when creating another SOM.   In this section, you will learn how to save an order as a template, load templates from folders and 
delete templates. 
 
   4.6.1 Maintain Your Order Template 
 
From the File option of the Main Menu of the SOM Data Entry window you can: 

 
•   “Save As Template” Communications Business orders to aid in the preparation of frequently used SOMs; 
•   “Load Template” of an existing Communications Business order. 

 

  4.6.2  Save As Template Window 
This service provides the mechanism to store, into the local database, the information entered by the user in a SOM Template. It is 
triggered when you select the ‘Save As Template’ option from the File option of the Main Menu of the SOM data entry window. This 
window allows you to uniquely name the SOM template.  The Save command button saves the file <filename> and type 
<som_type> to the local database.  Cancel closes the window. 
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The purpose of the following table is to present the components stored in the SOM template.  Column “P” represents Publications 
Mail, “L” represents Lettermail, “C” represents Catalogue Mail, “U” represents Unaddressed Admail, “I” represents Int’l Incentive 
Letter-post, and “A” represents Addressed Admail.  A checkmark in these columns indicates that the field is stored in the template. 
 
 
 

COMPONENT LABEL P L C U I A 

Mailed By (Customer Number) X X X X X X 

Mailed on Behalf of (Customer Number) X X X X X X 

Contract Number X X X X X X 

       

Paid By Customer  X X X X X X 

Downstream Entry X  X   X 

Customer Reference X X X X X X 

Publication Title X      

PAP Registration No. X      

Method of Payment X X X X X X 

       

Add. Accuracy % X X X   X 

Expiry Date X X X   X 

       

Additional Metered Amount      X 

Outlet  X X X X X X 

Size      X 

(Grid) Service Description X X X X X X 

(Grid) Outlet X  X   X 

(Grid) Unit of Measure X X X X X X 

Title of Mail Piece*    X   

Version Specific*    X   

ADS Reference*    X   

Delivery Installation Name*    X   

Coverage Selection*    X   

Piece Description*    X   

Route Selection*, that is: 
FSA 
DM Type 
DM Id From 
DM Id To 
Delivery Installation Name 

   X   

 
* Indicates ADS data (i.e. Delivery Installation Detail data) captured on the Delivery Installation Detail pages and related 
to a specific SOM line item. 
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For information purposes, the following information is not stored in the SOM template: 
Container Information 
Weight values 
# of Pieces values 
Issue Date (Publication Mail only) 
Mailing Date 
CIF 
DMC 

 

   4.6.3 Load a Template 
 
This service provides the mechanism to load, from the local database, previously saved SOM templates. If you are in the SOM 
data entry window, this window only lists SOM Templates, which are the same type as the calling SOM data entry window.   Select 
a file name from the drop-down list and press the Open command button. 
 
Once the file is opened, the information is retrieved and used to populate the appropriate fields on the SOM data entry form. All 
fields are populated except “Container Information”, “Weight values”, “# of Pieces values”, “Issue date (Publication Mail Only)” and 
“Mailing Date”. Note that these fields have not been saved when the SOM was saved as a template. 
 

 
 

 
  4.6.4  Deleting a Template 

 
From the Desktop window, select a file from any of the folders in the Folder Pane other than the Deleted Items folder.  Click on the 
Delete command button located on the bottom portion of the Desktop window.  This action moves the item to the Deleted Items 
folder. 
 
If you have selected an item in the Deleted Items folder and then click on the Delete command button, the order selected will be 
physically deleted upon confirmation that this is the desired action. 
 
 
   4.6.5  Templates and ADS Data 
 
If templates are being used, it is possible that the some route selections may no longer be valid, that is, a selected FSA/PC, DM 
Type, DM Id or Delivery Installation (abbreviated) Name is no longer a valid selection. If this is the case, upon initiating the display 
of the Delivery Installation Detail page a warning message will be displayed and the invalid data will not appear on the page. 
 
It is also possible that a Delivery Installation may no longer exist. If this is the case, upon initiating the display of the Delivery 
Installation Detail page a warning message will be displayed. This Delivery Installation Detail page will be deleted and the next 
Delivery Installation Detail page will be displayed. 
 
  4.6.6 Export / Import Templates 
 
 
An Export/Import Template functionality is available on the Desktop version under the Data Maintenance menu header for 
Unaddressed Admail only. 
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The Export Template option allows the export of data from templates in read-only format.  It can then be imported to another 
Desktop site. 
 
The Import Template option allows the retrieval of an exported template file from the local database, and it’s import into another 
Desktop site al long as the software versions are the same. 
 
The data that will be part of the Export/Import Template is the data for the SOM line item data.   
 
That is, the templates can contain the Service Description data, Weight data, Option data, Outlet, as well as the following data 
elements associated with each Delivery Installation (DI):   
 
Deposit Location 
Transportation Required 
Consumer’s Choice 
Version Specific 
Title of Mail Piece 
ADS Reference Number 
Container Type 
Pieces per Bundle 
Bundles per Container 
Target Area 
Delivery Mode Selection 
Total Pieces/Count 
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4.7 Data Fields and Descriptions 

 
   4.7.1 SOM Data Entry Window 
 

 
 
 
   4.7.2 At the Header Level 
 
In this section you will find general descriptions of fields that are presented in the Communications Services Data Entry window at 
the header level.  Depending on the Service Offering selected, you can enter your electronic Statement of Mailing Information for all 
of the fields displayed. 
 
Note: An asterisk (*) indicates that the field is mandatory. 
 
Mailed By (Customer Number) * 
This numeric field is display-only and cannot be altered by the user.  It identifies the CPC-assigned customer number of the 
customer that is preparing the mailing.  When the SOM data entry window is accessed, this field is populated automatically with the 
user’s Customer Number. 
 
Mailed On Behalf Of (Customer Number) * 
Select from the drop-down list the assigned customer number of the customer who owns the mailing (i.e. customer on behalf of 
whom the mailing is being prepared).  When the drop-down list is opened, it includes both the Customer Number and Customer 
Name.  When you make your selection, only the Customer Number is displayed. 
 
Contract Number 

Header 
Level 

Grid 
Level 

Postage 
Calculation
Summary 
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Select from the drop-down list the Contract Number to be associated with the mailing.  The Contract Number is defaulted to the one 
associated with the Mailed On Behalf Of Customer.  However, you can select the Contract Number associated with the Mailed By 
Customer.  If the Mailed On Behalf Of Customer selection is modified, then the Contract Number is changed to the one associated 
with the new Mailed On Behalf Of Customer. 
 
Note: For Addressed Admail, the following Service Descriptions require a contract number: 

• Machineable Mail 
• Letter Carrier Presort (LCP) 

 
Paid By Customer * 
Select from the drop-down list the customer number of the customer who will be paying for the mailing.  When the drop-down list is 
opened, it includes both the Customer Number and Customer Name.  When you make your selection, only the Customer Number is 
displayed. 
 
Downstream Entry 
Not applicable to Lettermail and International Incentive Letter-post. 
 
Check this box to identify that the mailing is downstream, allowing the customer to specify the Outlet Name, Date of Mailing and 
Shipment No. at the line item level. 
 
For Unaddressed Admail only:  Downstream means that there is more than one Deposit Location selected (i.e. that field is 

different from the Delivery Installation field) on the Delivery Installation Details pages - this includes the scenario of one or more 
Deposit Locations coupled with one or more direct drop-offs to the Delivery Installations (i.e. the Deposit Location is the same 
as the Delivery Installation).  An Order is determined to be Downstream Entry by the application based on the data entered by 
the user.  This field does not appear on the Unaddressed Admail data entry window.  However, such an indicator is on 
the List Pane of the Desktop window. 

 
Outlet or Payment Outlet (Number and Name) * 
This field label changes to Payment Outlet if Downstream Entry is selected.  Click the Select command button to select an outlet 
(number and name) where the mail is brought for induction into CPC’s mail stream.  A pop-up window allows the user to search for 
an Outlet by Province and City or by Outlet Number.  Upon clicking on an Outlet, the user is returned to the SOM data entry window 
with the Outlet field appropriately filled (see Section 5.2.5 Select Outlet/Induction Point Window). 
 
For Unaddressed Admail only:  This field is always called Payment Outlet.  Select from the drop-down list the outlet at which 

payment will be made.  This list is populated with all the outlets that were selected on the Select Outlets/Deposit Locations 
window (Data Maintenance > Site Information > Outlets/Deposit Locations tab > Add). 

 
Note: If the mailing contains Machineable mail, the mail must be placed in hard-sided containers and inducted at one of the 

approved mechanized plants.  For a List of Approved Mechanized Plants, see Appendix 1. 
 
Address Accuracy % 
Not applicable for Unaddressed Admail and International Incentive Letter-post, Basic Lettermail and Basic International/USA Letter-
post. 
 
Enter the declared Address Accuracy rate for the customer based on your Statement of Accuracy (SOA) as generated by a CPC-
recognized software and rounded to one decimal point (e.g. 93.43% = 93.4%).  Address Accuracy measures the percentage of 
correctly addressed items meeting the Canadian Addressing Guide in a customer's mailing list.  An adjustment is automatically 
calculated for any SOA less than 94.5%.  This field is mandatory if an Address Accuracy Expiry Date has been entered.  A copy of 
your SOA must be kept on file and provided to CPC upon request. 
 
Note: Address Accuracy is required for all domestic Incentive Lettermail items. 

Address Accuracy applies to all Addressed Admail, Publications Mail and Catalogue Mail items exceeding the minimum 
volume thresholds.  See the appropriate product Customer Guides or ask your sales representative for details. 

 
Address Accuracy Expiry Date 
Not applicable to Unaddressed Admail and International Incentive Letter-post, Basic Lettermail and Basic International/USA Letter-
post. 
 
Enter the expiry date of your Statement of Accuracy (format YYYYMMDD).  The SOA expiry date is one year from the run date of 
the SOA.  This field is mandatory if an Address Accuracy % has been entered. 
 
Method of Payment * 
From the drop-down list, select your primary method of payment for the mailing.  This field is defaulted to the preferred Method of 
Payment associated with the Paid By Customer (if any). 
 
There are three valid methods of payment available: 

• Account – refers to a payment made by a customer to cover current and future mailings, which will be posted to the 
customer’s account with CPC. 

• Metered - if the mailing will be paid by placing a meter impression on each item of mail to sufficiently cover the cost 
of mailing. 
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• Credit Card - refers to a payment made by a customer to cover current and future mailings, which will be posted to 
the customer’s credit card. 

 
For Publications Mail, Catalogue Mail, Unaddressed Admail and International Incentive Letter-post, Metered is not a valid method of 
payment. 
 
 
 
Selected Credit Card 
This field becomes enabled and is mandatory if the Method of Payment is Credit Card.  Select from the drop-down list the desired 
credit card with which to pay for the mailing. 
 
 
Customer Reference Number 
This is an alphanumeric field that can be used for your internal use and will appear on your Invoice/Transaction Record. 
 
Mailing Type 
Applicable to Catalogue Mail, Unaddressed Admail and Addressed Admail. 
 
Click on the “Full” radio button if entire mailing is deposited at one time.  Click on the “Partial” radio button if the mail corresponding 
to the SOM will be inducted in multiple shipments over one or more days (not to exceed 5 days). 
 
When “partial” is selected as the Mailing Type, the Date of Mailing and Shipment No. can be specified at the line item level. 
 
For Unaddressed Admail only:  Mailing Type of Partial means that there are different Deposit Dates on the Delivery Installation 

Details pages AND at least one of the Details pages has the Deposit Location field DIFFERENT from the Delivery Installation 
field (this means that Transportation Required needs to be selected, because the mail is being brought from the Deposit 
Location to the Delivery Installation).  An Order is determined to be Mailing Type of Partial by the application based on the data 
entered by the user.  This field is display-only. 

 
Note: Partial mailings are not permitted for domestic Lettermail, International Incentive Letter-post and Basic International/USA 

Letter-post. 
 
For partial mailings, you must pay for the entire mailing with the first deposit. 

 
Date of Mailing * 
Enter the date when the mailing is to be inducted at CPC (format YYYYMMDD).  This field has an impact on the calculation rules 
used by the application. 
 
Note: You will not be able to create and transmit your form with a mailing date that is prior to the current date. 
 
Additional Metered Amount 
Applicable to Addressed Admail only. 
 
If your total metered postage is less than the total amount due and you wish to pay the difference with meter tape impressions, enter 
the additional metered amount attached to the mailing (numeric with two decimal places).  This amount must equal the total amount 
due.  You may pay this amount by printing a separate meter impression and then attaching this to your SOM at the time your mailing 
is deposited.  You may also pay by applying the remainder of this to your account. 
 
Note: Metering is not available for Dimensional Addressed Admail. 
 
PAP Registration No. 
Applicable to Publications Mail only. 
 
For publications eligible under the Publications Assistance Program (PAP), select from the drop-down list the Registration Number 
that corresponds to the publication being mailed.  This number is assigned to a Canadian Publication eligible for a postal subsidy 
from the Department of Canadian Heritage. 
 
If the Publication Title changes, the PAP Registration No. is reset and you must select a new PAP Registration No.  If the Contract 
Number is modified, you must select from the drop-down list a new PAP Registration No. and enter a new Publication Title. 
 
Publication Title * 
Applicable to Publications Mail only. 
 
Enter the complete title of the publication being mailed.  This field identifies the name of the publication being issued by the 
customer and is used to confirm eligibility for Publications Mail.  It should be identical to the title listed on the Publications Mail 
Supplement of the Agreement Activation Form. 
 
Issue Date * 
Applicable to Publications Mail only. 
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Enter the issue date of the publication (YYYYMMDD).  If the issue date is seasonal or text, use a representative date.  For example, 
for Winter 2001, enter 20011231 to conform to the date format. 
 
Continuous Inbound Freight (CIF) 
Not applicable to International Incentive Letter-post and Basic International/USA Letter-post. 
 
Check this box if your mail originates outside Canada and is to be delivered directly to a CPC plant.  If the box is checked, you are 
required to provide CPC with documentation that shows proof of origin, such as a Canadian Customs document or Bill of Lading, in 
order to be exempt from Canadian sales taxes. 
 
 
Delivery Mode Audit Code (DMC) 
Not applicable to Catalogue Mail, Unaddressed Admail, Basic International/USA Letter-post and International Incentive Letter-post. 
 
Enter the alpha character of the DMC data version used.  The DMC is used to identify the data version of the National Presortation 
Schematic (NPS) used to sort the mailing.  A new version of the data is provided by CPC every month and reflects the most current 
changes to the delivery routes. 
 
Number and Types of Containers 
Enter the number of each type of container or bag (see below) used for this mailing.  To ensure that your container or bag is 
acceptable, please contact your Canada Post representative or call our Business Access Hotline at 1-800-260-7678. 
 

Monos 
Enter the number of monotainers used to hold the mailing.  A monotainer is a large, collapsible metal cage used to transport 
containers and/or brick-piled mail items between large volume mailers and postal facilities. 
 
Skids 
Enter the number of skids used to hold the mailing.  A skid, also referred to as a pallet, is a wooden/plastic/aluminum platform 
for the conveyance of containers. 
 
Small Bags (Fabrene or Canvas) 
Not applicable to Unaddressed Admail. 
 
Enter the number of small fabrene or small canvas bags used to hold the mailing. 
 
Large Bags (Fabrene or Canvas) 
Not applicable to Unaddressed Admail. 
 
Enter the number of large fabrene or large canvas bags used to hold the mailing. 
 
Hard Sided (Flats Tub or Lettertainer) 
Not applicable to Unaddressed Admail. 
 
Enter the number of hard-sided Flats Tubs or hard-sided Lettertainers used to hold the mailing.  A Flats Tub is a hard-sided 
container used primarily to transport large items (Oversize (O/S) mail) and a Lettertainer is a hard-sided container used for the 
transport of small and medium items (Short and Long (S/L) mail). 
 
Note: All Incentive Lettermail must be placed in a hard-sided container. 

 
If the mailing contains Machineable mail, the mail must be placed in hard-sided containers and inducted at one of the 
approved mechanized plants.  For a List of Approved Mechanized Plants, see Appendix 1. 

 
Flats Tubs, Lettertainers, Bags, Boxes 
Applicable to Unaddressed Admail only. 
 
These four fields are display-only.  They are automatically calculated by the application using data entered on the Delivery 
Installation Details pages.  They display the totals of each type of container used for the mailing. 

 
Cost Centre 
From the drop-down list, select the internal cost centre to which you want to assign the charges for the mailing. 
 
Mail Pieces Over 14” X 6” (35.56 x 25.4 cm) 
For Unaddressed Admail, when this selection box is chosen a validation will occur to ensure that all Delivery Installations related to 
the Statement of Mailing (SOM) have only the “Business” target area selected if there are any Letter Carrier Delivery Modes 
selected for this Delivery Installation.  
 
 
 
NPS Consolidation 
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Mail presortation is the process of sequencing, grouping and containerizing the mail, and labelling the containers to allow CPC to 
bypass various processing steps and facilities within its mail distribution network. 
 
The physical mail preparation process is facilitated when mail containers are pre-sorted to monotainers and skids.  Select the NPS 
Consolidation option by checking the Presort Containers to Monos/Skids box.  After checking the box, the three associated fields 
become enabled (Mono/Skid Type, Min No. and Max No. for Cont. per Mono/Skid).  These fields are mandatory. 
 
This sortation is based on Canada Post’s National Presortation Schematic.  You will be provided with documentation to support mail 
preparation. 
 
Size 
Applicable to Addressed Admail only. 
 
Select the size from the drop-down list that indicates the size of the mail items to be entered on the Statement of Mailing.  Sizes 
include: 

 
• Short/Long (S/L) 
• Oversize (O/S) 
• Dimensional Addressed Admail Small (DIM Small) 
• Dimensional Addressed Admail Medium (DIM Medium) 
• Dimensional Addressed Admail Large (DIM Large) 

 
Note: You may not combine items that are Short/Long, Oversize or Dimensional Addressed Admail Small, Medium or Large on 

the same SOM.  Please prepare separate SOMs for each type. 
 
Meter at Full Price 
Applicable to Addressed Admail only. 
 
Check this box if you are going to determine the exact price for each piece of mail and meter each item using this full rate.  The 
metered rate is the rate of postage on the meter impression attached to each piece of mail being deposited.  If you do not check this 
box, the metered rate for each piece of mail will be calculated at the rate of the lowest priced piece. 
 
Note: If your total metered postage is less than the total amount due, you must enter the Account number from which you wish 

to pay the balance owing.  A cheque should accompany the mailing OR you must ensure that there are sufficient funds in 
this account to cover the balance.  If you would prefer to pay the difference with meter tape impressions, please use the 
Additional Metered Amount field.  Metering is not available for Dimensional Addressed Admail. 

 
Apply Same Weight to All Items 
Applicable to Publications Mail and Addressed Admail. 
 
Click this box if all the pieces in the mailing are the same weight.  If you select to click this box, the Weight per Piece field will be 
automatically populated once your first entry is completed and applied to all other Service Description line items. 
 
If your mailing contains pieces of varying weights within the same weight band price point, use the Average Weight command 
button to calculate the Weighted Average Weight. 
 
 
 
   4.7.3 At the Grid Level 
 
In this section you will find general descriptions of fields presented in the Communications Services Data Entry window at the grid 
level. 
 
Service Description * 
Click on the empty field of the Grid column to display the drop-down list.  Select the appropriate Service Description option from the 
available choices. 
 
No. of Pieces * 
Enter the total number of pieces being mailed for each Service Description option, making up part or all of the mailing issue 
 
Note: For those Service Descriptions where the number of pieces deposited is less than the minimum volume, an 

applicable Phantom price will be charged on the difference between the required minimum volume and the actual volume 
deposited. 

 
For Addressed Admail, a Phantom amount is not acceptable when mixing Machineable with Letter Carrier Presort. 

 
For Publications Mail, the number of pieces you declare in this field are used to calculate the PAP subsidy if you select the 
Eligible for PAP checkbox.  Pieces in the issue that are not eligible for the subsidy must be declared on a separate line 
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item.  Since not all pieces may be eligible, the sum of the No. of Pieces field values may be greater than the total number 
of eligible pieces.  Ensure that you have entered your PAP Registration number at the header level of the data entry 
window and that your designated PAP authority signs Copies 1 and 2 of the printed SOM.  For eligible Bundles of 
Unaddressed Copies, enter only the number of bundles in the deposit, not the number of copies in each bundle. 

 
For Unaddressed Admail, the No. of Pieces field is display-only.  This field will be populated by the application and 
derived by summing the Total Pieces Shipped for Delivery fields (from the Delivery Installation Details pages) associated 
to the given SOM line item. 

 
Weight per Piece * 
Not applicable to International Incentive Letter-post. 
 
Enter the weight per piece for the specific line item.  The weight is necessary to calculate postage costs. 
 
If the mailing contains items of varying weights within the same weight band price point, use the Average Weight command button 
to calculate the Weighted Average Weight.  See Section 5.2.1 Command Button Functionality. 
 
Note: For the Service Description Bundles of Unaddressed Copies in Publications Mail, Weight per Piece should indicate the 

average weight of a bundle of copies (in kilograms), not the weight of each individual copy.  For example, if there are 10 
bundles in the mailing, the total weight of all bundles divided by 10 will give you the average weight of each bundle. 
 
Within the Lettermail selection, the following are rated in kilograms (kg): 
• USA Printed Papers “M” Bags 
• Intl Printed Papers “M” Bags 

 
Total Weight * 
Applicable to International Incentive Letter-post only. 
 
Enter the weight for the specific line item.  The weight is necessary to calculate postage costs. 
 
Note: For International Air Incentive or International Surface Incentive mail, enter the total NET weight for each Service 

Description (in kilograms).  For International Air Incentive items, enter the item weight in grams. 
 
Transport Pieces 
Applicable to Unaddressed Admail only. 
 
This field is display-only.  It will be populated by the application and derived by summing the Total Pieces Shipped for Delivery 
values of those Delivery Installations for which the Transportation Required option has been selected. 
 
Enter DI Details 
Applicable to Unaddressed Admail only. 
 
Once you select a Service Description, the Enter DI Details command button appears in this Grid column for the given line item.   
Clicking this button accesses the Mailing Plan Summary window, which in turn leads to the Delivery Installation Details pages, 
where you can enter information that will be used to automatically create delivery slips for your Unaddressed Admail mailing.  For 
detailed information on this function, see Section 5.3 Creating Admail Delivery Slips for Unaddressed Admail. 
 
DI Details Entered? Indicator 
Applicable to Unaddressed Admail only. 
 
Once you select a Service Description, a checkbox appears in this Grid column for the given line item.  This box is display-only and 
indicates whether or not Automated Delivery Slip (ADS) information exists for the SOM line item in question.  See Section 5.3 
Creating Admail Delivery Slips for Unaddressed Admail for ADS functionality. 
 
Unit of Measure 
Label not shown on screen. 
 
This is a derived field that displays the unit of measure (‘g’ or ‘kg’) for which the user is to enter the weight.  The value displayed is 
dependent on the selected Service Description and the weight information must be entered in the unit of measure displayed by the 
application. 
 
Outlet 
For Downstream Entry Only - Addressed Admail, Unaddressed Admail, Publications Mail and Catalogue Mail. 
 
Select from the drop-down list (you must click in the empty field to display the list) the outlet number where the mail for the line item 
will be brought for induction into CPC’s mail stream. 
 
For Unaddressed Admail only:  This field is display-only (obtained from the Delivery Installation Details page associated to the line 

item).  If the line item in question is for Delivery Installations that are direct drop-offs of mail (i.e. the Deposit Location is equal 
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to the Delivery Installation, and thus Transportation Required is not selected), then this field is blank.  The user should leave it 
blank. 

 
Date of Mailing 
For Downstream Entry and/or Mailing Type of Partial – Addressed Admail, Unaddressed Admail, Publications Mail and Catalogue 
Mail. 
 
Select date from the drop-down calendar (you must click in the empty field to display the calendar) to identify the date when the 
mailing item is to be inducted at CPC.  The Date of Mailing has an influence on the calculation rates. 
 
For Unaddressed Admail only:  This field is display-only (obtained from the Delivery Installation Details page associated to the line 

item).  If the line item in question is for Delivery Installations that are direct drop-offs of mail (i.e. the Deposit Location is equal 
to the Delivery Installation, and thus Transportation Required is not selected), then this field is blank.  The user needs to set 
the Deposit Date equal to the EARLIEST Deposit Date for these Delivery Installations to support the SOM report 
production. 

 
Shipment No. 
For Downstream Entry and/or Mailing Type of Partial – Addressed Admail, Unaddressed Admail, Publications Mail and Catalogue 
Mail. 
 
Enter a numeric identifier (maximum of three digits) for a grouping of line items mailed with: 
 

• The same Outlet and Date of Mailing when Downstream Entry is selected 
• The same Date of Mailing when only Mailing Type of Partial is selected. 

 
This field is always defaulted to 1 but can be altered by the user. 
 
For a mailing that is to be deposited at the same Outlet but on different dates, the Shipment No. helps to keep track of which 
portions of the mailing have been received and later confirm that the whole shipment has been received by CPC. 
 
For a mailing that is to be deposited at different Outlets (it could be a combination of Deposit Locations and direct drop-offs; the 
Deposit Dates could be different), the Shipment No. helps to keep track of which portions of the mailing have been received and 
later confirm that the whole shipment has been received by CPC. 
 
Calculated Metered Rate or Metered Rate 
Applicable to Lettermail (first label) and Addressed Admail (second label). 
 
For Lettermail, this field is display-only and is system calculated.  It shows the rate that should be used to meter the mailing items.  
For Addressed Admail, an initial default Metered value is presented and can be modified.  This is a numeric field with three decimal 
places. 
 
Note: Metering is not available for Dimensional Addressed Admail. 
 
Eligible for PAP 
Applicable to Publications Mail only. 
 
Click this box if the line item is eligible under the Publications Assistance Program (PAP). 
 
Price/Piece 
A calculated field identifying the price of a piece of mail for a given line item.  Display-only numeric field with five decimal places. 
 
Price/kg ($) 
A calculated field identifying the weight price associated with a given line item.  Display-only numeric field with three decimal places. 
 
Transportation Price/Piece 
Applicable to Unaddressed Admail only. 
 
A calculated field identifying the transportation price of a piece of mail for a given line item.  Display-only numeric field with four 
decimal places. 
 
 
Postage 
A calculated field identifying the total postage cost for the mail items of a given line item.  Display-only numeric field with two decimal 
places. 
 
Options 
Applicable to Lettermail including Basic International/USA Letter-post and International Printed Papers (Air) and Unaddressed 
Admail – AdCard. 
 
Click the navigation button to take you to the Select Options window. 
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PAP Subsidy Amount 
Applicable to Publications Mail only. 
 
A calculated field identifying the total PAP Subsidy amount for the mail items of a given line item.  Display-only numeric field with 
two decimal places. 
 
Phantom Adjustment 
Not applicable to Unaddressed Admail. 
 
A calculated field identifying the total phantom cost for the mail items of a given line item.  Display-only numeric field with two 
decimal places. 
 
Note: The total Statement of Mailing phantom cost is determined and then prorated among the relevant line items to obtain an 

item level cost figure. 
 
Address Accuracy Adjustment 
Applicable to Lettermail, Addressed Admail, Publications Mail and Catalogue Mail. 
 
A calculated field identifying the total address accuracy cost for the mail items of a given line item.  Display-only numeric field with 
two decimal places. 
 
GST/HST 
A calculated field identifying the total amount of GST/HST taxes associated with the mail items of a given line item.  Display-only 
numeric field with two decimal places. 
 
PST 
A calculated field identifying the total amount of PST taxes associated with the mail items of a given line item.  Display-only numeric 
field with two decimal places. 
 
Total Amount Due to CPC 
A calculated field identifying the total amount due to CPC for the mail items of a given line item.  The Total Amount Due is equal to 
the Postage plus the Adjustments and Taxes. 
 
 
   4.7.4 Postage Calculation Summary 
 
Postage 
The sum of the Postage amounts on the Statement of Mailing (SOM). 
 
Adjustments 
The sum of all the Adjustment amounts on the Statement of Mailing (SOM). 
 
Phantom Adj. 
The sum of the Phantom Adjustment amounts on the Statement of Mailing (SOM). 
 
Add. Acc. Adj. 
The sum of the Address Accuracy Adjustment amounts on the Statement of Mailing (SOM). 
 
Options Adj. 
The sum of the Options (Registered, Additional Coverage and Advice of Receipt) amounts on the Statement of Mailing (SOM). 
 
Sub-Total 
The subtotal of the above. 
 
Less Metered Amount 
The sum of the Metered Amounts on the Statement of Mailing (SOM) (i.e.  sum of Metered Rate x Number of Pieces for each line 
item) plus Additional Metered Amount. 
 
Sub-Total  
The subtotal of the above. 
 
GST/HST/PST 
The sum of the tax amounts due for GST, HST and PST on the Statement of Mailing (SOM). 
 
Sub-Total 
The subtotal of the above. 
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Less PAP Subsidy 
The sum of the PAP Subsidy amounts on the Statement of Mailing (SOM). 
 
NET AMOUNT DUE 
The total of the above. 
 
Sort ADS Forms for Printing 
Applicable to Unaddressed Admail only. 
 
Select one of the following radio buttons:  Delivery Installation Postal Code (default), ADS Reference, or Title of Mail This field is 
used to specify how the ADS Sequential Number is generated and how the ADS forms and Container labels should be sorted when 
printed.  See Section 5.3 Creating Admail Delivery Slips for Unaddressed Admail for ADS functionality. 
 
 
Collate ADS Forms 
Applicable to Unaddressed Admail only. 
 
Select the collating order for your ADS forms. 

 

 
 
 
 

 4.8    Tools  
 
   4.8.1 Search/Manage Orders Window 
 
This user interface component enables you to search for SOMs.  Selecting the Search/Manage Orders from the Tools menu triggers 
it.  From this window one can search for and retrieve Orders from the database and Open, Preview, Finalize, Transmit or Reprint the 
Order.  
 

1. The Search window allows you to search for and retrieve transactions using the following search criteria:  
• Order Type; 
• Order Id 
• Mailed on Behalf of (Customer Number) 
• Status;  
• Creation Date; 
• Start Mailing Date; 
• End Mailing Date; and 
• Service Offering (displayed as Manifest Type in the screen below) 

 
The screen displayed below shows an example of a distribution Services screen, which has different functionality than 
Communications Business.  For the purposes of the application functionality, only the commands and features of the 
Communications Business are described.  
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Note: The Search Results column headings will only appear once the SOM search results are returned.  As well, the 
Details column headings and data will only appear once a SOM has been selected.  When more than one entry is 
selected from the Search Results table, the Details table is cleared, including column headings.  

 
2. You can enter one or more search criteria. 
 
3. If the Start Mailing Date is entered and the End Mailing Date is blank, search is performed on Transactions that 

have a Mailing Date greater than or equal to the Start Mailing Date. If the End Mailing Date is entered and the Start 
Mailing Date is blank, search is performed on Transactions that have a Mailing Date less than or equal to the End 
Mailing Date. 

 
4. When the Start Mailing Date and End Mailing Date search criteria are entered, the search is performed on the Order 

Details for SOMs that have the Downstream Entry checkbox selected (as opposed to at the header level). If at least 
one line item contains a Date of Mailing within the search criteria entered, the SOM is displayed in the Search 
Results pane. 

 
5. Transactions that match the input search criteria are listed in a data grid and are sorted by Order Id (SOM Id), then 

by local Id, in ascending order.  You can sort the list by different fields by clicking the title of the appropriate column 
in the Search Results and Details grids. 

 
6. The copies fields are defaulted with the value of 1. 

 
7. Multiple rows (i.e. items) can be selected in the Details pane for the purpose of deleting and reprinting items. 

 
8. The Search/Manage Orders window includes a status line at the bottom to display messages for processes that are 

not immediate, such as Transmit/Print. 
 

9. The Drop Down List for the Date fields is defined below: 
 

• You can select a date from a visual calendar component. 
• When a date is not specified in the applicable field, the Month, Year and Day are defaulted to the current 

date. 
• When a date is specified in the applicable field, the Month, Year and Day are set to the value entered in 

the field. 
• You can scroll sequentially through the Calendar Month values (January to December) or Year values by 

using the mouse to click on the up and down arrows buttons located adjacent to the month or Year labels. 
• Either clicking on the desired value or using the up/down/left/right arrow keys performs navigation through 

the Day values 
• Clicking on another field on the parent window closes the Calendar component and the date selected is 

returned to the date field.  To clear the date field, press the Esc key. 
• The specified date is returned and displayed in the date field when: 

• You double click on a particular day with the mouse; or  
• Use the mouse or arrow keys and press the Enter key. 
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Windows Graphical Component Definitions 
The purpose of this section is to identify the labels for each window graphical 
component and to describe its functionality. 
 

COMPONENT LABEL DESCRIPTION 

Search Criteria  
Order Type Search criterion 
Order Id Search criterion 
Mailed on Behalf of  Search criterion 
Status Search criterion 
Creation Date Search criterion 
Start Mailing Date Search criterion 
End Mailing Date Search criterion 
Service Offering Search criterion 
Copies (SOMs) This field indicates the number of copies (1-9) that should be printed for the selected SOMs. 

Search Results  
SOM Id This field identifies the system-generated number assigned to the SOM. 
Local Id This field identifies the system-generated number assigned to the SOM. 
Service Offering This field identifies the Service Offering (e.g. Lettermail) of the SOM. 
Mailed on Behalf of 
Customer Number 

This field identifies the CPC assigned customer number of the customer who owns the 
mailing (i.e., customer on behalf of whom the mailing is being prepared). 

Downstream Entry This field identifies that the mailing is downstream, allowing the customer to specify the 
Outlet, Date of Mailing and Shipment No. at the line item level. 

Outlet Name This field identifies the outlet name selected at the header level. It identifies where the mail 
is paid when Downstream Entry is selected. 
Otherwise, it identifies the outlet name where the mail is brought for induction into CPC’s 
mail stream. 

Method of Payment This field indicates the customer’s chosen method of payment for the mailing. 
Date/Time This field identifies the date and time the SOM was created. 
Mailing Date This field identifies the date when the mailing is to be inducted at Canada Post.  The Date of 

Mailing has an influence on the calculation rules. 
Total Volume This field identifies the Total Number of Pieces included in this SOM. 
Status This field identifies the Status of the SOM (e.g. Transmitted). 
Attempted 
Communication Date 

This Field identifies the date that the data was transferred to the CPC Server. 

Grand Total This field identifies the Total Cost associated with this SOM. 
Search Details  

Service Description This field identifies the service description chosen for the line item.  
No. of Pieces This field identifies the total number of pieces per specific line item, making up part or all of 

a mailing issue. 
Weight per Piece This field indicates the weight for a specific line item on the data entry form.  The Weight is 

necessary to calculate postage costs. 
Unit of Measure  This field indicates the unit of measurement (‘g’ or ‘kg’).  
Eligible for PAP This field identifies whether a specific line item is eligible for the DCH subsidy.  
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COMPONENT LABEL DESCRIPTION 

Outlet This field identifies the outlet name where the SOM line item is brought for induction into the 
CPC’s mail stream. This field only applies when Downstream Entry is selected. 

Date of Mailing This field identifies the date when the SOM line item is to be inducted at Canada Post. This 
field only applies when Downstream Entry and/or Mailing Type Partial is selected. 

Calculated Metered Rate This field shows the rate that should be used to meter the mailing items. 
Price/Piece This field identifies the price of a piece of mail for the given line item. 
Price/kg ($) This field identifies the weight price associated the given line item. 
Transportation Required This field identifies whether a specific line item requires transportation. 
Transportation 
Price/Piece 

This field identifies the transportation price of a piece of mail for the given line item. 

Postage This field identifies the total postage cost for the mail items of the given line item. 
 
 
Command and Navigation Control Definitions  
The following table describes the Command Button definitions and displays the hot key definitions (by underlining the letter in 
question).  
 

COMMAND BUTTON 
OR MENU ITEM  

RESULT OF INVOCATION 

Search A query is generated based on the search criteria entered. 
If no transactions are found in the database that match the search criteria then a message is displayed. 
If more than 500 transactions are found, a warning message will be displayed. 
If one or more transactions are found they are listed in the data grid 
A warning message will be generated if the Start Mailing Date is greater than the End Mailing Date. 

Clear All search criteria fields; Search Results and Details tables are cleared, allowing a new search to be initiated. 
Open Opens the data entry window for the selected Order and populates the window with data located in the 

selected Order or template record. 
For a SOM with a status of transmitted, the following information is not retrieved from the saved SOM record. 

Issue Date (Publications Mail only) 
Mailing Date 

Preview When a SOM entry is selected, performs the same process as the Preview button. 
Finalize Performs the same process as the Finalize button on the main Desktop window. 
Transmit/Print Performs the same process as the Transmit/Print button on the Desktop window. 
Void Enabled when you have selected from the Details pane a single manifest entry with a status of ‘Opened’.  

Opens a confirmation window ‘Are you sure you want to void this line item?’ 
      If confirmed: Clears (i.e. sets to zero) the Quantity, Keyed and Calculated weight and all changes fields; 
Resets the Traceable and Notify Recipient indicators to false; Sets the item as ‘Void’ and closes the 
confirmation window. 
       If the action is cancelled, closes the confirmation. 

Reprint Performs the same process as the Reprint button on the desktop window. 
Close The Search window is closed and the Desktop window is displayed. 
 
 
 
   4.8.2 Scale Configuration  
 
You can use the Scale Configuration window to set up the scale you will be using with Electronic Shipping Tools, or to indicate that 
you will not be using a scale.  You can access this by selecting Tools from the Main menu and then selecting Scale Configuration. 
 
Command and Navigation Control Definitions 
The following table describes the fields, Command Buttons and menu items.   
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COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Scale Selection List Electronic Shipping Tools supports three scales: the Pitney Bowes scale, the Weightronix scale 
and the Mettler scale. 
Select your scale type from the list, or select None/Aucune, then click OK.  If you selected one of 
the scales you will then have an opportunity to configure the scale more specifically using the 
Scale Configuration window 

OK Once you have selected a scale type, or have selected None, click OK.   
If you selected one of the scales you will have the opportunity to configure the scale more 
specifically. 

Cancel Click to close this window without changing your scale selection.  You are not prompted to 
configure a selected scale. 

 

 
 

 

 
 
  
 
   4.8.3 Eltron/Zebra Custom EST Label Configuration  
 
From the Desktop Main Menu, select Tools, Eltron/Zebra Configuration to set-up an Eltron or a Zebra Thermal Printer; 
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Select the model of Eltron printer and from the drop-down list one of the pre-defined ports available on the workstation’s operating 
system and press OK to accept. 
 
 
   4.8.4  Printer Configuration 
 
The Printer Configuration option allows you to identify the printer(s) to be used with the application.  Printers can be added, deleted 
or modified within the user interface component.   For each printer, you can indicate the type (Laser, Dot Matrix, or Thermal), the 
media (plain paper, Thermal paper, or pre-printed Dot-Matrix forms).  From the Main Menu, select Tools>Printer Configuration. 
 
Customs Thermal Printers 
 
The Desktop version now supports all thermal printers defined by your computer’s operating system through your Windows drivers. 
 
You may select from the drop down list a different thermal printer, most common ones are found under Thermal (Windows Driver), 
which does not include the integrated driver within the application, as per the Eltron models.  However, you will first need to install 
the appropriate printer-specific Windows driver on your workstation. 
 
Please Note:  If you encounter printer specific driver installation errors, please refer to your printer manual for assistance. 
 

 
 
 

 
 
 
Window Graphical Component Definitions 
The purpose of this section is to identify the labels for each window graphical component and to describe its functionality.  
 

COMPONENT DESCRIPTION 

Installed Printers A listing of all printers currently configured for this application. 
  Printer Alias An alternate name for the printer that is user defined.   
  Printer Name The make and model of the printer generated from the list of printers installed through Windows. 
  Installed Media The media (paper) type that is currently associated with the printer. 
Printer Configuration The user input area to define the available printers. 
  Name The make and model of the printer.  The field will initially be populated with the Name of the 

Printer selected.  When adding a new printer, the field will be cleared and the drop-down will 
present the user with a choice of all Windows configured printers on their system.  This field is 
mandatory. 
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COMPONENT DESCRIPTION 

  Type Type of printer selected and is used to validate the various media types to be used.  This field is 
populated with Type of the printer initially selected.  If configuring a new printer, this field will be 
cleared and the user will be given the choice of selecting one of three types: Dot Matrix, Laser or 
Thermal.   

  Port Port associated with selected printer.  When configuring a new printer, it will be automatically 
populated when the Printer Name is chosen. (Windows has already been configured with this 
information so this field is read only) 

  Media The media (paper) type that is currently associated with the printer.  This field is populated with 
Installed Media of the selected printer.  If configuring a new printer, this field will be cleared and 
the user will be given a choice of various media types based on the type of printer selected.  

  Alias An alternate name for the printer that is user definable.  Initially, this field is populated with the 
Alias of the selected printer.  The user can modify it.  If a new printer is being configured, once a 
Printer Name is selected, this Name automatically populates the Alias field but the user can 
change it immediately.   

 
 
Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

New All fields in the Printer Configuration Group Box will be cleared and focus will be on the first 
Printer Name within the opened drop-down box.  Select a Printer. 

Delete If a printer is not selected, displays error message to inform you to select a printer to delete. 
If a printer is selected, displays warning message to confirm the deletion. 
If OK is pressed, deletes the printer currently selected.  
If Cancel is pressed, returns control to calling window. 

Save When one of the fields has been modified, select Save Printer Configuration.   
Information within the Installed Printers group Box is immediately updated. 

Close Close Printer Configuration Window. 
Return control to Main Menu. 

 
 
   4.8.5 Output Configuration  
 
This option allows you to assign or re-assign a printer to a specific document type.  The menu path for this option is Tools, Output 
Configuration.  The Output Configuration task is presented in a single window that follows.  Select a Document Type from the 
Documents list view and associate it to an available printer.  When one of the fields has been modified, select Save to save the 
Output Configuration.  
 
Note: Printers must first be set-up using Configure Printer. 
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Window Graphical Component Definitions 
The purpose of this section is to identify the labels for each window graphical component and to describe its functionality. 
 

COMPONENT DESCRIPTION 

Documents This list displays summary information about all currently configured document types. 
The first item in the list is highlighted when the window is opened. 

 Document Type The Document Type will be table driven from the local database and will display all Document 
Types within the application. 

 Printer The printer currently associated with the corresponding Document Type. 

 Barcode Type The Barcode Type currently associated with the corresponding Document Type. 

Document Printer and 
Barcode Type 

The user input area to associate the Printer and Barcode Type to the selected Document Type. 

 Document Type Displays the Document Type selected in the Documents Group Box. 

 Printer Initially, the Printer of the selected Document Type will be displayed.  The drop-down list will 
display a list of printers configured on your workstation.  If there is only one printer configured on 
the workstation, it should be defaulted for all Document Types.  If there is more than one printer 
configured, then blank should be defaulted.  Defaulting blank will help avoid the entry of an 
incorrect printer. 

 Media This field is for information purposes only and will display the Media currently associated with the 
selected Printer. (From Printer Configuration)  

 Barcode Type For Distribution Services only.  A table driven field presenting the user with a list of barcode types 
available with the Document Type selected.  If there is no Printer selected, this field should 
remain blank. 

 
 
Command Buttons 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Save When one of the fields has been modified, select Save to save your changes. 
Close Close the Output Configuration Window. 
 
 
   4.8.6 Proxy Server Configuration 
 
The Proxy Server Configuration task allows you to manage the Proxy Server information.  You can modify Proxy Server data or 
select not to use a Proxy Server.  Selecting Proxy Server Configuration from the Tools menu accesses this window. 
 
If a Proxy Server is used, you will be required to enter the Proxy Server IP Address and Proxy Server Port.  Your Network 
Administrator will be able to assist you in this process.   
 
When you select Yes, you will be required to enter the IP address and port of you Proxy server (HTTP or Secure server).  In 
addition, your proxy server will require user identification by clicking on the Authentication button and entering a valid user id and 
password. 
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Window Graphical Component Definitions 
The purpose of this section is to identify the labels for each window graphical component and to describe its functionality. 
 
Component Description 

Do you want to use a 
Proxy Server? 

This field indicates whether or not a Proxy Server will be used. 

Proxy Server IP 
Address (HTTP Proxy 
or Secure Proxy 
Server) 

This field records the IP Address of the Proxy Server for subsequent connections.  Numeric with IP 
Address Data Mask (i.e. xxx.xxx.xxx.xxx where there is a three character maximum between 
periods) 

Proxy Server Port This field identifies the port number for the Proxy Server. 
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Command Buttons 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Authentication Enabled when a proxy server is selected.  As part of the proxy server authentication, a valid user 
id and password must be entered. 

OK When one of the fields has been modified, select OK to save your changes. 
Close Close the Configure Proxy Server Window. 
 
 
   4.8.7 Purging 
 
The Purging option allows you to purge and if you require, archive older historical data.  Following these steps does this: 

• From the Main Menu, Select Tools, Purging; 
• Enter a date, which must be a minimum of 60 days prior to the current date, and specify if archiving is desired – the 

Archive Orders check box is defaulted to selected; 
• If requested, you can archive Orders that you wish to purge in the same file layouts as those produced during Export 

(see Export Order History).  The suffix “Archive” is used as part of the filename; 
• Orders are purged if they have a Creation Date less than the date entered and a Status of ‘Transmitted’ or ‘Deleted”. 
• Transmit Session Log records are purged and archived if they have a Creation Date less that the date entered. 
• The archived data files are written to the application’s Archive folder.  If the file already exists, the data is appended 

to the existing file; 
• Select between Original or Extended File Format  

 

 
 
The archived order files created are the same as those produced during Order History Export process with a filename suffix of 
“Archive”.  See the following section on Order History Export. 
The archived Transmission Log files are comma-delimited files where all the fields are enclosed in double quotes (“ “).  The system 
will store a blank entry (i.e. “”) where no information is available. 
 
Name of file created: Transmit Log Archive.txt 
 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Transmission Log Transmission Log Id Transmission Log Id. 
Transmission Log Transmission Date Transmission Date. 
Transmit Order Message Order Id Order Id. 
Transmit Order Message Message Type Code Message Type Code. 
Transmit Order Message Diagnostic Transmission Message. 
Transmission Log Application Version Number Version Number of the application 

when transmission occurred. 
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   4.8.8 Order History Export 
 
The Order History Export allows you to export order data.  This task can be performed using the following steps: 

• From the Main Menu, select Tools, Order History Export; 
• Enter a date range 
• A file saving window is displayed, prompting you for a name and location to save the exported files. 
• Export the following data for Orders that have a Creation Date greater than or equal to the Start Date, and less than 

or equal to the End date: 
For Communications Business: 
 SOMs, 
 SOM Items, 
 SOM Item Add-ons, 
 SOM Mail Containers, 
 SOM Items ADS, 
 SOM Item ADS Details. 
 

 
 

Start Date – enter the start date (YYYYMMDD) from which your Order History Export is to start 
End Date – enter the end date (YYYYMMDD) from which your Order History Export ends 
File Format – Select between Original or Extended File Format  
 
Upon validation of the date information, the Export Files Location window is displayed: 
 

 
 
Command and Navigation Control Definitions  
The following table describes the Command Button definitions and/or the menu items. 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Save in Displays the location of the current folder in the hierarchy of folders on the computer. 
Up One Level Opens the folder on level higher than the current folder selected and refreshes the information 

in the list box. 
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COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

View Desktop Toggles the current folder from Desktop to My Computer. 
Create New Folder Creates a new folder under the current directory. 

Allows the user to name the directory. 
List Lists the name of the folders and files in the List Box. 
Details Lists the details of the folders and files in the List Box. 
Files Suffix Provides a space for you to enter a suffix that will be appended to the name of files (see Order 

History Export Files section for details).  Defaults to Current Date in yyyymmdd format. 
Save as type Specifies the extension of the files be saved.  Defaults to ‘Text (*.txt)’. 
Save Performs validations and saves file. 
Cancel  Closes the window  
 
 
 
 
 
Order History Export File Layouts 
The Order History export files are comma-delimited files where fields are all enclosed in double quotes (‘”).  The system will store a 
blank entry (i.e. “”) where no information is available.   
 
SOMs 
 
Name of file created: SOM suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Order Order Id Order Id 
Order WERKS – Induction Point CPC Outlet Number 
Order VBELN – SAP Order Id SAP-assigned Order Number 
Order KUNNR – Behalf of Customer Number Mailed on Behalf of Customer Number 
Order KUNNR – Payer Customer Number Paid By Customer Number 
Order Category Type Code Order Category Type 
Order VBELN – SAP Contract Id Contract Number 
Order Creation Datetime Creation Date and Time (in format yyyy/mm/dd 

hh:mm:ss AM) 
Order Mailing Date Mailing Date (in format yyyy/mm/dd) 
Order MOP Type Code Method of Payment 
Order Current Status Status 
Order Customer Reference Customer Reference 
Order Delivery Mode Code Delivery Mode Audit Code 
Order Drop Shipment Indicator Drop Shipment Indicator 
Order Partial Mailing Indicator Partial Mailing Indicator 
Order Address Accuracy Percent Address Accuracy Percent 
Order Address Accuracy Expiry Date Address Accuracy Expiry Date 
Order CIF Ind Continuous Inbound Freight Indicator 
Order Full Metered Indicator Full Metered Indicator 
Order PAP Reg Id PAP Subsidy Registration Id 
Order Total Base Amount Base Amount of the Order 
Order Total Order Options Amount Total Options Amount on the Order 
Order Total Pretax Amount Pretax Amount of the Order 
Order Total GST Amount GST Amount for the Order 
Order Total PST Amount PST Amount for the Order 
Order Total HST Amount HST Amount for the Order 
Order Total Address Accuracy Amount Address Accuracy Amount for the Order 
Order Total Phantoming Amount Phantoming Amount for the Order 
Order Total DCH Subsidy Amount DCH Subsidy Amount for the Order 
Order Total Metered Amount Metered Amount on the Order 
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ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Order Total Order Due Amount Amount Due to CPC for the Order 
 
 
 
 
SOM Items 
 
Name of file created: SOMItems suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Order Item Order Id Id of the Order to which this Item belongs. 
Order Item Order Item Id Item Id 
Order Item MATNR – Article Number Product Number 
Order Item Quantity Number of pieces in the item 
Order Item Keyed Weight Weight of each piece 
Order Item Metered Rate Metered Rate 
Order Item Price per Piece Price per Piece 
Order Item Price per Kg Price per Kg 
Order Item Transport Required Ind Indicates if Transport is Required. 
Order Item Transport Price per Piece Price to Transport each piece. 
Order Item Item Pretax Amount Item Pretax Amount 
Order Item Item GST Amount Item GST Amount 
Order Item Item PST Amount Item PST Amount 
Order Item Item HST Amount Item HST Amount 
Order Item Base Amount Item Base Amount (i.e. without options). 
Order Item Transportation Amount Transportation Amount. 
Order Item Address Accuracy Amount Address Accuracy Amount. 
Order Item Phantoming Amount Phantoming Amount. 
Order Item DCH Subsidy Amount DCH Subsidy Amount. 

 
SOM Item Add Ons 
 
Name of file created: SOMItemAddOns suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Order Item Option Order Id Id of the SOM to which this Option belongs. 
Order Item Option Order Item Id Id of the Order Item to which this Option belongs. 
Order Item Option Option Type Code Option Type Code 
Order Item Option Option Amount Add On Pretax Amount 

 
 
SOM Mail Containers 
 
Name of file created: SOMMailContainers suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Mail Container Order Id Id of the SOM to which the Mail Container 
belongs. 

Mail Container Mail Container Type Code Type of Mail Container 
Mail Container Quantity Number of containers of this type. 

 
 
SOM Item ADS 
 
Name of file created: SOMADS suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Admail Del Slip Hdr Order Id Id of the SOM to which this ADS belongs. 
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ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Admail Del Slip Hdr Order Item Id Id of the Order Item to which this ADS belongs. 
Admail Del Slip Hdr Hdr Sequence Number ID of the Header 
Admail Del Slip Hdr Piece Description Type Code Piece Description Code 
Admail Del Slip Hdr Total Pieces Shipped Total Pieces Shipped 
Admail Del Slip Hdr Dlvry Instln Area Name Name of the Delivery Installation Area 
Admail Del Slip Hdr Dlvry Instln Type Description Delivery Installation Type Description 
Admail Del Slip Hdr Dlvry Instln Qlfr Name Delivery Installation Qualifier Name 
Admail Del Slip Hdr Dlvry Instln Postal Code Delivery Installation Postal Code 
Admail Del Slip Hdr House Indicates if Houses are covered 
Admail Del Slip Hdr Apartment Indicates if Apartments are covered 
Admail Del Slip Hdr Bus Indicates if Businesses are covered 
Admail Del Slip Hdr Farm Indicates if Farms are covered 
Admail Del Slip Hdr ADS Reference ADS Reference 
Admail Del Slip Hdr Consumers Choice Indicates Consumers Choice 
Admail Del Slip Hdr Version Specific Indicates Version Specific 
Admail Del Slip Hdr Pieces per Bundle Pieces per Bundle 
Admail Del Slip Hdr Title of Mail Piece Title of Mail Piece 
Admail Del Slip Hdr Delivery Start Date Delivery Start Date 
Admail Del Slip Hdr Upon Receipt Indicates to deliver upon receipt. 
Admail Del Slip Hdr Number of Residue Pieces Number of Residue Pieces 
Admail Del Slip Hdr Number of Containers Number of Containers 
Admail Del Slip Hdr Number of Bundles Number of Bundles 

 
 
SOM Item ADS Details 
 
Name of file created: SOMADSDetails suffix.txt 

ENTITY NAME ATTRIBUTE NAME DESCRIPTION 

Admail Del Slip Dtl Order Id Id of the SOM to which this Detail Record 
belongs. 

Admail Del Slip Dtl Order Item Id Id of the Order Item to which this Detail Record 
belongs. 

Admail Del Slip Dtl Hdr Sequence Number Id of the Delivery Slip Header to which this 
Detail Record belongs. 

Admail Del Slip Dtl Dtl Sequence Number Sequence Number of the Detail record. 
Admail Del Slip Dtl FSA FSA 
Admail Del Slip Dtl FSA All Ind Indicates All FSAs 
Admail Del Slip Dtl DM Type Delivery Mode Type 
Admail Del Slip Dtl DM Type All Ind Indicates All Delivery Mode Types 
Admail Del Slip Dtl DM From Id Delivery Mode From Id 
Admail Del Slip Dtl DM From Id All Ind Indicates All Delivery Mode Ids 
Admail Del Slip Dtl DM To Id Delivery Mode To Id 
Admail Del Slip Dtl Delivery Installation Name Delivery Installation Name 
Admail Del Slip Dtl Delivery Installation Name All 

Ind 
Indicates All Delivery Installations 

 
 



 

©September 2004 Canada Post Corporation  74 

  
 
 
 
  4.8.9 Barcode Ranges 
 
Use the Barcode Range Maintenance window to enter a range of item identifies associated with barcodes used on pre-printed 
labels.  Access this window by selecting Barcode Ranges from the Tools menu. 
 

 
 
 
Command and Navigation Control Definitions 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Barcode Range Name This frame displays a list of Canada Post Distribution Services products, and the ranges of item 
identifiers currently assigned to the product. To assign a range of item identifiers to a product, 
click the product name in the Barcode Range Name column; complete the fields in the Barcode 
Range Values frame, then click Save. 

Start Enter the item identifier (barcode number) that starts the range of labels provided to you. The 
format for a complete item identifier is AA ### ### ### AA (a two-letter prefix, a nine-digit 
number, and a two-letter suffix). 

End Enter the item identifier (barcode number) that ends the range of labels provided to you. The 
format for a complete item identifier is AA ### ### ### AA (a two-letter prefix, a nine-digit 
number, and a two-letter suffix). 

Next Available Enter the nine digits that make up the numeric portion of the item identifier (barcode number) 
that is next to be used in the range of labels provided to you. If you are entering a new range of 
labels, this is the first label in the range. The format for a complete item identifier is AA ### ### 
### AA (a two-letter prefix, a nine-digit number, and a two-letter suffix). 

Frequency If you use a thermal printer, in this field, enter the number of item identifiers to be downloaded 
from the Canada Post server. See the Barcode Management topic for more information. 

Clear Click Clear to erase the current values in the Barcode Range Values fields without saving. 
Save Click Save to save the current values in the Barcode Range Values fields. 
Close Closes the window 
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   4.8.10 Reserve SOM Ids for Presort Software 
 
You will be able to print the Unaddressed Admail Container labels prior to transmit the Unaddressed Admail Statement of Mailing 
(SOM) to Canada Post. 
 
Since the Unaddressed Admail Container label contains a SOM Id, you will be able to download a SOM Id range through the “Check 
for Application, Data & Barcode Updates” process, if you have configured your site for Unaddressed and Addressed Admail 
Services. 
 
When the SOM Id range is depleted and you wish to save a SOM, the application will warn you with an error message to initiate the 
process through the “Check for Application, Data & Barcode Updates” to replenish the range. 
 
Select Reserve SOM Ids for Presort Software from the Tools menu. 
 

 
 
 

   4.8.11 Check for Application, Data and Barcode Update  
 
When selecting this option from the Tools menu, the CPC server first verifies that your installed version of the application is current.  
If the update exists on the CPC server, the update can occur automatically or in some cases, an update may be deferred for a later 
time.  In any case, you will be prompted to restart the application following the update process. 
 
If you are part of a Multi-user environment, a warning message will be displayed indicating that all users should sign out of the 
application until the update process is complete.   
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   4.8.12 Sign In Electronic Shipping Tools 
 
Depending on whether the Security Enabled checkbox was selected during the Installation and Set up of your application, you may 
be required to sign into the application.  If the Sign In window is displayed when you double click the application ID, you will be 
required to enter a User ID and password, otherwise you can start to use the application right away.  See you system administrator 
if you have any problems signing in. 
 
The Sign In option performs the following task steps: 

• Requires you to enter a User Id and password to access the application. 
• Allows you to change your current password to a new password. 
• Allows a new user to logon to the application.  The previously logged on user does not have to log off first. 

 
 USER ACTIONS USER INTERFACE 

Sign In (from application icon 
on Windows desktop) 

Double click on the 
application icon, which is 
located on the computer 
screen desktop. 

Enter valid User Id and Password to access the application. 
Note: User Id is not required each time as the system can 
remember it between sessions. 

Sign In (from Tools menu) Select Sign In sub-menu 
item from the Tools main 
menu. 

Enter a valid User Id and Password to access the 
application. 

Change Password Click on the Change 
Password Command Button 
on the Sign In window. 

Enter your old password, along with a new password 

 
 

 
 
User Ids and passwords are alphanumeric with a maximum length of 8 characters.  Selecting the Remember User Id box will result 
in your User Id being displayed in the field the next time you are presented this Sign In screen.  If you select the Change Password 
button, the following dialog box is presented.  Select Ok after you have changed your password.  Passwords have a maximum 
length of 8 alphanumeric characters. 
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   4.8.13 Sign Out Electronic Shipping Tools 
 
You can Sign Out of the application in one of two ways.  Each Sign Out Option performs different tasks.  The following are the tasks 
associated with each option: 
 

• Signing out of the application from the Tools menu will: 
•   Disconnect you from the CPC server, if a connection exists; and 
•   Log you off as the current User. 

 
This will disable all menu options, with the exception of the Exit sub-menu item from the File menu; the Sign In sub-menu 

item from the Tools menu; and the Help menu. 
•   Signing out from the Exit sub-menu item on the File menu will disconnect the connection to the CPC server and exit 

the application. 
 
In either case, you are presented with the Sign Out window confirming that you wish to complete this task. 
 

 
 
 
   4.8.14 Managing Communication with CPC Server 
 
During the following processes, the application manages communication and the data synchronization between your system and the 
CPC server: 
 

• Checks for reference data, barcode range and software application updates (from the Tools menu select Check for 
Application, Data and Barcode Update); 

• Transmit/Print orders to the CPC server. 
 
During either of these two processes, the application established communication with the CPC server to ensure you have the most 
current rates and the latest version of the application. 
 
Associated with the tasks above, the following steps are performed: 

• You will see the status bar with the progress of each updated process; 
• A connection established with the CPC server, if a connection does not already exist; 
• Prompts for you to logon to the CPC server; 
• Initiates updates, verification and availability of reference data, barcode replacement and software application 

updates; 
• A Transmit Session Log is maintained for communications with the server; 
• Prints the orders that have been successfully transmitted. 

 
 
Transmit Session Log 
 
A Transmit Session Log is maintained for messages returned from the Transmit/Print server process.  The following window is 
displayed when a single order transmit has failed or all orders during a multiple order transmit return with errors.  
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The following table lists the components of the Transmission Session Log. 
 

COMPONENT DESCRIPTION 

Transmit Session 
Identifier 

The file name of the log file. 

Transmit Session Date The date and time of the transmit session. 
Application Version The current version of the application. 
Electronic Shipping 
Tools Transmit Session 

A message returned by the CPC server.  This message space is used: 
• To document that a successful transmit session has been achieved, or 
• To document that transmit session could not be established and the reason for the 

session failure.  This message will also include instructions the user is to follow to 
correct the problem. 

Manifest/SOM Local 
Identifier 

The local system identifier of the SOM being transmitted. 

Server Manifest / SOM 
Id 

The SOM Id assigned by the CPC server.  This will be blank if an error condition exists with the 
current SOM being transmitted. 

Acknowledgement 
Message 

A message returned by the CPC server.  The message space is used: 
• To document the successful transmit of the local SOM or 
• To document that the local SOM has not been successfully transmitted and the 

reason(s) why.  If the server detects an error with the SOM being transmitted, the 
server will return one or more error messages describing the errors it has identified.  

Transmit Status 
Message 

This message identifies the number of SOMs successfully transmitted during this session. 

 
 
 
Print Order Documents  
 
The message ‘Printing order documents.  Please wait …’ displays as the Current Operation on the Updating Application window. 
 
Once all orders have been successfully transmitted to CPC, the SOM/Manifest printing process is automatically initiated.   
 
For Unaddressed Admail: 
Once the SOM documents have been printed, the printing of the Unaddressed Admail Distribution Plan documents is automatically 
initiated. 
 
Once the printing of the Unaddressed Admail Distribution Plan documents has been initiated, a message is displayed to ensure the 
proper paper stock has been loaded into the printer before initiating the ADS print job. 
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If the Print Unaddressed Admail Labels checkbox on the Site information window is checked, a message is displayed to ensure the 
proper paper stock has been loaded into the printer before initiating the Unaddressed Admail Label print job.  The user has the 
option of cancelling the Label print job by selecting the Cancel button.  
 
If the Print Unaddressed Admail Labels checkbox on the Options Tab of the Site Information window is unchecked then the Label 
printing file is not generated.   
 
   4.8.15  Logon to the CPC Electronic Shipping Tools Server 
 
This Window allows you to logon on the Electronic Shipping Tools CPC server to:  

• Transmit orders to the CPC Server; 
• Initiate an application and reference data update; or 
• Obtain delivery confirmation status on one or more manifest items (Distribution Services only). 

 
It is triggered the first time you initiate one of the server processes above during the current session.  The User Id and Password is 
remembered for the remainder of the current session after the first successful connection to the CPC server and reuses the logon 
information for the subsequent connection to the server. 
 
 
 

 
 

 
 

 4.9  Data Maintenance 
 
Use the Data Maintenance menu to work with customer data in Electronic Shipping Tools.  You can also configure many aspects of 
Electronic Shipping Tools from this menu, along with assigning aliases (meaningful names) to contracts and cost centres. 
 
   4.9.1 Order Items 
 
The Order Items submenu provides two options: Import and Maintain. Select Import from the Order Items submenu to access the 
Open File for Import Order Items window, where you can import order entry information produced outside of Electronic Shipping 
Tools into the Electronic Shipping Tools database.  
 
Note: The Order Items option refers to Distribution Services.  For more information on its functions please refer to the Distribution 
Services User Guide.   
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   4.9.2 Cost Centres 
 
Cost Centres allow you to allocate the costs of shipping transactions.  The Cost Centre window id accessed by selecting Cost 
Centres from the Data Maintenance window option of the Main Menu or be selecting the New command button next to the Cost 
Centre field in the SOM data entry window.  This window allows you to maintain (add, delete, or modify) and import user-defined 
cost centres. 
 
Note: The Cost Centres option refers to Distribution Services.  For more information on its functions please refer to the Distribution 
Services User Guide. 
 
   4.9.3 Address Book  
 
Address Books allow you to group customers with similar shipping characteristics. Your Address Books act as your main database 
of addresses, from which you can select addresses to ship to, or create distribution lists for group shipping. Use the Address Book 
window to add or delete Address Books in your Electronic Shipping Tools records, or to add, delete, or edit clients in Address 
Books.  Access this window by selecting Address Book from the Data Maintenance menu. 
 
Note: The Address Book option refers to Distribution Services.  For more information on its functions please refer to the Distribution 
Services User Guide. 

 
   4.9.4 Group Shipping of Clients 
 
Select Group Shipping of Clients from the Data Maintenance menu to access the Group Shipping List - Clients window, where you 
can create and edit distribution lists. 
 
Note:  The Group Shipping List of Clients option refers to Distribution Services.  For more information on its functions please refer 
to the Distribution Services User Guide.   
 
 
   4.9.5 Group Shipping of Imported Orders 
 
Select Group Shipping of Imported Orders from the Data Maintenance menu to access the Group Shipping List - Imported Order 
Items window, where you can add an Imported Order Item to the selected distribution list. 
 
Note:  The Group Shipping of imported Orders option refers to Distribution Services.  For more information on its functions please 
refer to the Distribution Services User Guide.   
 
   4.9.6 Containers 
 
Select Containers from the Data Maintenance menu to access the Containers window, where you can predefine container sizes 
and weights. 
 
Use the Containers window to add a new shipping container type to the Container List, remove existing containers, or modify the 
properties of existing containers. To add a new container, enter the Container Name, Weight, Length, Width, and Height fields will 
clear (or be set to 0). Enter the appropriate information in those fields, then click the Save button. 
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Command and Navigation Control Definitions 
The following table describes the fields and Command Button 
 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Container List  A complete list of currently defined containers, indicating the name and dimensions. To modify 
the information for any container on the list, highlight the container, modify the appropriate fields, 
then click the Save button. 

Delete Click Delete to delete the container currently selected on the Container List. You will be 
prompted to confirm the deletion. 

Name* The name of the currently selected container (or blank, if no container is currently selected or 
you are adding a new container). To change or add a name, modify this field, then click the 
Save button. 

Weight The weight of the currently selected container (or 0, if no container is currently selected or you 
are adding a new one). The units of measure for this dimension are set using the Options tab of 
the Site Information window. To change or add a weight, modify this field, then click the Save 
button. 

Length* 
 

The length of the currently selected container (or 0, if no container is currently selected or you 
are adding a new one).  The units of measure for this dimension are set using the Options tab of 
the Site Information window.  To change or add a length, modify this field, then click the Save 
button. 

Width* The width of the currently selected container (or 0, if no container is currently selected or you 
are adding a new one). The units of measure for this dimension are set using the Options tab of 
the Site Information window. To change or add a width, modify this field, then click the Save 
button. 

Height* The height of the currently selected container (or 0, if no container is currently selected or you 
are adding a new one). The units of measure for this dimension are set using the Options tab of 
the Site Information window. To change or add a height, modify this field, then click the Save 
button. 

Cancel  Clears the fields and/or changes nothing 

Save Click Save to save your changes to the Electronic Shipping Tools database. 

Close Click this button when you are done on this window. 

 
 
 
 
   4.9.7 Pre-defined Goods  
 
The Goods Editor window is used to create pre-defined records of commonly shipped items. Each record describes a single item 
that can be included in a shipment.  Select Pre-defined Goods from the Data Maintenance menu to access the Pre-defined Goods 
window. 
 
Note:  The Pre-Defined Goods option refers to Distribution Services.  For more information on its functions please refer to the 
Distribution Services User Guide. 
 
 
   4.9.8 Contract Number Alias 
 
Use the Contract Number Alias window to associate an alias or alternate name to an existing contract. Using an alias name can 
often make contract type identification easier during shipping. The alias name is associated with the Contract Number.  Select 
Contract Number Alias from the Data Maintenance menu to access the Contract Number Alias window. 
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Command and Navigation Control Definitions 
The following table describes the fields and Command Button  

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Contract Number Field This list details all currently defined contract numbers for the selected CPC Customer #. As each 
number is highlighted, the associated alias is displayed in the Alias field, if an alias has been 
defined. If an alias has not been defined, the Alias field is blank. 

Alias Name This field displays the alias defined for the currently selected contract number. If no alias has 
been defined, this field is blank. To define an alias, enter it in this field. 

Contract Number List of all Contracts available to all Behalf of Customer Partners of the current Mailed By 
Customer. 

Customer Number Behalf of Customer Number associated to the Contract. 

Alias* Enter the user defined alias in this field 

Save Click Save to save your changes to the Electronic Shipping Tools database. 

Close Click this button to close this window. 

 
   4.9.9 Salutations  
 
A salutation is the title we use to address an individual, for example, Mr., Mrs., Dr., Ms, etc. Use the Salutations window to view all 
of the salutations currently available on the system. You can also create new salutations, or delete or modify existing salutations. 
 
Access this window by selecting Salutations from the Data Maintenance menu. 
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Command and Navigation Control Definitions 
The following table describes the fields and Command Button 
 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Salutation List  A complete, alphabetical list of currently defined salutations by name. 
To modify the information for any salutation on the list, highlight the salutation, modify the Name 
field, then click Save. 
To add a new salutation, click New. 

Delete Highlight a salutation on the Salutation List, then click Delete to delete it. You will be prompted 
to confirm the deletion. 

New To add a new salutation, click New. Then, enter the name of the new salutation in the Name 
field and click Save. 

Name The name of the currently highlighted salutation. For a new salutation, this field will be blank. 
Click New, enter the name of the new salutation, then click Save. 

Save After any modification to the Name field (either the addition of a new name or the modification of 
an existing name), click Save to save your changes. 

Close Click this button when you are done on this window. 

 
 
   4.9.10  Site Information 
 
The Site Information window has four tabs:  Machine Location, Outlets/Deposit Locations, Customers, and Options. .  Much of the 
information in this window is pre-filled during set-up, or when the system downloads information from Canada Post. 
 
 
 
The Site Information window allows you: 

• To modify profile and/or configuration information of an existing Customers Site; 
• To maintain Machine Location Information; 
• To maintain Induction Point information; 
• To maintain a list of CPC Customer Information; 
• To maintain Site Options; and  
• . 

 
You can access this window by selecting Site Information from the Data Maintenance option of the Main Menu. 
 
Machine Location Tab 
 
The Site Information – Machine Location tab is used to record information about the physical address of the system.  The address 
set-up in the screen is used as the default return address on the manifest and label output.  
 
This panel will initially be populated using the information captured during initial set-up or from CPC databases.  All subsequent 
changes will be managed locally.   
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Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Site This numeric field is display only and cannot be altered by the user.  It is a unique, Canada Post 
Corporation number to identify the Electronic Shipping Tools site.  

Customer Owner This numeric field is the Mailed by Customer number, which is the Canada Post-assigned 
number of the customer that is preparing the mailing.  It is customer associated with the login 
User ID.  It is display-only and cannot be altered by the user. 

Company* Enter your company name as it appears on your contract with CPC. 

Contract Enter the name of the primary contact person in your organization for CPC contracting issues. 

Address* Enter the street address of your organization as it appears on your contract with CPC. 

City* Enter the city or municipality in which your organization resides. 

Country* Select the country in which your organization resides from the drop-down list. 

Province/State* If the country is Canada, the field is province and it displays an alphabetical listing of the valid 
provinces and territories.  If the country is USA, the field is State and it displays an alphabetical 
listing of the valid states.  Select the province or state in which your country resides. 

PC/ZIP* If the country is Canada, the field’s label is PC.  If the country is USA, the field label is ZIP.  
Enter the postal code or ZIP code for your organization as it appears on your contract with CPC. 

E-Mail Enter the e-mail address of the primary contact person at your organization for CPC contracting 
issues. 

Phone (voice/FAX)* Enter the telephone number (in the left field) and FAX number (in the right field) of the primary 
contact person at your organization for CPC contracting issues. 

Save Click the Save button to initiate the save process 

Close Click the close button to exit this window 
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Outlets/Deposit Locations Tab 
 
The Site Information –Outlets/Deposit Locations tab is used to record information about the Electronic Shipping Tools user.  The 
user may set-up two default induction points: one for Distribution services and the second one for Communication services. 
 

 
 
Command and Navigation Control Definitions 
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Information Window This window displays basic information about CPC induction points. Select one to see more 
detailed information in the fields below. 

Outlet List  A unique, Canada Post Corporation name for the Outlets/Deposit locations used by the site. You 
cannot change this field. 

Outlet   This field identifies the number and name of the outlet where the mail is brought for induction 
into CPC's mail stream. 

Address This field displays the street address of the postal facility where items are inducted into the 
Canada Post mail stream. You cannot change this field. 

PO Box This field displays the post office box of the postal facility where items are inducted into the 
Canada Post mail stream. You cannot change this field. 

City This field displays the municipal address of the postal facility where items are inducted into the 
Canada Post mail stream. You cannot change this field. 

Province This field displays the provincial address of the postal facility where items are inducted into the 
Canada Post mail stream. You cannot change this field. 

Postal Code Postal code of the postal facility where items are inducted into the Canada Post mail stream. 
You cannot change this field. 

Add Enables you to select an outlet from which to induct your mail.  Rating and Services standards 
are based on the induction point selected in this window. 

Remove Enables you to de-select an outlet. 

Connect Initiates the Logon process. 

Save Click the Save button to initiate the save process 

Close Click the Close button to exit this window 
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Customers Tab  
 
The Site Information - Customers tab is used to list all the Mailed on Behalf of partners and partner's contracts that have been set-
up on the Electronic Shipping Tools. This list is view only.  
This Tab also enables you to add or remove Customers Numbers to the Mailed on Behalf of Customer List. 

 

 
 
 
The Site Information – Customers tab is used to list all the Mailed on Behalf of partners and partner’s contracts that have been set-
up on the Electronic Shipping Tools. 
 
This tab also enables the user to add or remove Customer Numbers to the Mailed on Behalf of Customer List.   
 
To add or remove customer Numbers, first click on the Connect button and then logon to the CPC server (if you have not already 
logged on).  Note that if your local version of the application requires software or data updates then you must initiate the 
software/data update process.  Only after the local version of the application is up-to-date can the addition or removal of Mailed in 
Behalf of Customers be processed.   

Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Mailed by Customer 
Number 

Read Only. To add a new customer number, enter it in this field, then click the Add button. 

Mailed by Contract 
Number  

Read Only. To add a new contract number, enter it in this field, then click the Add button. 

Customer Number to 
be added to Mailed on 
Behalf of Customer List  

Read Only during the Set-up process, or if you have not yet clicked on the Connect button and 
successfully logged on to the Electronic Shipping Tools server. 

Contract Number  Type a contract number associated with the Customer Number that you entered above. 

Add Enables you to add Customer Numbers to Mailed on Behalf Of Customer List 

Remove Enabled after you have clicked on the Connect button and successfully logged on to the 
Electronic Shipping Tools server; Removes the Customer Number from the Mailed on Behalf of 
Customer List. 
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COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Connect Initiates the Logon process. 

Save If you select "Yes", then continues with the save process. If you select "No", the Save process is 
cancelled. 

Close Verifies if you have made changes to data. If you select "Yes", then you are prompted to save 
data prior to the window closing. If you select "No", the window is closed. 

 
 
Options Tab  
 
The Site Information – Options tab is used to record information about the user.   
 
This window allows you to specify options, system preferences and the Services Used.  To modify the Services Used, first click on 
the Connect button and then logon to the CPC server) if you are not already logged on).  Note that if your local version of the 
application requires software or data updates then you must initiate the software/data update process.  Only once the local version 
of the application is up-to-date can the addition or removal of Services Used be processed. 

 

 
 
Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Language  Select the language of preference for the workstation. 

Security Enabled This option allows you to control access to the application.  Select or unselect to use sign-in and 
sign-out security at the site. 

Inbound Freight Display only.  This option is automatically checked by the system when a shipper is physically in 
the US but inducts their mail in Canada.  The shipper’s country is set in the Machine Location 
tab.  You cannot change this field. 

Automatically initiate 
printing of 
Unaddressed Admail 
Delivery Slips 

Only valid for Communication Business.  Check this option to automatically print delivery slips 
for Unaddressed Admail 
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COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Automatically initiate 
printing of 
Unaddressed Admail 
Container Labels 

Check this option to automatically print container labels for Unaddressed Admail. 

Enable PDF Format 
Printing  

Check this option to improve report, manifest, and label printing by loading a full version of the 
Adobe acrobat Reader application. 

Services Used Enables you to select Communication or Distribution. 

Communication  Select this option if you want your desktop application to be configured to process 
Communication Services (you can select as many as you want). 

Distribution Select this option if you want your desktop application to be configured to process Distribution 
Services.  

Connect Initiates the Logon process. 

Save If you select "Yes", then continues with the save process. If you select "No", the Save process is 
cancelled. 

Close Verifies if you have made changes to data. If you select "Yes", then you are prompted to save 
data prior to the window closing. If you select "No", the window is closed. 

 
 
Shipping Preferences - Default Settings  Shipping Tab 
 
The Shipping Preferences – Default Settings window allows you to establish default settings for the application. 
 
Access this window by selecting Site Information from the Data Maintenance menu. 
 
This window is divided into four tabs:  Shipping, Shipping Options, Customs, and Return Parcel Data. 
 

 
 
Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 

COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Default Settings Mailed 
on Behalf Of 

Displays the Customer Number for which the mailing is being done 

Open Shipping Window 
on Startup 

Check this option to have the Shipping window automatically open when you enter the 
application. 
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COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Prompt for Imported 
Order ID 

Check this option if you want an Imported ID supplied for every shipping transaction.  The 
prompt appears when you click the Process/Print button. 

Clear Shipping Data 
after Process/Print 

Check this option if you want the application to automatically clear the data entered in the Ship 
to and Size & Weight frames of the Ship tab (Shipping Window) after processing a transaction.  
Note that the Cost Centre value and checkbox selections, if any, remain as is.   

Cost Centre Required Check this option to automatically include the cost centre to your shipping items 
Print USA/Intl address 
label 

Check this option to automatically print address labels for USA and International Shipments. 

Additional Address 
Information required 

Check this option to automatically include additional address information to your shipping items  

Print Quickship address 
label 

Check this option to automatically print address labels when using the Quickship option to 
process a parcel. 
Quickship normally suppresses the label printing, on the assumption that your label is produced 
using other means.   

Active Field after Process/Print 
Regular Shipment  The system default is the Client ID field (i.e. after processing a regular transaction, the cursor is 

set in this field).  You can change this default to Imported Order ID, Last Name, or Company 
Name. 

Quickship Shipment  The system default is the Country Field (i.e. after processing a transaction using Quickship 
information only, the cursor is set in this field).  You can change this default to Postal Code. 

Measurement Units The system default for the preferred measurement unit is Metric.  You can change this default to 
Imperial. 

Cost Centres From the drop-down list, select the cost centre to which to charge the cost for the shipment. The 
default is the cost centre used in the previous shipping transaction, but can be changed. This is 
an optional field. 

No. of Pieces Enter the number of units to be shipped under the multi-piece shipment method. The field is 
blank and cannot be less than 1 or exceed 999. 

Container  If you have predefined container types (using Electronic Shipping Tool’s Container Editor), a 
list of all available container types is presented on this drop-down. Select the appropriate 
container type from the drop-down list. 

Item Refence #2 You can enter a second reference number to help you manage your shipping process 
Use Cost Centre as 
Reference #2 

Select this option to identify the Cost Centre as the second reference number 

Item Identifier 
Use System Generated 
Ids 

Select this option to have the application automatically generate an identifier (i.e. barcode) for 
shipments with delivery confirmation selected. 

Manually Scan/Type 
Ids 

Select this option to have the responsibility of entering the identifier (i.e. barcode) for shipments 
with delivery confirmation selected.  If you do not enter one, the application prompts you for one 
when you click Process/Print. 

Manifest Address 
Use Site Address Select this option to have Site address to appear on shipping labels 
Use Customer’s 
Address 

Select this option to have Customer’s address to appear on shipping labels 

Address Label Return Address 
Use Site Address Select this option to have Site address appear on return address labels 
Use Customer’s 
Address 

Select this option to have Customer’s address appear on return address labels 

Save  Saves your information  

Close Click this button when you are done on this window. 
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Shipping Preferences - Default Settings –Shipping Options Tab 
 
The following default settings affect the Ship To, and Service and Options sections  of the Shipping window.   

 
 

Command and Navigation Control Definitions  
The following table describes the fields and Command Button  
 
Command Button or Menu Item  Result of Invocation 
Send E-Mail Notification? 
Client Check this option to send an E-Mail notification to the client 
Mailed By Check this option to send an E-Mail notification to the customer identified by 

the Mailed By number 
Mailed on Behalf Of Check this option to send an E-Mail notification to the customer identified by 

Mailed On Behalf Of number 
After Process/Print 
Clear Shipping Options Check this option to clear the service options selected for a Service Type 

between shipments per workstation.   
Retain Shipping Options Check this option to keep the service options selected for a Service Type 

between shipments per workstation.  You will get warning messages to 
remind you that this option is set. 

Use default Service & Options - Set Check this option to use the service options selected for a Service Type 
between shipments per workstation 

Coverage 
Value You can enter a value to be the default amount if the Coverage service 

option is selected. 
COD 
Include Shipping Cost in COD Collection Amount Check this option which will includes the Shipping Cost to the COD amount 

to collect. 
COD Collection Amount You can enter a value to be the default amount if the COD service option is 

selected. 
COD Method of Collection You can select from the drop-down list a default method if the COD service 

option is selected. 
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Shipping Preferences - Default Settings –Customs Tab 
 
The following default settings affect the Customs window. 
 

 
 

Command and Navigation Control Definitions  
The following table describes the fields and Command Button 
 
COMMAND BUTTON OR MENU ITEM  RESULT OF INVOCATION 

Always print Customs document Check this option to print Customs documents for every order 
Retain Customs Data Check this option to have the application keep the customs data, including the 

goods selected, between shipments per workstation.  Remember that the 
Service Type field defaults to what as chosen for the previous transaction for a 
particular country (Canada, USA, or International).  Once you change this 
Service Type, however, the customs data is permanently cleared (i.e. you 
cannot retrieve it by reselecting the Service Type). 

Reference Number You can enter a reference number to be automatically associated with a 
shipment. 

CAD to USD The values of all predefined goods and those entered for one-time use via the 
Maintain Goods window are in Canadian currency.  You can enter an 
exchange rate that will automatically be used to calculate the Customs Value 
in US currency if USD is entered as the Customs Currency. 

Currency  You can enter a currency (i.e. CAD, USD) to be automatically used for a 
shipment. 

Duty and Tax You can enter the value of the calculated Duty rate plus the tax that applies to 
the item. 

Value You can enter a customs value to be automatically used for a shipment.  This 
default applies only if the field is enabled for the Service type chosen. 

Description  You can enter a (general) description to be automatically used for a shipment.  
This default applies only if the field is enabled for the Service Type chosen. 

Reason for Export  You can select a reason for export from the drop-down list to be automatically 
used for a shipment.  The default applies only if it is available for the Service 
Type chosen. 

Non Delivery Instructions  You can select non-delivery instructions from the drop-down list to be 
automatically used for a shipment.  This default applies only if the field is 
enabled for the Service Type chosen. 

Save  If you select "Yes", then continues with the save process. If you select "No", 
the Save process is cancelled. 

Close  Click this button when you are done on this window. 
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Shipping Preferences – Default Settings –Return Parcel Data Tab 
 
This illustration highlights the features found under the Return Parcel Data tab, accessed by clicking on  
Shipping Preferences on the Navigation Bar menu of the shipping page.  

 
 
•Return Parcel Tab: This page allows you to select default values for use when a parcel is returned to you; it is related to the Print 
Return Label checkbox on the shipping page. This new page allows you to enter information that will be printed on the labels of 
designated returned parcels. You can also specify which type of service you wish to be used for the return, and an e-mail address 
for notification of a return. Once you click Save on this page, the information you have entered will appear on the return label if you 
select to print one.  
 
Command and Navigation Control Definitions  
 
The following table describes the fields and Command Button  
COMMAND BUTTON OR 
MENU ITEM  

RESULT OF INVOCATION 

Print Return Label Select this option if you want to print the Return Label 

Use the Address Label 
Return Address 

Select this option if you want the Return Address to be printed on your return label 

Use this Return 
Address 

The information you enter in this section will be used on the return address label 

Service Type Select service type from the drop down list 

E-Mail Notification? Enter the email address(s) to be used to send an E-Mail notification  

Always use this data for 
Return Parcels (Do not 
prompt during 
Process/Print) 

Select this option if you always want to use this data for your Return Parcel labels 

Save  If you select "Yes", then continues with the save process. If you select "No", the Save process is 
cancelled. 

Close  Click this button when you are done on this window. 
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   4.9.11  Customer 
 
The Customer Information window is used to maintain Machine Location information.  This information is provided during initial set-
up of the system.  If any of the information changes, you can use this window to update it by selecting Customer from the Tools 
menu. 
 
Note:  The Customer option refers to Distribution Services.  For more information on its functions please refer to the Distribution 
Services User Guide.   
 
 
   4.9.12  Client  
 
Each Client entered in Electronic Shipping Tools has a profile that includes address and contact information, as well as the address 
book to which they belong. Use the Client window to add a new Client and profile, or edit an existing Client's profile.  You can 
access the Client window from the Data Maintenance menu.  Each Client must be stored in an address book, but can be stored in 
only one address book. 
 
Note:  The Client Option refers to Distribution Services.  For more information on its functions please refer to the Distribution 
Services User Guide.   
 
   4.9.13  Import Presort Software Mailing Plan 
 
The Import Presort Software Mailing Plan window is used to import software mailing plans from an outside file.  You can access this 
window by selecting Import Presort Software Mailing Plan from the Data maintenance window. Once accessed select the file that 
you wish to open. 
 

 
 

 

5.0 Security  
 5.1 User Profile 
 
The User Profile function is designed for the system administrators who can use this window to add new users to the system, and 
assign access privileges to defined users.  Only a user with administrator privileges will be able to modify a user profile. 
 
The User Profile window allows the user: 

• To add a new User Profile to the local database; 
• To modify an existing User Profile; 
• To delete a user profile from the User Profile list; and  
• To maintain preferred language and access privileges. 
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Select Security option from the Main Menu to access the User Profile function. 
 

 
 
Command Buttons and Navigation Control Definitions  
The following table describes the Command Buttons and Navigation Controls definition and displays the hot key definition by 
underlying the letter in question. 
 

COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

User Profile list 
 
List View 

Select a User Profile 
Display User Profile detail information in the User Profile information section 
User Ids must be greater than 5 characters. 
 

Delete  Delete Selected User Profile in the User Profile List View from the local database 
Reset Password Resets the Password of the selected User Profile. The Password is set equal to the User Id.  Passwords 

can be a maximum of 8 characters. 
New  Allows you to create a New User Profile in the local database 
 
 
Access Privileges 

OPTION ACCESS PRIVILEGE 

Administration Allows the user to perform system functions such as hardware set-up, user set-up, etc. 
Address Book Allows the user to add customers to Address Books, or to add or delete Address Books. 
Trace Queries Allows the user to initiate delivery confirmation queries. 
Order Creation Allows the user to create, modify or delete orders. 
Reporting Allows the user to generate and print reports. 
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6.0 Reports  
 
 6.1 Reports 
The Electronic Shipping Tools reporting function allows you to produce and print many types of reports (detailed in the list below). 
Use the Reports window to select the type of report desired, enter the Criteria, then preview and print the resulting report. 
Access this window by selecting Reports from the Reports menu. 
 

 

 
 

To generate a report: 
1. Select the report type from the Reports frame. 
2. Enter the criteria in the Criteria frame. 
3. Click Preview to preview the report before printing. 
4. Click Print to print the report.  

 
For Communications Services, the only reports available from the Report Selection Window are the Cost centre Summary Report 
and the Cost Centre Detail Report.   
 
Note: For information on any of the other reports please see the Distribution Services User Guide. 
 
Highlight on of the two reports available from the Reports List view.  The Summary Report is summarized by the descriptions of the 
Service Offering with sub-totals by Cost Centre and grand totals.  The Detail Report is ordered by Mailing Date and Service 
Description with sub-totals by Cost Centre (with a page break) and grand totals (on the last page). 
 
SOM orders that meet the following criteria will be presented in these reports: 

• Is assigned to a provided Cost Centre; 
• Belongs to the provided Mailed on Behalf of Customers Number; 
• Has a status of Finalized or transmitted; and 
• Has been created within the provided date range. 

 
 
Command and Navigation Control Definitions  
The following table describes the Command Buttons and Navigation Controls definition and displays the hot key definition (by 
underlying the letter in question, where applicable).   
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COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

Date Range 
 

Enter a Start date and an End date. The resulting report will include only shipments that occurred within 
the specified date range. 

Customer 
Number 

List of all Mailed on Behalf of Customers (Name and Number) configured on the workstation. One entry 
must be selected from the drop-down list. The resulting report will include only shipments allocated to 
that Customer Number. 

Cost Centre Select a Cost Centre from the drop-down list. The resulting report will include only shipments allocated to 
that Cost Centre. 

Preview Click Preview to view an on-screen preview of your report prior to printing. 
Print Click Print to print all of the messages displayed on the Communications Status screen. 
Close Click this button when you are done on this window. 
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 6.2 Delivery Confirmation  
 
You can use Electronic Shipping Tools to confirm delivery of domestically shipped items or groups of items. Use the Delivery 
Confirmation window to search for and confirm delivery of a single item, or all items that can be confirmed that are associated with 
a particular manifest.  Access this window by selecting Delivery Confirmation from the Reports menu 
 
For an item or manifest to appear in this window and be selected for confirmation, it must meet the following criteria: 

• It must have a delivery confirmation option. 
• It must have been transmitted to Canada Post. 
• It must not be voided. 
• It must not already have a final response status (i.e., successful delivery was previously confirmed). 

 

 
 
 
Command and Navigation Control Definitions  
The following table describes the Command Buttons and Navigation Controls definition and displays the hot key definition (by 
underlying the letter in question, where applicable). 
 

COMMAND OR 
MENU ITEM 

RESULT OF INVOCATION 

Search Once you have entered criteria from the drop down menu, click Search to conduct the search.  Select 
from Company, Client Id, Item Identifier, Last Name, Manifest Number, or Imported Order Id. 

All Manifest 
Items 

Once the Search Results frame has been populated with all confirmable transactions allocated to a 
closed manifest by conducting the appropriate search (i.e., completing the Manifest # field and clicking 
Search), you can confirm delivery for all confirmable items on the manifest by invoking the overnight 
batch delivery confirmation process. 
Click Manifest. Electronic Shipping Tools will send a delivery confirmation request the next time you 
communicate with Canada Post. The request will return a description of the most significant event, the 
date of the event and the signatory name 

Event 
Description  

Click the Event Description command button to display a separate window that shows the complete 
Delivery Confirmation Description (which is up to 400 characters). 

Submit Select Submit to send information.  
Print Once Electronic Shipping Tools has received a response to either an item or manifest delivery 

confirmation request, the results are displayed on this screen. You can then click Print to print the results. 
Close Click this button to exit this window. 
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7.0 Help Menu 
 
 
Overview 
 
Use the Help menu to access tools you need to complete the order. 
You can now open EST messages from Help on the Navigation bar.  
 
You can open the Help menu by clicking on the Help button on the Navigation bar 

 
 
If you click on the Command button – Help, this sub-menu will appear: 

 
 

 
 
 
 

 Click Help 
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You are able to print the following topics with your Internet browser: 
 

7.1 EST News 
 
Select EST News to view contents of the latest Release Notes upcoming changes and notices for outages  
 

 
 

7.2 Release Notes 
 
Select Release Notes to view contents of Current and Past releases 
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7.3 Electronic Shipping Tools 
 
Select Electronic Shipping Tools to access directly to the User Guides and reference material  
 

 
 
 

7.4 Help 
 
Select Help to access the Electronic Shipping Tools Desktop Online Help 
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7.5 HouseHolder Counts & Maps 
 
Select HouseHolder Counts & Maps to access information on the Address Management Tools for the Canada Post Web site. 
 

 
 

7.6 Track a Package 
Select Track a Package to access information from the Web site to track your package 
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7.7 Products & Services 
 
Select Product & Services to access information about Canada Post products & services directly from the Canada Post web site. 

 
 
Contacting the Help Desk 
If you have set-up or technical questions that can't be answered using this help, contact the Help Desk weekdays from 7:00 am to 
8:00 pm (Eastern Standard Time) at 1-800-277-4799. 
If you need supplies, contact the Distribution Centre weekdays from 8:00 am to 6:00 pm (Eastern Standard Time) at 1-888-550-
6333. 
 
 

 7.8  Help Desk Tickets 
 
 
When you encounter a System error and the problem persists, you must select the Copy Logs button to create a copy of the log 
files that will be required by the Help Desk. 
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When you select the Copy Logs button, the following logs are copied under the VCD installation folder: 
 

o stderr.txt 
o stdout.txt 
o \bin\upgrades.log 
o \bin\desktop.properties 
o \bin\synchronization.log 
o \download\data.zip 

 
The folder is created if it does not exist, or will be overridden if any log is in the folder.  The copied logs are deleted if you upload a 
Help Desk Ticket. 
 
Once this folder is created, you are ready to contact the Help Desk to open a ticket. 
 
You now have the ability to send an email to the Technical Help Desk from the Desktop application, either related to an OPEN ticket 
(previously provided by the Help Desk), or requesting the DELETION of a transmitted SOM (directly from the application). 
 
Clicking on a sub-menu, gives you the ability to: 
 

- Create a NEW request 
-       Browse previous ones  
- Click on Help 
- Select Help Desk Tickets 
- Call the Help Desk to have a ticket number issued 
- Enter this number in the Help Desk Ticket request 
- Complete the mandatory fields, and provide any necessary additional information 
- eMail your request to the Help Desk 

 

 
 

 7. 9  SOM Deletion Request (Communications Orders only) 
 

o Click on Help 
o Select SOM Deletion Requests 
o Enter the SOM ID # 
o Click on the Search button 
o Complete the mandatory fields, and provide any necessary additional information 
o eMail your request to the Help Desk 
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A successfully transmitted email will display the details in the bottom section in read-only mode.  With a new request, the 
details section is blank, allowing you to add further information about the request. 
 
NOTE:  While you are composing and sending a request to the Help Desk, the application will not be available for shipping or 
mailing.   
 
Any orders that were finalized and ready to be transmitted will be sent separately. 
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